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Safety Precautions

* Only use the Plug&View IP camera within the specified temperature
range for this camera

When not in use, store the product in a clean and dry place in
temperatures between 0°C and 40°C

Do not cover the camera

Do not let the camera come into contact with liquids (except
outdoor cameras with IP66 protective cover)

Plug&View IP cameras do not replace adult supervision. Safeguard
the health of your children, family members or pets by regularly
looking after them

Ensure that the indoor IP cameras are only used inside. These
cameras are not intended for outdoor use and can be damaged.
In this case use the specified outdoor models

Install the Plug&View IP cameras in close proximity to an easily
accessible wall outlet. Ensure that the power cord is not under
tension or stretched

Position the Plug&View IP cameras within the range of your Wi-Fi
router and ensure that there are no obstacles between camera
and router, which could interfere with the Wi-Fi signal



Protect the Plug&View IP cameras from electrical and other HF
devices generating interferences (microwaves, mobile phones,
etc.)

Keep camera, network cable and power cord outside the reach of
children, since these components can be dangerous

Only use the supplied power adapter.

Never try to repair Plug&View IP cameras yourself. Repair and
maintenance work must be carried out by specialists.

In case of problems contact our customer service.

Observe all applicable laws regarding camera monitoring. The
Plug&View IP cameras are intended for private use at home.
Inform your family members, relatives and domestic helpers in
your household with regard to video monitoring. Ensure that
public areas and your neighbors’ properties cannot be seen.



Personal Information D)

* Read and accept the privacy policy for using the DIGITUS®
Plug&View systems under
http://plug-view.com/privacy-policy-for-platform-apps/.

* Select a password with a high degree of safety for your
Plug&View account to protect it from unauthorized access.

* The password should contain at least 8 characters; we
recommend case-sensitive letters and alphanumeric characters.

e Furthermore, the standard password of the camera should be
changed to avoid unauthorized access here as well.

Live stream, push notification and further services are available
via a cloud server. Despite backup solutions, system stability
and bandwidth management the uninterrupted availability of the
system cannot be guaranteed.

What's in the box

1 x Plug&View IP camera Optional:

1 x Power supply with cable 1 x Ethernet cable

1 x Quick Installation Guide 1 x Ceiling/Wall mount

1 x CD with utilities 1 x Removable antenna*

* The following cameras are equipped with a removable antenna:
DN-16029, DN-16039, DN-16043, DN-16048, DN-16049

Thank you for choosing a Plug&View IP-camera, which can be up-
and-running quick and easy without complicated network settings.



Install MicroSD Card

DIGITUS® indoor Plug&View cameras can be equipped with a
microSD card for recording.
Check installation option by means of the installation illustration.

DN-16047

Install the SD card as
illustrated, with the golden
contacts towards the camera
lens.

DN-16046

Install the SD card as B

illustrated, with the golden e

contacts towards the camera . .3

lens. <L
\. e y W

DN-16029

Install the SD card as
illustrated, with the golden

contacts up. |i !\



Camera Connections

LAN:

Connect the camera to the
LAN port of your router.
Reset:

Press and hold the Reset
button for 10 seconds after
starting the camera to reset the
camera to default settings.
Power:

Connect the supplied power
cord to supply the camera with
power.

MicroSD:

Insert a microSD card for local
storage.

Mic: Microphone (Audio In).
Audio output:

Connect an external speaker
via the 3.5mm audio cable.
WPS:

Press and hold WPS button for
8 seconds after camera boots-
up to activate WPS mode.
(*DN-16029 and DN-16046
has WPS button)

Alarm:

Pin1: Alarm input

Pin2: Ground

Pin3: Not in use

Pin4: NO
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Camera Connections

DIGITUS® outdoor Plug&View cameras are equipped with a special
cable.
Check installation option by means of the installation illustration.

. Reset button:

Press and hold this button
for 10 seconds after the
camera is connected and
ready-to-use. This resets
the camera to default
settings.

. Network cable:

Connect the network
cable to you router on the
network to establish
Internet connection.

. DC 12V power
connection:

Connect the external
power adapter to supply
the camera with power.

. LED status indicator:
The blue LED status
indicator shows if the
camera is supplied with
power.

For DN-16039, DN-16043 and DN-16048, its power can be supplied
directly to the camera via the network cable in connection with a
PoE injector or PoE switch.



Lens Settings

DN-16039
DN-16043

Set focus (angle)
You can adjust focus L.
and sharpness via Set sharpness

manual controls.
Use the camera live
image to adjust
focus and sharpness
as required.



1. Preparation

Before you can use your IP camera, some preparations must be
taken care of.

Connect antenna

Plug the wireless antenna into the connector and tighten the
mounting bolts.

Insert SD-card

The Plug&View IP cameras support MicroSD cards with up to 32 GB
storage capacity, which you can buy at your resellers. Pictures or
videos taken with your IP camera are then stored on this card.

If your camera has an external port and does not have existing
internal memory, insert your MicroSD card into the corresponding
slot until it firmly snaps into place.

Connect power supply

Plug the cable of the enclosed power supply into the "Power"
connection of the camera.

Connect camera to router (e.g. AVM Fritz! Box,
Telekom Speedport etc.)*

Connect one end of the supplied network cable to the LAN port of
the camera. Connect the other end of the network cable to one of
the connectors marked as 'LAN' on the back of your router. Some
routers have only one LAN connection, others have multiple
connections. Your router must have a working Internet connection.

* You can skip this point with the access point mode of the
cameras. For DN-16047 this point must be skipped.



2. Setting up the Plug&View User Account

In order to use your Plug&View camera and to have a video
liveview at anytime and anywhere, you need to register your
camera in a Plug&View user account. The setup and control can
both be done either from your Smartphone/tablet as well as from a
PC/Notebook.

2.1 Create a user account with your Smarthpone/
tablet

If you have an Apple® iOS device, then you will find our "DIGITUS®
Plug&View" App in the Apple App Store®. For Smartphones and
tablets running on Google Android OS you can find our "DIGITUS®
Plug&View" App in the Google™ Play Store.

In the search field of the respective App Stores® enter "Digitus" or

"DIGITUS Plug&View".

Apple App Store® Google™ Play

[« oo Wl




In the Search results the "DIGITUS® Plug&View"-

( )
@ App will be marked with this symbol.

Then install the App on your mobile device.

Start the App on your tablet or on your Smartphone. You have 2 options
to create your account:

1. If you already have a Google account, you can use your Google
account to use your Plug&View App, or

2. You directly create a new Plug&View account with an individual
user name and password.

»= oo sm> 1. Sign in with Google
account
Click on "g" for "Google
account” login. Then you
can use your Google Mail
address and password to
log in.

Or

2. Create new account
with Plug&View

Click on "Create Account".




= 1:02 CR |
Terms of Use Agreement

Fiir die Nutzung der Plug8View Plattform via Browser oder App ist es
erlorderlm die Datmsch u:zerklarung die Sie unter hitp:/plug

€ m/privacy-policy platform-apps/ nachlesen konnen v
akzepneren
Eridérung:
Ich habe die Datenschutzeridérung der Assmann Electronic GmbH zur
Kenntnis genommen und willige in die Datenvereinbarung gemas der
Datenschutzerkiinung ein. Ich kann meine Einwiligung jederzeit unter
8 digitus.info wiederrufen,
Wir weisen jedoch darauf hin, dass die Plug&View App dann nicht mehr
genutzt werden kann

To use the Plug&View platform via the browser or app, it is necessary
that you agree to the privacy

policy, which you can find at http://plug-vie
platfo apps/ Privacy policy:

| have acknowledged the privacy policy of Assmann Electronic GmbH,
and hereby consent to the dala agreement according to the privacy
polncy 1 may revoke my consent at any time by contacting

digitus.info,

However, we must point out that in the event consent is revoked, the

T

Accept the privacy
policy for using the
DIGITUS® Plug&View
system.

On the next page,
please choose a user
name, a password,
and confirm your
e-mail address.

Then tap on "Apply" to your Plug&View Account to create. Next you
will receive an e-mail with instructions on how to activate your
account. Then log into the App with "Login" using your user name
and password. Now you can add your camera to the account

(proceed to item 3).

2.2 Create user account with your PC

Besides App support, DIGITUS Plug&View system also supports

PC/Notebook via browser access.

Please visit the website http://plug-view.com

Then click on "Login" to enter Plug&View Web Portal.



Create Account

[BirosT -

1. Sign in with Google account

Click on "g" for "Google
Login". Then you can use your
existing Google Mail address
and password to log in.

Or

2. Create new account with
Plug&View

Click on "Create Account".
Please complete the information
on the next page and confirm
your entries with "Apply". Next
you will receive an e-mail with
instructions on how to unlock
your account. On the login page
you can then log in with your
user data and add your camera.

At this point, you have successfully created an account either by

App or by Web portal.

To continue WiFi setting for the IP camera via Access-Point mode,

please follow on Section 3 of this manual.
Please note that for DN-16047, it is a must to connect the camera

to Internet via Access-Point mode.

Skip to Section 4 of this manual if your camera is connected to your

router via LAN cable.
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3. Connect Plug&View IP Camera Via Wi-Fi

3.1 With Smartphone/tablet

Open the Wi-Fi settings on your

smartphone/tablet.

Search for available wireless
networks in the immediate vicinity.
The camera will be displayed as a
wireless network with its model
number and the last 6 characters of

its MAC address.

4 4 4.4 4 4 4 2
i

WLAN @

+  PlugandView a=(

K WAHLEN

DN-16049-07a405 = (

AnmmrDirni a= (1

Connect your smartphone/tablet to the IP camera via the Wi-Fi
connection.

##e00 02-de+ 36 n23 9% mm)

After smartphone/tablet is
£ Einstellungen  WLAN

connected to the camera you

can continue the Plug&View WLAN O
app installation. Open the 7 OREoHS biadoe g
Plug&View app.



The Plug&View app detects
connection to a Plug&View
camera operated in access
point mode and prompts you to
select the Wi-Fi network, to
which the camera is to be
connected.

Back

Available networks in the vicinity will
be indicated. Please select here the
network, with which the camera
should be connected. If your network
is not displayed, the camera may
need to be repositioned.

ATTENTION: Hidden SSID’s, meaning hidden Wi-Fi networks,
are not supported by the camera. Please make your network
visible, if you want to install your camera into one of these.
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weeo o2-dar ¥ mas | e

{ Back Wi-Fi Setting

Cancel

Please se-connect the WIF| of yous mobie phone 10 the wireless
Foutes o AP before logn 1o BIGITUS Plugtiew

o

Enter the network password in the
password field, with which your
Wi-Fi network is encrypted and
confirm the input with OK.

Under Android operating systems
you are prompted after successful
connection to reconnect your
Smartphone/Tablet to your Wi-Fi
network again.

As a rule, this will happen
automatically. Should this not be
the case, please go to your
Smartphone/Tablet Wi-Fi settings
and connect to your Wi-Fi network
there.



4. Add Plug&view IP camera

4.1 With Smartphone/tablet

Press "+" to add a new camera
during the first Plug&View camera
installation.

Navigate to settings (cogwheel icon
top right) and tap on "Add camera"
if there are already cameras. This is
easily done by scanning the QR-
code with your Smartphone/tablet
or through manual entry of the
activation data.

The following devices are suitable for scanning the QR-code: Apple
iPhone®, Apple iPad®, Android-Smartphone, Android-tablet (with
integrated rear camera).

The MAC-address, the activation code, and the QR-code can be
found on the last page of this guide.

Note: The Android version of the mobile device should be at least
2.3.5 or higher.
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Adding the camera by scanning the QR-Codes

[ A TR CE0E ] On the next page, select the option
"Scan QR code".

The QR code scan function of your

mobile device is activated.

Please scan the QR code on the last page of this manual to add
the camera into your account.

During QR code scanning, you may need to move your mobile
device backwards and forwards until the code is recognized.

Adding the camera though manual input of MAC-
address and activation code

The MAC-address and the activation code are located on the last
page of this guide. Navigate to "Manual input" after selecting "Add
camera" in the Plug&View app.

Enter the alphanumeric combination, which you find under "MAC".
Then enter your activation code and click "Apply".

18



4.2 Add the camera to the PC via the Browser

For PC/Notebook users, you can also add cameras into your account,
which is the similar process as seen from 4.1 with mobile device.

After the first login into your camera administration page via
http://www.plug-view.com to "Login" with your account and
password, you will be prompt with "Download" page to install the
plug-in. Please press download and follow the instruction to install.

Please download the new version of "Plug&View
plugin” for camera liveview:

If you have already downloaded before, check the
following:

Enable P2P Viewer in Chrome extension

Open Menu > Settings > Extensions > P2P Viewer

If you have ever deleted the plugin before, please download
the Plug&View plugin

If P2P Viewer does not exist in the Chrome extension list,
please download P2P Viewer

« Chrome installation tutorial

19



After plug-in installation,
please enter the login page
again from
http://www.plug-view.com
with your account.

L B — Please press the "+" sign to
add the camera.
Please complete registration in 60 minutes
after boot up your camera, or you need to Then press " sign to go to

re-powe.rthe camera and corﬂplete next page and follow the
registration process again.
steps.

Then please key-in the MAC address and Activation code as seen
from the last page of your user manual and press "Apply" to add the
camera.

Add Camera

MAC Address

Activate Code

20



After successfully adding the camera to your account, please check
whether your camera is displayed with live-view.

et ST
Plugiiew s

If you plan to continue using your Plug&View camera with a
network cable, the setup is completed here.

If, however, you intend to use the wireless connection with Wi-Fi for
flexibility of location, please continue reading.
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5. Setting up Wi-Fi on PC/Notebook

The setup of the wireless (Wi-Fi) connection between the IP camera
and the Wi-Fi router/Access-point can also be done on the PC/
notebook side via browser

After the successful installation of your camera, log in to the web
site "http://www.plug-view.com". Please click on "Login | My camera
administration".

Use your Plug&View account or select the Google-Login. If you are
not signed in to your Google account, you will be automatically
redirected to the Google login page.

After entering your login details you can see the camera live-view.

To the right side of the camera 0
image, you will see some icons. -
Click on the "Camera Configuration"
button to be directed to the user
interface of the camera.

‘ ' Camera Configuration
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Then it will open another window, which is the Web User interface of
the camera. Please login with default "camera" login account with
"admin" and password "admin". If you select the option "Autologin”,
you will be logged in automatically next time you access the
configuration menu. Click on "Login".

DIGITUS® PLUG&VIEW

safe&secure - anywhere. anytime.

S —
Language:
Stream

In the user interface of the camera, click on Wi-Fi to carry out Wi-Fi
settings.

D lGlTUS safeasecure - anywhere. aﬂvﬂmé-

Home Replay Parameters System Wireless

A search window will appear, in which the available wireless networks
in your environment will be displayed. Please select the identifier
(SSID) of your network and confirm with "OK".

ssID Signal  Authentifzierungsmodus
O Testrrm 85% [WPA-FSK-TKIF)WRAZ-FSK-COMP)IWPS]ESS)
O PhugandView 85% [WPA-PSK-TKIF)[ESS]

—ams masme s AL s S
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In the next window enter the Wi-Fi-key and confirm with "OK".

Passwort:

ok

Please ensure that your
router is functioning as a
DHCP-server. This is the
factory setting of almost
all routers.

Next, the connection to
your wireless LAN is
established. If the
connection was
successfully established,
this will be displayed in a
separate window.

You can now remove the network cable from the camera and

close the browser window.

Congratulations. You have just completed your Plug&view IP
camera set up. Now you can access your IP camera at any time
from your Smartphone, tablet PC, or from a browser.
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6. Set Motion Detection and Recording

The DIGITUS® Plug&View system offers the options motion detection
and recording. To use this function, the SD card must be formatted in
the camera and motion detection must be activated.

For formatting the SD card, access the camera via the web portal.

To the right side of the camera 0
image, you will see some icons.
Click on the "Camera Configuration"
button to be directed to the user
interface of the camera.

‘ E ‘ , Camera Configuration

Then it will open another window, which is the Web User interface of
the camera. Please login with default "camera" login account with
"admin" and password "admin". If you select the option "Autologin”,
you will be logged in automatically next time you access the
configuration menu. Click on "Login".

You can access the SD card information via menu by going to
System -> Local storage. Format the SD card via menu item "Format".

After formatting, motion detection can be activated.
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Please go to "Parameters" -> "Motion Detect" on the Web Ul.

safe&secure - anywhere. anytime.

Activate B4 Enable

.

Sensibiity [Nerma v Select All m

Action:
E-Mail

Send E-mail

Output Alarm With Snapshot 1 Send ToEmall ) Upload to FTP

=
I~
B AamwihRecord o upicadto FTP
B4 Trigger Alarm Output

Schedule: Week Mode Work Mode ®  Always

Activate motion detection by clicking on "ON". The colored area
within the video image is the motion detection area, i.e. the area in
which a movement triggers a picture or a video recording. In the
original delivery condition, almost the entire screen is covered with
red boxes. Click on the color markings to exclude certain areas
from motion detection. By doing this, you delete the marker for that
area. You can set the motion detection sensitivity in "Sensibility".
Select from the following four levels: "Very high", "High", "Normal"
and "Low".

Activate "Alarm with recording" to save in case of detected motion
to SD card.

Time setting is affected via the schedule for motion detection. You
can record in Weekly, Workday or Full-time modes.

You can individually adjust the schedule.

Save the configuration with "Apply".
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You have successfully set motion detection with recording.
For explanations regarding the camera’s web interface see the
camera manual supplied on CD.

With questions access the FAQ area on our Plug&View page
(http://www.plug-view.com/) or contact our Hotline
(http://www.plug-view.com/support-de/support/).

Trademarks

DIGITUS is a registered trademark ASSMANN Electronic GmbH.
Apple, Apple App Store are registered trademarks of Apple Inc.
Android, Google, Google play are registered trademarks of Google Inc.
AVM Fritz!Box is a registered trademark of AVM Computersysteme
Vertriebs GMBH.

Telekom Speedport is a registered trademark of Deutsche Telekom AG.

Note:

All other trademarks not listed here, are the property of their respective
owners.

Trademarks or trade names mentioned in this manual are used to
describe the operating steps and do not imply that they are freely
available. In any case they are the property of the respective holder
of the rights.
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Hereby ASSMANN Electronic GmbH, declares that this device is in
compliance with the requirements of Directive 2014/53/EU and the
Directive 2011/65/EU for RoHS compliance. The complete declaration
of conformity can be requested by post under the below mentioned
manufacturer address.

Warning:

This device is a class B product. This equipment may cause some
radio interference in living environment. In this case, the user can
be requested to undertake appropriate measures to prevent
interference.

www.assmann.com
Assmann Electronic GmbH
Auf dem Schiiffel 3
58513 Liidenscheid

Germany T
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DIGITUS"/

DIGITUS® Plug&View-
IP-Kameras

Kurzanleitung zur Installation (QIG)



Sicherheitsvorkehrungen

* Verwenden Sie die Plug&View-IP-Kamera nur innerhalb des
angegebenen Temperaturbereichs.

Wenn Sie die Produkte nicht verwenden, lagern Sie sie bitte an
einem sauberen und trockenen Ort bei Temperaturen zwischen
0°Cund40°C

Decken Sie die Kamera nicht ab

Lassen Sie die Kamera nicht in Kontakt mit Flissigkeiten kommen
(AuBer Kameras fiir den Auf3eneinsatz mit IP66-Schutzabdeckung)

Plug&View-IP-Kameras ersetzen nicht die Aufsicht durch
Erwachsene. Achten Sie darauf, dass sich lhre Kinder,
Familienmitglieder und Haustiere in Sicherheit befinden, indem
Sie regelmafig nach ihnen schauen

Achten Sie darauf, dass die IP-Kameras nur in Innenrdumen
verwendet werden. Diese Kameras sind nicht fir die Installation
im AuRenbereich vorgesehen und kénnen beschadigt werden.
Verwenden Sie flr die Installation im AuRenbereich bitte die
Geréate, die dafiir vorgesehen sind

Montieren Sie die Plug&View-IP-Kameras in der Nahe einer leicht
zuganglichen Steckdose. Stellen Sie sicher, dass sich das
Stromkabel nicht unter Spannung befindet oder gedehnt wird

Positionieren Sie die Plug&View-IP-Kameras innerhalb der
Reichweite lhres WLAN-Routers und stellen Sie sicher, dass sich
keine Hindernisse zwischen der Kamera und dem Router
befinden, die das WLAN-Signal stéren kdnnten.



Schitzen Sie die Plug&View-IP-Kameras vor Stérungen durch
elektrische und andere funkwellenerzeugenden Geraten
(Mikrowellen, Handys usw.).

Halten Sie Kameras, Netzwerkkabel und Stromkabel auRerhalb der
Reichweite von Kindern, da diese Teile gefahrlich sein kénnten.

Verwenden Sie nur das mitgelieferte Netzteil.

Versuchen Sie niemals die Plug&View-IP-Kameras selbst zu
reparieren. Reparaturen und Wartungsarbeiten sollten nur von
qualifiziertem Fachpersonal durchgefiihrt werden.

Wenn Probleme auftreten, wenden Sie sich bitte an unseren
Kundenservice.

Beachten Sie bitte lhre landesspezifischen Gesetze zur
Uberwachung mit Kameras. Die Plug&View-IP-Kameras sind nur
fur den privaten Gebrauch zuhause vorgesehen. Teilen Sie lhren
Familienmitgliedern, Verwandten und Helfern im Haushalt mit,
dass Sie eine Videolberwachung installiert haben. Stellen Sie
sicher, dass offentliche Bereiche und die Grundstiicke lhrer
Nachbarn nicht Giberwacht oder aufgezeichnet werden.



Personliche Daten

* Lesen und akzeptieren Sie die Datenschutzbestimmungen fir
die Nutzung der DIGITUS® Plug&View-Systeme unter
http://plug-view.com/privacy-policy-for-platform-apps/.

e Wabhlen Sie ein sicheres Passwort fiir lhren Plug&View-Zugang
aus, um ihn vor unberechtigtem Zugriff zu schitzen.

* Das Passwort sollte mindestens 8 Zeichen enthalten. Wir
empfehlen die Verwendung von GroR3- und Kleinbuchstaben
sowie alphanumerischen Zeichen.

* Dariber hinaus sollten Sie das Ausgangspasswort der Kamera
andern, um auch hier unberechtigtem Zugriff vorzubeugen.

Livestreams, Push-Nachrichten und weitere Dienstleistungen
sind liber unseren Cloud-Server verfiigbar. Trotz unserer
Backup-Losung, unserer Systemstabilitdt und unseres
Bandbreitenmanagements kénnen wir die Verfiigbarkeit des
Systems nicht garantieren.

Lieferumfang

1 x Plug&IP-Kamera Optional:

1 x Netzteil mit Kabel 1 x Ethernet-Kabel

1 x Anleitung zur Schnellinstallation 1 x Decken-/Wandbefestigung
1 x CD mit Dienstprogrammen 1 x Abnehmbare Antenne*

*

Die folgenden Kameras sind mit einer abnehmbaren Antenne
ausgestattet: DN-16029, DN-16039, DN-16043, DN-16048,
DN-16049

Vielen Dank, dass Sie sich fiir eine Plug&View IP-Kamera
entschieden haben, die schnell und einfach aufgestellt und schnell
und einfach ohne komplizierte Einstellungen in Betrieb genommen
werden kann.
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Installation einer microSD-Karte

DIGITUS® Innen-Plug&View-Kameras kénnen mit einer microSD-
Karte fir die Aufnahme ausgerustet werden.

Uberpriifen Sie die Installationsoption mit den Abbildungen zur
Installation.

DN-16047

Setzen Sie die SD-Karte wie
in der Abbildung dargestellt
ein, mit den goldenen
Kontakten in Richtung des

Kameraobjektivs.
DN-16046
Setzen Sie die SD-Karte wie o
in der Abbildung dargestellt e d
ein, mit den goldenen e .:‘
Kontakten in Richtung des 292"
Kameraobjektivs. *-4.

S i’ \ )

DN-16029
Setzen Sie die SD-Karte wie
in der Abbildung dargestellt

ein, mit den goldenen
Kontakten nach oben. &



Kameraanschliisse

LAN:

Schlieflen Sie die Kamera an
den Netzwerkanschluss Ihres
Routers an.

Reset:

Driicken und halten Sie den
Reset-Knopf fiir 10 Sekunden
nach Einschalten der Kamera,
um die Kamera auf den
Ausgangszustand
zurlickzusetzen.
Stromversorgung:
Verbinden Sie das mitgelieferte
Netzteil mit der Kamera, um sie
mit Strom zu versorgen.
microSD:

Setzen Sie eine microSD-Karte
ein, um Daten auf dem Gerat
zu speichern.

Mic: Mikrofon (Audioeingang).
Audioausgang:

Anschluss eines externen
Lautsprechers Uber das

3,5 mm Audiokabel.

WPS:

Halten Sie die WPS-Taste fiir

8 Sekunden gedriickt, nachdem
die Kamera hochgefahren ist, um
den WPS-Modus zu aktivieren.
(*DN-16029 und DN-16046
verfugen uber eine WPS-Taste)
Alarm:

Pin 1: Alarmeingang

Pin 2: Masse

Pin 3: Nicht benutzt

Pin4: NO

6
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Netzwerkanschluss
Audioausgang
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Reset
Steckplatz fiir MicroSD-Karte
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Kameraanschliisse

DIGITUS® AuRen-Plug&View-Kameras sind mit einem speziellen
Kabel ausgestattet.

Uberpriifen Sie die Installationsoption mit den Abbildungen zur
Installation.

. Riicksetztaste:

Halten Sie diese Taste fir
10 Sekunden gedriickt,
nachdem Sie die Kamera
angeschlossen haben und
sie betriebsbereit ist. Dies
setzt die Kamera auf die
Standardeinstellungen
zurlck.

. Netzwerkkabel:

SchlieRRen Sie das
Netzwerkkabel an den
Router im Netzwerk an, um
eine Internetverbindung
herzustellen.

. DC12V
Spannungsversorgung-
sanschluss:

SchlieBen Sie den externen
Netzadapter zur
Versorgung der Kamera an.

. LED-Statusanzeige:

Die blaue LED-
Statusanzeige zeigt an, ob
die Kamera mit Strom
versorgt wird.

Bei der DN-16039, DN-16043 und DN-16048 kann die Kamera
direkt Uber das Netzwerkkabel und einen PoE-Injektor oder PoE-
Switch mit Strom versorgt werden.



Objektiveinstellungen

DN-16039
DN-16043

Fokus einstellen (Winkel)
Sie kénnen Fokus s
und Scharfe Uber d|e Schirfe einstellen
manuelle
Bedienelemente
anpassen.
Verwenden das
Livebild der Kamera
um Fokus und
Scharfe anzupassen.



1. Vorbereitung

Bevor Sie lhre IP-Kamera verwenden kdnnen, missen Sie einige
Dinge erledigen.

Antenne anschlieBen

Stecken Sie die WLAN-Antenne in den Anschluss und ziehen Sie
die Schrauben fest.

SD-Karte einsetzen

Die Plug&View-IP-Kameras unterstiitzen MicroSD-Karten mit bis zu
32 GB Speicherkapazitat. Diese erhalten Sie bei Ihrem Handler. Auf
der Karte sind dann Fotos oder Videos gespeichert, die mit Ihrer IP-
Kamera aufgezeichnet wurden.

Wenn lhre Kamera lber einen externen Port verfiigt und keinen
internen Speicher hat, stecken Sie die MicroSD-Karte in den
entsprechenden Steckplatz, bis sie fest einrastet.

Anschluss des Netzteils

Schlielen Sie das Kabel des mitgelieferten Netzteils in den
,Power‘-Anschluss der Kamera.

Verbinden Sie die Kamera mit dem Router (z.B. AVM
Fritz! Box, Telekom Speedport usw.)*

Verbinden Sie das eine Ende des mitgelieferten Netzwerkkabels mit
dem LAN-Anschluss der Kamera. Verbinden Sie das andere Ende
des Netzwerkkabels mit einem der Anschlisse auf der Riickseite
des Routers, die mit ,LAN" beschriftet sind. Einige Router haben
nur einen LAN-Anschluss, andere haben mehrere. Ihr Router muss
Uber eine aktive Internetverbindung verfligen.

* Sie kénnen diesen Punkt mit dem Access-Point-Modus der
Kameras Uberspringen. Bei der DN-16047 muss dieser Punkt
Ubersprungen werden.



2. Einrichtung eines Plug&View-

Benutzerkontos

Zur Verwendung der Plug&View-Kamera und fiir ein Video-Livebild
jederzeit und Uberall, missen Sie Ihre Kamera in einem Plug&View-
Benutzerkonto registrieren. Die Einrichtung und Steuerung kann
entweder von lhrem Smartphone/Tablet sowie von einem PC/
Notebook erfolgen.

2.1 Erstellen eines Benutzerkontos mit lhrem
Smartphone/Tablet

Wenn Sie ein Geréat mit Apple® iOS haben, finden Sie unsere
L,DIGITUS® Plug&View*-App im Apple App Store®. Bei Smartphones
und Tablets mit Google Android finden Sie unsere ,DIGITUS®
Plug&View“-App im Google™ Play Store.

Geben Sie in die Suchzeile des entsprechenden App Stores®

,Digitus” oder ,DIGITUS Plug&View" ein.

Apple App Store® Google™ Play




\

Die ,DIGITUS® Plug&View“-App wird in den
Suchergebnissen mit diesem Symbol
gekennzeichnet.

Installieren Sie anschlieRend die App auf Ihrem mobilen Geréat.

Starten Sie die App auf Ihrem Tablet oder Smartphone. Sie haben
2 Moglichkeiten, um |hr Konto zu erstellen:

1. Wenn Sie bereits ein Google-Konto haben, kénnen Sie lhr
Google-Konto fir lhre Plug&View App verwenden, oder

2. Sie erstellen direkt ein neues Plug&View-Konto mit einem
individuellen Benutzernamen und Passwort.

00 sm3 1. Melden Sie sich bei
Ihrem Google-Konto an

Klicken Sie auf ,g“ firr die
,Google-Konto*-
Anmeldung. Dann
koénnen Sie lhre Google
Mail-Adresse und lhr
Passwort verwenden, um
sich anzumelden.

oder

2. Neues Konto mit
Plug&View erstellen

Klicken Sie auf ,Create
o Account".



c = 1:02 om

Terms of Use Agreement Lesen und akzeptieren Sie die
Datenschutzbestimmungen
Fir die Nutzung der Plug8View Plattform via Browser oder App ist es fir die Nutzung der DIGITUS®
erforderlich, die Datenschutzerklérung, die Sie unter /plug .
view.com/privacy-policy-for-platform-apps/ nachlesen kénnen, zu Plug&View-Systeme unter
akzeptieren, . .
Erk]é'?ung; http://plug-view.com/privacy-

Ich habe die Datenschutzerklarung der Assmann Electronic GmbH zur i ~vfOr »
Kenntnis genommen und willige in die Datenvereinbarung gem&n der pollcy for platform apps/.
Datenschutzerklarung ein. Ich kann meine Einwilligung jederzeit unter

support@digitus.info wiederrufen

Wir weisen jedoch darauf hin, dass die Plug&View App dann nicht mehr

genutzt werden kann. Wahlen Sie auf der nachsten

To use the Plug&View platform via the browser or app, it is necessary Seite einen Benutzernamen
that you agree to the privacy

policy, which you can find at hitp://plug com/privacy-policy und ein Kennwort und
platform-apps/ Privacy policy: s .

| have acknowledged the privacy policy of Assmann Electronic GmbH, bestatigen Sie Ihre

and hereby consent to the data agreement according to the privacy
policy. | may revoke my consent at any time by contacting
support@digitus.info,

However, we must point out that in the event consent is revaked, the

E-Mailadresse.

Tippen Sie anschlieBend auf ,Apply“, um Ihr Plug&View-Konto zu
erstellen. Als nachstes erhalten Sie eine E-Mail mit Anweisungen,
um |hr Konto zu aktivieren. Melden Sie sich anschlieRend in der
App unter ,Login (Anmelden)* mit lhrem Benutzernamen und
Passwort an. Sie kdnnen jetzt Ihre Kamera zum Konto hinzufigen
(gehen Sie zu Punkt 3).

2.2 Erstellen eines Benutzerkontos mit lhrem PC

Neben der Unterstiitzung der App, unterstiitzt das DIGITUS
Plug&View-System auch PCs/Notebooks liber den Browserzugriff.

Besuchen Sie die Website http://plug-view.com
Klicken Sie anschlielend auf ,Login“, um die Plug&View-Web-
Benutzeroberflache aufzurufen.



1. Melden Sie sich bei Ihnrem
Google-Konto an

Be

Klicken Sie auf ,g“ fur die
,Google-Anmeldung®. Sie
kénnen dann |hre
bestehende Google Mail-

7 Adresse und das Kennwort
zum Anmelden verwenden.

Forgot Password?

[-=}

oder

Create Account 2. Neues Konto mit
Plug&View erstellen

Klicken Sie auf ,Create Account®.
Geben Sie die Informationen auf
e der néchsten Seite vollstéandig
ein und bestatigen Sie Ihre
Eingabe mit ,Apply*“. Als
DIGITUS®/ o néchstes erhalten Sie eine E-
Mail mit Anweisungen, um lhr
Konto zu entsperren. Auf der
Anmeldeseite kdnnen Sie sich
mit Ihren Benutzerdaten
anmelden und Ihre Kamera
hinzufagen.

or

An dieser Stelle haben Sie erfolgreich ein Konto erstellt, entweder
mit der App oder Uber die Web-Benutzeroberflache.

Um mit der WLAN-Einstellung fir die IP-Kamera iber den Access-
Point Modus fortzufahren, befolgen Sie Abschnitt 3 in dieser
Betriebsanleitung.

Beachten Sie, dass bei der DN-16047 die Kamera Uber den
Access-Point Modus mit dem Internet verbunden werden muss.

Gehen Sie zu Abschnitt 4 in dieser Bedienungsanleitung, wenn lhre
Kamera uber ein Netzwerkkabel mit lnrem Router verbunden ist.
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3. Verbinden der Plug&View-IP-Kamera uiber

WLAN

3.1 Mit einem Smartphone/Tablet

Offnen Sie die WLAN-Einstellungen
auf lhrem Smartphone/Tablet.
Suchen Sie nach verfiigbaren
drahtlosen Netzwerken in der
unmittelbaren Umgebung. Die
Kamera wird als ein drahtloses
Netzwerk mit ihrer Modellnummer
und die letzten 6 Zeichen der MAC-
Adresse angezeigt.

Plugandview

AEGANT

AEGA0G

AEG-Guest

AEGPMIT

4 4 9 4 4 o

DN-16047-003F08
W PMMassmann

W AcerProjectork_Bode

WLAN (/

+  PlugandView a= (i)

NETZWERK WAHLEN

- ®

Fp——— a = T

Verbinden Sie Ihr Smartphone/Tablet tiber die WLAN-Verbindung
mit der IP-Kamera.

weecon2-de+ 3G n:23 4 69 %

Nachdem das Smartphone/
< Einstellungen WLAN

Tablet mit der Kamera
verbunden ist, kdnnen Sie die WLAN
Installation der Plug&View-App
fortsetzen. Offnen Sie die
Plug&View-App.

> 8

« DN-16048-07a405

)
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Die Plug&View-App stellt eine
Verbindung mit einer Plug&View-
Kamera her, die im Access-
Point-Modus betrieben wird und
fordert Sie auf, das WLAN-
Netzwerk auszuwéahlen, mit dem
die Kamera verbunden ist.

Back Die verfiigbaren Netzwerke in der
hoose your wiraless network unmittelbaren Umgebung werden
bssid signal ssid angezeigt. Wahlen Sie hier das
PlugandView Netzwerk aus, mit dem die Kamera
verbunden werden soll. Wenn lhr
Netzwerk nicht angezeigt wird,
mussen Sie mdglicherweise die
Kamera neu positionieren.

ACHTUNG: Versteckte SSIDs, also versteckte WLAN-Netzwerke
werden von der Kamera nicht unterstiitzt. Bitte machen Sie lhr
Netzwerk sichtbar, wenn Sie lhre Kamera damit verwenden
wollen.
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wenco pieder F Mids {76 % -

 Back Wi-Fi Setting

[WPA-PSK-TKIP][ESS]

Cancel

Please re-cannect the WIF| of your mobile phone 1o the wireless
router or AP before [ogin 1@ DIGITUS Plug&View

oK

Geben Sie das Netzwerk-Passwort
in das Feld Passwort ein, mit dem
lhr WLAN-Netzwerk verschlisselt
ist und bestatigen Sie die Eingabe
mit ,,OK*.

Unter Android werden Sie
aufgefordert, nach der erfolgreichen
Verbindung mit Ihrem Smartphone/
Tablet sich erneut mit lhrem WLAN
zu verbinden.

In der Regel geschieht dies
automatisch. Sollte dies nicht der
Fall sein, gehen Sie bitte zu den
WLAN-Einstellungen lhres
Smartphones/Tablets und stellen
Sie eine Verbindung mit lhrem
WLAN her.



4. Plug&View IP-Kamera hinzufiigen

4.1 Mit einem Smartphone/Tablet

Driicken Sie die Taste ,+“, um
eine neue Kamera wahrend der
ersten Installation der Plug&View-
Kamera hinzuzufigen.
Navigieren Sie zu den
Einstellungen (Zahnrad-Symbol
oben rechts) und tippen Sie auf
»Kamera hinzufligen®, falls dort
bereits Kameras vorhanden sind.
Dies kann einfach durch das
Scannen des QR-Codes mit lhrem
Smartphone/Tablet oder durch die
manuelle Eingabe der
Aktivierungsdaten erfolgen.

Folgenden Gerate sind fiir das Scannen eines QR-Codes geeignet:
Apple iPhone®, Apple iPad®, Android-Smartphone, Android-Tablet-
(mit integrierter Kamera auf der Rickseite).

Die MAC-Adresse, den Aktivierungscode und den QR-Code finden
Sie auf der letzten Seite dieses Handbuchs.

Hinweis: Die Android-Version des mobilen Gerats sollte
mindestens 2.3.5 oder héher sein.
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Hinzufiigen der Kamera durch Scannen des
QR-Codes

] Wahlen Sie auf der nachsten Seite
die Option ,Scan QR code”.
Die Scanfunktion des QR-Codes
lhres mobilen Gerats wurde
aktiviert.

[ Scan QR Code

¥

Manual Input

Bitte scannen Sie den QR-Code auf der letzten Seite dieses
Handbuchs, um die Kamera zu Ihrem Konto hinzuzufiigen.

Waéhrend des Scannens des QR-Codes mussen Sie mdglicherweise
Ihr mobiles Geréat vorwarts und riickwarts bewegen, bis der Code
erkannt wird.

Hinzufiigen der Kamera durch die manuelle Eingabe
der MAC-Adresse und des Aktivierungscodes

Die MAC-Adresse und der Aktivierungscode finden Sie auf der
letzten Seite dieses Handbuchs. Navigieren Sie zu ,Manual input®,
nachdem Sie ,Add camera*“ in der Plug&View-App ausgewahlt haben.



Geben Sie die alphanumerische Kombination ein, die Sie unter
,MAC*" gefunden haben. Geben Sie dann Ihren Aktivierungscode
ein und klicken Sie auf ,Apply*“.

4.2 Figen Sie die Kamera liber den Browser zum
PC hinzu

PC-/Notebook-Benutzer kénnen auch Kameras zu lhrem Konto
hinzufligen. Das ist ein ahnlicher Vorgang wie unter 4.1 mit dem
mobilen Gerat dargestellt.

Nach der ersten Anmeldung an der Kamera-Verwaltungsseite tGber
http://www.plug-view.com zur ,Anmeldung“ mit lhrem Account und
Passwort werden Sie auf der ,Download“-Seite aufgefordert, das
Plug-In zu installieren. Bitte klicken Sie auf Download und folgen
Sie den Anweisungen zur Installation.

Please download the new version of "Plug&View
plugin™ for camera liveview:

If you have already downloaded before, check the
following:

« Enable P2P Viewer in Chrome extension.
Open Menu > Settings > Extensions > P2P Viewer

« If you have ever deleted the plugin before, please download
the Plug&View plugin

« |f P2P Viewer does not exist in the Chrome extension list,
please download P2P Viewer

« Chrome installation tutorial
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Nach der Installation des

- " Plug-Ins rufen Sie die

7 Anmeldeseite erneut tiber
http://www.plug-view.com
mit Ihrem Konto auf.

@
LL p— Driicken Sie zu Hinzufiigen
der Kamera das Zeichen ,+.“

Please complete registration in 60 minutes
after boot up your camera, or you need to Driicken Sie dann das
re-power the camera and complete Zeichen .>“ um zur

registration process again. nichsten Seite gehen und
fuhren Sie die folgenden
Schritte aus.

Geben Sie die MAC-Adresse und den Aktivierungscode von der
letzten Seite der Bedienungsanleitung ein und driicken Sie ,Apply*,
um die Kamera hinzuzufiigen.

Add Camera

MAC Address

Activate Code
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Nach dem erfolgreichen Hinzufiigen der Kamera zu Ihrem Konto,
Uberprifen Sie, ob lhre Kamera mit dem Livebild angezeigt wird.

P ogesmydpusnet
PlugaView =

Wenn Sie planen, lhre Plug&View Kamera mit einem
Netzwerkkabel zu verwenden, ist das Setup hier abgeschlossen.

Wenn Sie jedoch vorhaben, die drahtlose Verbindung mit dem WLAN
fur Flexibilitat bei der Ortswahl zu verwenden, lesen Sie weiter.
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5. Einrichten von WLAN auf PC/Notebook

Die Einrichtung der drahtlosen (WLAN) Verbindung zwischen der
IP-Kamera und dem WLAN-Router/Access-Point kann auch auf
dem PC/Notebook Uber einen Browser erfolgen

Melden Sie sich nach der erfolgreichen Installation der Kamera auf
der Website ,http://www.plug-view.com* an. Klicken Sie auf ,Login |
My camera administration*.

Verwenden Sie Ihr Plug&View-Konto oder wahlen Sie die Google-
Anmeldung. Wenn Sie nicht bei lhrem Google-Konto angemeldet sind,
werden Sie automatisch zur Google-Anmeldeseite weitergeleitet.

Nach Eingabe lhrer Anmeldedaten sehen Sie das Livebild der Kamera.

Auf der rechten Seite des

&
Kamerabilds sehen Sie einige x
Symbole. Klicken Sie auf die
Schaltflache ,Camera Configuration®, @
um die Benutzeroberflache der
Kamera zu 6ffnen.

G

‘ Camera Configuration
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Dann 6ffnet sich ein weiteres Fenster, was die Web-
Benutzeroberflache der Kamera darstellt. Melden Sie sich mit dem
standardmaRigen Anmeldekonto der ,Kamera“ mit ,,admin“ und dem
Password ,,admin“ an. Wenn Sie die Option ,Autologin“ auswahlen,
werden Sie beim nachsten Zugriff automatisch fir den Zugriff auf das
Konfigurationsmenii angemeldet. Klicken Sie auf ,Login“.

DIGITUS® PLUG&VIEW

safe&secure - anywhere. anytime.

Language: | English ~
Stream:

[ Auto Login

Klicken Sie auf der Benutzeroberflaiche der Kamera auf ,Wi-Fi“, um
Wi-Fi-Einstellungen vorzunehmen.

DlGlTUSV safé&seéur;—anywhéfe.anytime.

Home Replay Parameters System Wireless

Es o6ffnet sich ein Suchfenster in dem die verfiigbaren drahtlosen
Netzwerke in der Umgebung angezeigt werden. Bitte wahlen Sie die
Kennung (SSID) Ihres Netzwerks aus und bestatigen Sie mit ,OK".

Signal  Authentifizierungsmodus
[ P ES% [WRA-FSH-THIP)[WRAZ-PSK-COMPIWRS][ESS]
O Piugandview BE% [WRA-PSK-THIF)[ESS]

~
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Im nachsten Fenster geben Sie den WLAN-Schlussel ein und
bestatigen Sie mit ,OK".

Achten Sie darauf, dass
Ihr Router als ein DHCP-
ok Server arbeitet. Dies ist
die Werkseinstellung von
fast allen Routern.

Als nachstes wird die
Verbindung zu Ihrem
drahtlosen Netzwerk
aufgebaut. Wenn die
Verbindung erfolgreich
hergestellt wurde, wird
dies in einem separaten
Fenster angezeigt.

Paszwaort:

Sie konnen jetzt das Netzwerkkabel von der Kamera entfernen
und das Browser-Fenster schliefRen.

Herzlichen Glickwunsch! Sie haben gerade Ihre Plug&View IP-
Kamera eingerichtet. Jetzt kdnnen Sie jederzeit von lhrem
Smartphone, Tablet-PC oder von einem Browser auf lhre IP-
Kamera zugreifen.
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6. Bewegungserkennung und Aufzeichnung

einrichten

Das DIGITUS® Plug&View-System bietet optionale
Bewegungserkennung und Aufzeichnung. Um diese Funktion zu
verwenden, mussen Sie die SD-Karte in der Kamera formatieren
und Bewegungserkennung aktivieren.

Greifen Sie fiir die Formatierung der SD-Karten tiber die Web-
Benutzeroberflache auf die Kamera zu.

Auf der rechten Seite des

Kamerabilds sehen Sie einige \!j
Symbole. Klicken Sie auf die
Schaltflache ,Camera
Configuration®, um die (O}
Benutzeroberflache der Kamera zu
offnen.
4
G

Camera Configuration

Dann 6&ffnet sich ein weiteres Fenster, was die Web-
Benutzeroberflache der Kamera darstellt. Melden Sie sich mit dem
standardmafigen Anmeldekonto der ,Kamera“ mit ,,admin“ und dem
Password ,,admin“ an. Wenn Sie die Option ,Autologin“ auswahlen,
werden Sie beim nachsten Zugriff automatisch fiir den Zugriff auf das
Konfigurationsmenl angemeldet. Klicken Sie auf ,Login*“.

Sie kénnen Uber das Menu auf die SD-Karteninformationen
zugreifen, indem Sie zu ,System*” -> ,Local storage” gehen.
Formatieren Sie die SD-Karte Uber den Menupunkt ,Format®.
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Nach der Formatierung kann die Bewegungserkennung aktiviert
werden.

Klicken Sie auf der Web-Benutzeroberflache auf ,Parameters” ->
»,Motion Detect".

D I G lTUS safes&secure - anywhere. anytime.

Replay Parameters Wireless

Activate: M Enable

Action:

E-Mail Send E-mail

Output: Alarm With Snapshot ]  send ToEmail & Upload to FTP

Alarm With Record |4 Upload to FTP

AU

Trigger Alarm Output

)

Schedule: O WeekMode O WorkMode ® Aways Time

Klicken Sie zum Aktivieren der Bewegungserkennung ,ON*. Der
farbige Bereich im Videobild ist der Bereich der
Bewegungserkennung, d. h. der Bereich, in dem eine Bewegung
ein Bild oder eine Videoaufzeichnung auslost. Im urspriinglichen
Auslieferungszustand ist fast der gesamte Bildschirm mit roten
Kéastchen bedeckt. Klicken Sie auf die Farbmarkierungen, um
bestimmte Bereiche von der Bewegungserkennung
auszuschlieBen. Auf diese Weise I6schen Sie die Markierung fur
diesen Bereich. Sie kdnnen die Empfindlichkeit der
Bewegungserkennung unter ,Sensibility” einstellen. Wahlen Sie aus
den folgenden vier Stufen: ,Very high“, ,High*, ,Normal“ und ,Low".
Aktivieren Sie ,Alarm with recording“, um im Fall einer erkannten
Bewegung auf der SD-Karte zu speichern.
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Die Zeiteinstellung beeinflusst den Zeitplan fir die
Bewegungserkennung. Sie kdnnen mit den Modi Wdchentlich,
Arbeitstag oder Vollzeit aufzeichnen.

Sie kdnnen den Zeitplan einzeln einstellen.

Speichern Sie die Konfiguration mit ,Apply*.

Sie haben erfolgreich die Bewegungserkennung mit der Aufzeichnung
eingerichtet.

Fiir Erlauterungen zur Web-Benutzeroberflache siehe
Bedienungsanleitung der Kamera auf der mitgelieferten CD.

Gehen Sie bei Fragen zum FAQ-Bereich auf unserer Plug&View-
Seite (http://www.plug-view.com/) oder wenden Sie sich an
unsere Hotline (http://www.plug-view.com/support-de/support/).

Eingetragene Warenzeichen

DIGITUS ist ein eingetragenes Warenzeichen der ASSMANN
Electronic GmbH.

Apple und Apple App Store sind eingetragene Warenzeichen von
Apple Inc.

Android, Google und Google Play sind eingetragene Warenzeichen
von Google Inc.

AVM Fritz!Box ist ein eingetragenes Warenzeichen der AVM
Computersysteme Vertriebs-GMBH.

Telekom Speedport ist ein eingetragenes Warenzeichen der
Deutsche Telekom AG.

Hinweis:

Alle anderen hier nicht aufgefihrten Warenzeichen sind das
Eigentum ihrer jeweiligen Eigner.

Die in diesem Handbuch genannten Warenzeichen oder
Handelsnamen dienen der Beschreibung der Bedienung dieses
Gerats und sollen nicht andeuten, dass diese nicht geschitzt sind.
Unabhangig davon sind sie das Eigentum der jeweiligen
Rechteinhaber.
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Hiermit erklart die ASSMANN Electronic GmbH, das der Artikel in
Ubereinstimmung mit den Anforderung und Vorschriften der
Richtlinien 2014/53/EU und RoHS 2011/65/EU befindet. Die
vollstandige Konformitatserklarung kénnen Sie postalisch unter der
unten genannten Herstelleradresse anfordern.

Warnung:

Dies ist eine Einrichtung der Klasse B. Diese Einrichtung kann im
Wohnbereich Funkstérungen verursachen. In diesem Fall kann vom
Betreiber verlangt werden, angemessene MaRRnahmen durchzufiihren.

www.assmann.com
Assmann Electronic GmbH
Auf dem Schiiffel 3
58513 Lidenscheid

Germany —
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DIGITUS"

Caméra IP DIGITUS®
Plug&View

Guide d'installation rapide



Précautions de sécurité

N'utilisez la caméra IP Plug&View que dans la plage de température
spécifiée pour cet appareil

Lorsque I'appareil n’est pas utilisé, le ranger dans un endroit
propre et sec a une température comprise entre 0°C et 40°C

Ne couvrez pas la caméra

Ne laissez pas la caméra entrer en contact avec des liquides
(sauf pour les caméras extérieures qui sont dotées de I'indice de
protection IP66)

Les caméras IP Plug&View ne remplacent jamais la vigilance des
adultes. Prenez soin de vos enfants, membres de famille et
animaux domestiques en les surveillant régulierement

Ce modele de caméras IP ne doit étre utilisé qu’a l'intérieur. Elles
ne sont pas destinées a une utilisation en extérieur ou elles
risquent d’étre endommagées. Pour I'extérieur, utilisez les
modéles appropriés

Installez les caméras IP Plug&View a proximité d'une prise de
courant murale facilement accessible. Veillez a ce que le cordon
d'alimentation ne soit pas tendu

Placez les caméras IP Plug&View dans le rayon de portée de
votre routeur Wi-Fi et veillez a ce qu'aucun obstacle ne se trouve
entre une caméra et le routeur, cela pourrait interférer avec le
signal Wi-Fi



Il faut protéger vos caméras IP Plug&View des appareils
électriques et des appareils HF qui générent des interférences
(fours a micro-ondes, téléphones portables, etc.)

Les caméras, cables réseau et cordons d'alimentation peuvent
étre dangereux, il faut les garder hors de la portée des enfants

N'utilisez que I'adaptateur secteur inclus.

N'essayez jamais de réparer vous-méme une caméra IP Plug&View.
Toute réparation et tout entretien doit étre effectué par un personnel
qualifié.

En cas de problemes, contactez notre service a la clientéle.

Il faut veiller a respecter toutes les lois applicables en matiére de
vidéosurveillance. Les caméras IP Plug&View sont destinées a
un usage domestique. N’oubliez pas d’informer les membres de
votre famille, vos proches et aides domestiques de la
vidéosurveillance installée chez vous. Veillez a ce que vos
caméras ne captent ni des espaces publics ni vos voisins.



Informations personnelles

* |l faut lire et accepter la politique de confidentialité sur
I'utilisation des systémes DIGITUS® Plug&View se trouvant sur
http://plug-view.com/privacy-policy-for-platform-apps/.

¢ |l faut choisir un mot de passe fort pour protéger votre compte
Plug&View de tout accés non autorisé.

e Ce dernier doit contenir au moins 8 caractéres ; majuscules et
minuscules et des chiffres.

* En plus, il faut changer régulierement le mot de passe de la
caméra afin d'éviter tout accés non autorisé.

La diffusion en direct, les notifications push et d'autres
services se font via un serveur cloud. Malgré les solutions de
sauvegarde, la stabilité du systéme et la gestion de la bande
passante, la disponibilité continue du systéme ne peut étre
garantie.

Contenu du coffret

1 x caméra IP Plug&View En option :

1x adaptateur d'alimentation avec 1 x cable Ethernet

cable 1 x support de montage au
1x Guide d'installation rapide plafond/mural

1x CD d'utilitaires 1 x antenne amovible

* Les caméras ci-dessous sont équipées d'une antenne amovible :
DN-16029, DN-16039, DN-16043, DN-16048, DN-16049

Nous vous félicitons d'avoir choisi cette caméra IP Plug&View, qui
peut étre installée rapidement et utilisée facilement sans
parametres réseau complexes.



Installation d'une carte mémoire MicroSD

Les caméras d'intérieur DIGITUS® Plug&View peuvent utiliser une
carte microSD pour I'enregistrement.

Les illustrations ci-aprés vous donnent les différentes options
d'installation.

DN-16047

Installez la carte SD avec les
contacts jaunes orientés vers
I'objectif de la caméra,
comme illustré.

DN-16046

Installez la carte SD avec les o
contacts jaunes orientés vers 2’ “*J_
I'objectif de la caméra, 3@
comme illustré. L L
DN-16029

Installez la carte SD avec les
contacts jaunes orientés vers

le haut, comme illustré. |i !\



Raccordements de la caméra

LAN :

Connectez la caméra au port
LAN de votre routeur.
Bouton de réinitialisation :

Bou

i

Almentaton 5 VCC

wes l

|
K

Maintenez appuyé le bouton de
réinitialisation pendant

10 secondes aprés le démarrage
de la caméra pour restaurer les
paramétres par défaut.
Alimentation :

Branchez le cordon
d'alimentation fourni pour
alimenter la caméra.

MicroSD :

Insérez une carte MicroSD
pour la sauvegarde locale.
Microphone : Micro (entrée
audio).

Sortie audio :

Vous pouvez connecter un
haut-parleur externe a l'aide
d’un cable audio 3,5 mm.
WPS :

Maintenez appuyé le bouton
WPS pendant 8 secondes aprés
le démarrage de la caméra pour
activer le mode WPS.

(* DN-16029 et DN-16046
sont dotées d'un bouton WPS)
Alarme :

Broche 1 : Entrée d'alarme
Broche 2 : Terre

Broche 3 : Non utilisée

Broche 4 : NON

uuuuuuuuu

Po

i

Fente pour carte MicroSD  Entréelsorte Galame

rt réseau
Sortie audio

Jiii e

T
. 5

Alimentation 5 VCC
CEQZ
es B

* o ©

Réinitialisation

wpPS

Fente pour carte

MicroSD

Fente pour carte MicroSD

Alimentation 5 VCC



Raccordements de la caméra

Les caméras d’extérieur DIGITUS® Plug&View sont équipées d'un
cable spécial.

Les illustrations ci-aprés vous donnent les différentes options
d'installation.

. Bouton de
réinitialisation :
Maintenez appuyé ce
bouton pendant
10 secondes apres la
connexion de la caméra et
sa mise en marche. Cette
opération restaure les
parametres par défaut de
la caméra.

. Cable réseau :

Branchez le cable réseau
dans le routeur de votre
réseau pour établir une
connexion Internet.

. Raccordement de
I'alimentation 12 VCC :
Branchez I'adaptateur
secteur pour alimenter la
caméra.

. Témoin d'état :

Le témoin d'état bleu
indique que la camera est
sous tension.

Les modeles de caméras DN-16039, DN-16043et DN-16048 peuvent
étre alimentées directement via le cable réseau connecté a un
injecteur ou commutateur PoE.



Réglages de I'objectif

DN-16039
DN-16043

Mise au point (angle)
Vous pouvez L
effectuer la mise au  Réglage de lanetteté
point et régler la
netteté a l'aide des
boutons de
commande. Servez-
vous de l'image en
direct de la caméra
pour effectuer la
mise au point et
régler la netteté.



1. Préparations

Certaines préparations doivent étre effectuées avant de pouvoir
utiliser votre caméra IP.

Raccordement de I'antenne

Branchez I'antenne sans fil dans le connecteur et serrez les boulons
de fixation.

Insertion de carte SD

Les caméras IP Plug&View prennent en charge les cartes microSD
de capacité allant jusqu'a 32 Go, que vous pouvez acheter auprés
de détaillants. Les images et vidéos prises par la caméra IP sont
stockées sur cette carte.

Si votre caméra est dotée d'un port externe et pas de mémoire
interne, insérez votre carte MicroSD dans la fente correspondante
jusqu'a ce qu'elle s'enclenche.

Branchement de I'alimentation

Branchez le cable de I'adaptateur d'alimentation fourni dans la prise
« Power » de la caméra.

Connexion de la caméra a un routeur (ex. AVM Fritz!
Box, Telekom Speedport etc.)*

Connectez une extrémité du cable réseau fourni au port LAN de la
caméra. Connectez l'autre extrémité du cable réseau a I'un des
connecteurs marqués « LAN » situés a l'arriére de votre routeur.
Certains routeurs n'offrent qu'une seule connexion LAN, d'autres
plusieurs. Votre routeur doit disposer d'une connexion Internet
active.

* Vous pouvez ignorer ce point en mode point d'acces des caméras.
Ce point doit étre ignoré pour le modéle DN-16047.



2. Création d'un compte d'utilisateur

Plug&View

Pour utiliser votre caméra Plug&View et bénéficier d'une vidéo en
direct partout et & tout moment, vous devez |'enregistrer avec un
compte utilisateur Plug&View. La configuration et le controle
peuvent étre effectués a partir de votre smartphone/tablette ou
PC/ordinateur portable.

2.1 Création de compte utilisateur avec votre
smartphone/tablette

Si vous avez un appareil iOS Apple®, Vous pouvez trouver notre
application « DIGITUS® Plug&View » sur I'’App Store® d’Apple. Pour
les smartphones et tablettes fonctionnant sous Google Android,
vous trouverez notre application « DIGITUS® Plug&View » dans
Google™ Play Store.

Dans le champ de recherche de I'App Stores® entrez « Digitus » ou
« DIGITUS Plug&View ».

Apple App Store® Google™ Play




Dans les résultats de recherche, I'application

w « DIGITUS® Plug&View » sera marquée par ce

symbole.

Installez ensuite I'application sur votre appareil portable.

Lancez l'application sur votre tablette ou smartphone. Vous
disposez de 2 options pour créer votre compte :

1. Sivous avez déja un compte Google, vous pouvez s'en servir
pour utiliser I'application Plug&View, ou

2. Créer directement un nouveau compte Plug&View avec un nom
d'utilisateur et un mot de passe différents.

= 11:00 sm5 1, Se connecter avec un
compte Google

Cliquez sur « g » pour
vous connecter avec « un
compte Google ». Vous
pouvez utiliser votre
adresse e-mail et mot de
passe Google pour vous
connecter.

Ou

2. Créer un nouveau
compte avec Plug&View

Cliquez sur « Create
e Account ».

1"



= 1:02 CR |
Terms of Use Agreement

Fiir die Nutzung der Plug8View Plattform via Browser oder App ist es

erlorderlwm die Datmsch utzerklarung. die Sie unter hitp:/plug
fprivacy-polic slatform-apps/ nachlesen kdnnen, zu

akzepneren

Eridérung:

Ich habe die Datenschutzeridérung der Assmann Electronic GmbH zur

Kenntnis genommen und willige in die Datenvereinbarung gemas der

Daienschu!zeka.ung in, Ich kann meine Einwiligung jederzeit unter

digitus.info wiedernufen,

er weisen jedoch darauf hin, dass die Plug&View App dann nicht mehr

genutzt werden kann

To use the Plug&View platform via the browser or app, it is necessary
that you agree to the privacy

policy, which you can find at http://plug T y-for
platform-apps/ Privacy policy:

| have acknowledged the privacy policy of Assmann Electronic GmbH,
and hereby consent to the dala agreement according to the privacy
pollcy 1 may revoke my consent at any time by contacting

digitus.info,

However, we must point out that in the event consent is revoked, the

Il faut lire et accepter
la politique de
confidentialité sur
l'utilisation des
systémes DIGITUS®
Plug&View.

Sur la page suivante,
choisissez un nom
d'utilisateur, un mot
de passe et
confirmez votre
adresse e-mail.

Appuyez ensuite sur « Apply » pour créer votre compte Plug&View.
Vous recevrez un e-mail contenant des instructions sur la fagon
d'activer votre compte. Accédez ensuite a I'application via « Login »
en utilisant votre nom d'utilisateur et mot de passe. Vous pouvez
alors ajouter votre caméra au compte (passez au point 3).

2.2 Créer un compte utilisateur avec votre PC

L'application prend en charge le systeme DIGITUS Plug&View ainsi
que l'accés au navigateur via PC/ordinateur portable.

Rendez-vous sur le site web http://plug-view.com
Cliquez ensuite sur « Login » pour accéder au portail Web Plug&View.



1. Se connecter avec un
compte Google

Cliquez sur « g » pour vous
connecter avec « Google
8 Login ». Vous pouvez utiliser
votre adresse e-mail et mot
de passe Google pour vous
connecter.

Ou

Create Account 2. Créer un nouveau compte
avec Plug&View

Cliquez sur « Create Account ».
Complétez les informations de
ol e la page suivante et confirmez
avec « Apply ». Vous recevrez
un e-mail contenant des
DIGITUS® instructions sur la fagon
d'activer votre compte. Sur la
page de connexion, vous
pouvez vous connecter avec
vos données utilisateur et
ajouter votre caméra.

Assmann Electronic GmbH

A ce stade, vous avez créé un compte soit par 'application, soit via
un portail Web.

Pour continuer la configuration WiFi de la caméra IP via le mode
point d'accés, suivez la section 3 de ce guide.

Pour le modéle DN-16047, il est indispensable de connecter la
caméra a Internet via le mode point d'acces.

Passez a la section 4 de ce guide si votre caméra est connectée a
votre routeur via un cable LAN.

13



3. Connexion Wi-Fi d’'une caméra IP

Plug&View

3.1 A I'aide de smartphone/tablette

Ouvrez les paramétres Wi-Fi sur

votre smartphone/tablette.

Recherchez les réseaux sans fil
disponibles dans le voisinage
immédiat. La caméra sera affichée
comme un réseau sans fil avec son
numéro de modele et les six derniers

caracteres de son adresse MAC.

4049992
]
i

ON-16047-003F00

E

FAAM Assmann

E

cmProqectons_Bode

WLAN O

+  PlugandView a= (i)

NETZWERK WAHLEN

DN-16049-07a405 =+ (

Annreai a= (1

Connectez votre smartphone/tablette a la caméra IP via la connexion
WLAN.

#sec0 02-de+ 36 n23  eoxmmy

Une fois le smartphone/tablette
< Einstellungen ~ WLAN

connecté a la caméra, vous
pouvez poursuivre l'installation WLAN L
de I'application Plug&View.

Lancez I'application Plug&View.

~ DN-16049-072405 = (D



L’application Plug&View détecte
la connexion a un appareil
Plug&View fonctionnant en
mode point d'accés et vous
demande de sélectionner le
réseau Wi-Fi auquel la caméra
va étre connectée.

Back Les réseaux disponibles dans le

cr voisinage seront affichés.
Sélectionnez ici le réseau auquel la
caméra va étre connectée. Si votre
réseau n’est pas affiché, il se peut
que vous deviez repositionner la
caméra.

ATTENTION : Un SSID masqué, signifie des réseaux Wi-Fi
masqués, non pris en charge par la caméra. Il faut rendre votre
réseau visible pour pouvoir y connecter votre caméra.

15



weeo o2-dar ¥ mas

{ Back Wi-Fi Setting

| e

seessnnsns

Cancel

Please se-connect the WiFl of your mobie phone 10 The wireless

your
Foutes o AP before logn 1o BIGITUS Plugtiew

o

Entrez dans le champ mot de
passe, le mot de passe du réseau
avec lequel votre réseau WLAN
est crypté et confirmez avec OK.

Sous les systémes d'exploitation
Android, et une fois la connexion
établie avec succes, il vous sera
demandé de reconnecter votre
smartphone/tablette a votre réseau
Wi-Fi.

En régle générale, cela se fait de
fagon automatique. Si ce n’est pas
le cas, allez aux parameétres Wi-Fi
de votre smartphone/tablette et
connectez-vous a votre réseau
Wi-Fi.



4. Ajouter la caméra IP Plug&View

4.1 A raide de smartphone/tablette

Appuyez sur « + » pour ajouter une
nouvelle caméra lors de la premiere
installation d'une caméra Plug&View.
Allez a paramétres (icone de
couronne dentée dans le coin
supérieur droit) et appuyez sur

« Add camera » si des caméras
existent déja. Il suffit de scanner le
code QR avec votre smartphone/
tablette ou d’entrer manuellement
les données d'activation.

Vous pouvez utiliser le code QR avec les appareils suivants : Apple
iPhone®, Apple iPad®, smartphone Android, tablette Android (avec
caméra intégrée a l'arriere).

L'adresse MAC, le code d'activation et le code QR se trouvent sur
la derniére page du présent manuel.

Remarque : La version Android de I'appareil portable doit étre au
moins 2.3.5 ou supérieure.

17



Ajout de caméra par scannage du code QR

] Sur la page suivante, sélectionnez
I'option « Scan QR code ».
La fonction de scannage du code
QR de votre appareil portable sera
activée.

Scannez le code QR situé a la derniére page de ce guide pour
ajouter la caméra a votre compte.

Pendant le scannage du code QR, il se peut que vous ayez a
déplacer votre appareil portable vers l'arriére et vers I'avant jusqu'a
ce que le code soit reconnu.

Ajout de la caméra en entrant manuellement
I'adresse MAC et le code d’activation

L'adresse MAC et le code d'activation se trouvent sur la derniére
page du présent manuel. Allez a « Manual input » aprées avoir
sélectionné « Add camera » dans I'application Plug&View.

Entrez les caractéres alphanumériques se trouvant sous « MAC ».
Entrez ensuite votre code d'activation et cliquez sur « Apply ».

18



4.2 Ajout de la caméra au PC via le navigateur

Pour les utilisateurs de PC/ordinateurs portables, vous pouvez
également ajouter des caméras a votre compte ; le processus
similaire a celui de la section 4.1 avec un appareil portable.

Apres la premiére connexion dans votre page d’administration de la
caméra via http://www.plug-view.com pour « vous connecter » avec
votre compte et mot de passe, il vous sera demandé de

« Télécharger » la page pour installer le plug-in. Appuyez sur
télécharger et suivez les instructions pour l'installer.

Please download the new version of "Plug&View
plugin” for camera liveview:

If you have already downloaded before, check the
following:

« Enable P2P Viewer in Chrome extension
Open Menu > Settings > Extensions > P2P Viewer

+ If you have ever deleted the plugin before, please download
the Plug&View plugin

« If P2P Viewer does not exist in the Chrome extension list,
please download P2P Viewer

« Chrome installation tutorial

19



AL

Please complete registration in 60 minutes

after boot up your camera, or you need to
re-power the camera and complete
registration process again.

Apreés l'installation du plug-
in, accédez de nouveau a la
page de connexion via
http://www.plug-view.com
avec votre compte.

Appuyez sur le bouton « + »
pour ajouter la caméra.

Appuyez ensuite, sur le
bouton « > » pour aller a la
page suivante et suivez les
différentes étapes.

Entrez ensuite, 'adresse MAC et le code d’activation comme
indiqué a la derniere page du guide d'utilisation et appuyez sur

« Apply » pour ajouter la caméra.

20
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Activate Code




Apres l'ajout de la caméra a votre compte, vérifiez dans la liste des

caméras de |'application, si votre caméra est affichée avec vue en
direct.

.oe .

La configuration se termine ici si vous envisagez d'utiliser
votre caméra Plug&View avec un cable réseau.

Toutefois, si vous envisagez d'utiliser une connexion Wi-Fi pour
plus de flexibilité dans le choix de I'emplacement, poursuivez la
lecture.
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5. Configuration de Wifi sur PC/ordinateur

portable

La configuration de la connexion sans fil (Wi-Fi) entre la caméra IP
et le routeur/point d'accés Wi-Fi se fait sur le PC/ordinateur portable
via le navigateur

Une fois la caméra est installée avec succes, connectez-vous au
site web « http://www.plug-view.com ». Cliquez sur « Login | My
camera administration ».

Utilisez votre compte Plug&View ou sélectionnez la connexion
Google. Si vous n'étes pas connecté a votre compte Google, vous
serez automatiquement redirigé vers la page de connexion Google.

Aprés avoir entré vos données de connexion, vous pouvez voir la
page vue en direct de la caméra.

Certains icones vont apparaitre sur I

le coté droit, au-dessus de l'image b

de la caméra. Cliquez sur le bouton

« Camera Configuration

(Configuration de la caméra) »pour ©

étre redirigé vers l'interface

utilisateur de la caméra. by
G

‘ ‘ , Camera Configuration
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Ceci ouvre une autre fenétre, qui est l'interface utilisateur Web de la
caméra. Veuillez vous connecter avec le compte de connexion

« caméra » par défaut avec le nom « admin » et le mot de passe

« admin ». Si vous sélectionnez I'option « Autologin », vous serez
connecté automatiquement la prochaine fois que vous accédez au
menu de configuration. Cliquez sur « Login ».

D[G]TUSO DIGITUS® PLUG&VIEW

safe&secure - anywhere. anytime.

R —
Lenguage:
Stream

Dans l'interface utilisateur de la caméra, cliquez sur Wi-Fi pour
configurer les paramétres sans fil.

safe&secure - anywhere. anytime.

Home Replay Parameters System Wireless

Une fenétre de recherche apparait, dans laquelle seront affichés les
réseaux sans fil disponibles dans votre voisinage. Sélectionnez
I'identifiant (SSID) de votre réseau et confirmez avec « OK ».

ssiD Signal  Authentifcierungsmodus.
PMM % -PSK-TKIP][ -PSK-CCMP][ JESS]
) TestPun 88% PSK-TKIF)[WPAZ-PSK-CCMF][WFS][ESS]
O Piugandview 88% [WPA-PSK-TKIPJ[ESS]

~ Sam masma A mALs e e A
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Dans la fenétre suivante, entrez la clé Wi-Fi et confirmez avec

« OK ».

Passwort:

ok

Veuillez vous assurer que
votre routeur fonctionne
comme un serveur
DHCP. C'est le réglage
par défaut de presque
tous les routeurs.

La connexion a votre
réseau sans fil sera
établie tout de suite
apres. Si la connexion est
établie avec succes, ce
message sera affiché
dans une fenétre
distincte.

Vous pouvez alors retirer le cable réseau de la caméra et fermer

la fenétre du navigateur.

Félicitations. Vous venez de terminer la configuration de votre
caméra IP Plug&view. Vous pouvez accéder a votre caméra IP a
tout moment a partir de votre Smartphone, tablette PC ou via un

navigateur.
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6. Configuration de la détection de

mouvement et de I’enregistrement

Le systéme DIGITUS® Plug&View offre les options de détection de
mouvement et d'enregistrement. Pour utiliser cette fonction, la carte
SD doit étre formatée dans la caméra et la détection de mouvement
doit étre activée.

Accédez a la caméra via le portail web pour formater la carte SD.

Certains icones vont apparaitre sur 0

le coté droit, au-dessus de I'image x

de la caméra. Cliquez sur le bouton

« Camera Configuration

(Configuration de la caméra) »pour O

étre redirigé vers l'interface

utilisateur de la caméra. by
v
G

' Camera Configuration

Ceci ouvre une autre fenétre, qui est l'interface utilisateur Web de la
caméra. Veuillez vous connecter avec le compte de connexion

« caméra » par défaut avec le nom « admin » et le mot de passe

« admin ». Si vous sélectionnez I'option « Autologin », vous serez
connecté automatiquement la prochaine fois que vous accédez au
menu de configuration. Cliquez sur « Login ».

Vous pouvez accéder aux informations de la carte SD en allant a

System -> Local storage. Formatez la carte SD via le menu
« Format ».
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Une fois le formatage terminé, la détection de mouvement peut étre
activée.

Allez a « Parameters » -> « Motion Detect » dans l'interface utilisateur
Web.

D lGITUS safe&secure - anywhere. anytime.

Home

Area:
Activate & Enatie

Sensibilty | Normal L Select All Clean All

Action:

E-Mail Send E-mail

Output: Alarm With Snapshot /1  Send ToEmall ) Uploed to FTP

Alarm With Record 4 Upload to FTP
Trigger Alarm Output

Schedule: Week Mode Work Mode @ Alvays

Cliquez sur « ON » pour activer la détection de mouvement. La
zone en couleur dans I'image vidéo est la zone de détection de
mouvement, c'est a dire celle qui déclenche une image ou un
enregistrement vidéo. A la livraison initiale, presque la totalité de
I'écran est recouverte de zones rouges. Cliquez sur les reperes de
couleur pour exclure certaines zones de la détection de
mouvement. Ainsi, vous supprimez cette zone. Vous pouvez régler
la sensibilité de détection de mouvement dans « Sensibility ».
Choisissez parmi les quatre niveaux suivants : « Very high »,

« High », « Normal » et « Low ».

Activez « Alarm with recording » pour enregistrer sur la carte SD
tout mouvement détecté.

HRAA

26



Le réglage de I'heure dépend du programme de détection de
mouvement. Vous pouvez enregistrer pendant toute une semaine,
les jours ouvrables ou de fagon continue.

Vous pouvez définir le programme d’enregistrement comme vous le
souhaitez.

Cliquez sur « Apply » pour enregistrer la configuration.

Vous venez de configurer avec succes la détection de mouvement
avec enregistrement.

Pour plus d’informations sur l'interface Web de la caméra
reportez-vous au guide d’utilisation fourni sur le CD.

Si vous avez des questions reportez-vous a la section FAQ de
la page Plug&View (http://www.plug-view.com/) ou contactez
notre service de téléassistance
(http://www.plug-view.com/support-de/support/).

Marques commerciales

DIGITUS est une marque déposée d'ASSMANN Electronic GmbH.
Apple, Apple App Store sont des marques déposées d'Apple Inc.
Android, Google, Google play sont des marques déposées de
Google Inc.

AVM Fritz!Box est une marque déposée d'AVM Computer systeme
Vertriebs GMBH.

Telekom Speedport est une marque déposée de Deutsche Telekom
AG.

Remarque :

Toutes les autres marques non citées ici, appartiennent a leurs
propriétaires respectifs.

Les marques ou noms de commerce mentionnés dans ce manuel
sont utilisés pour décrire les étapes d'utilisation et n'impliquent pas
qu'ils sont disponibles gratuitement. Dans tous les cas, ils sont la
propriété du détenteur des droits.
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La ASSMANN Electronic GmbH, déclare par les présentes, que cet
appareil est en conformité avec les exigences de la Directive
2014/53/EU et avec celles de la Directive 2011/65/EU sur la
conformité RoHS. La déclaration de conformité compléete peut étre
demandée par courrier a I'adresse du fabricant mentionnée
ci-dessous.

Avertissement:

Ce dispositif appartient a la classe B. Ce dispositif est susceptible
de provoquer des perturbations radio-électriques dans une zone
habitable. Il peut étre exigé a I'utilisateur de prendre des mesures
appropriées

www.assmann.com
Assmann Electronic GmbH
Auf dem Schiiffel 3

58513 Liidenscheid
Germany
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DIGITUS"

Telecamere IP
DIGITUS® Plug&View

Guida Rapida d’Installazione



Precauzioni di sicurezza

Utilizzare la telecamera IP Plug&View solo nell'intervallo di
temperatura specificato per tale prodotto

Quando non in uso, conservare il prodotto in un luogo pulito e
asciutto con temperature tra 0 °C e 40 °C

Non coprire la telecamera

Non lasciare che la telecamera entri in contatto con liquidi (tranne
telecamere per esterni dotate di copertura con grado di protezione
IP66)

Le telecamere IP Plug&View non sostituiscono la supervisione
degli adulti. Per proteggere la salute dei propri bambini, familiari o
animali domestici, controllarli regolarmente

Assicurarsi che le telecamere IP per interni siano utilizzate solo in
ambienti interni. Queste telecamere non sono destinate all'uso in
ambienti esterni e potrebbero subire danni. Se necessario,
utilizzare i modelli adatti all'uso in ambienti esterni

Installare le telecamere IP Plug&View vicino a una presa faciimente
accessibile. Accertarsi che il cavo di alimentazione non sia
sottoposto a tensione o pressione eccessiva

Installare le telecamere IP Plug&View nel raggio di portata del
router Wi-Fi e accertarsi che tra le telecamere e il router non ci
siano oggetti che possano interferire con il segnale Wi-Fi



Proteggere le telecamere IP Plug&View da dispositivi elettrici e ad
alta frequenza che producono interferenze (forni a microonde,
telefoni cellulari, ecc.)

Tenere le telecamere, il cavo di rete e il cavo di alimentazione
lontano dalla portata di bambini, in quanto tali componenti
possono costituire un pericolo per la loro incolumita

Utilizzare solo I'alimentatore fornito in dotazione.

Per nessun motivo cercare di riparare da soli le telecamere IP
Plug&View. Gli interventi di riparazione e manutenzione devono
essere eseguiti da personale specializzato.

In caso di problemi, contattare il nostro servizio clienti.

Attenersi a tutte le leggi applicabili al monitoraggio a mezzo
telecamere. Le telecamere IP Plug&View sono destinate
all'utilizzo privato in ambienti domestici. Informare i membri della
famiglia, parenti e collaboratori domestici sulla presenza di
telecamere di monitoraggio in casa. Accertarsi che le aree
pubbliche e le proprieta dei vicini siano fuori della portata della
telecamera.



Informazioni personali D)

* Leggere e accettare I'informativa sulla privacy per I'utilizzo dei
sistemi DIGITUS® Plug&View all'indirizzo
http://plug-view.com/privacy-policy-for-platform-apps/.

e Selezionare una password con un alto livello di sicurezza per
I'account Plug&View al fine di proteggerlo da un accesso non
autorizzato.

* La password deve contenere almeno 8 caratteri; consigliamo
una combinazione di lettere maiuscole e minuscole e caratteri
alfanumerici.

* Inoltre, per evitare un accesso non autorizzato, consigliamo di
modificare anche la password predefinita della telecamera.

Streaming live, notifiche push e altri servizi sono disponibili
tramite un server cloud. Nonostante le soluzioni di backup, la
stabilita del sistema e la gestione della larghezza di banda, non
e possibile garantire la disponibilita ininterrotta del sistema.

Cosa contiene la confezione

1 telecamera IP Plug&View Facoltativo:

1x Alimentatore con cavo 1 cavo Ethernet

1x Guida Rapida d’Installazione 1 supporto da soffitto/parete
1x CD con le utility 1 antenna rimovibile*

* Le seguenti telecamere sono dotate di antenna rimovibile:
DN-16029, DN-16039, DN-16043, DN-16048, DN-16049

La ringraziamo per aver scelto una telecamera IP Plug&view che
puo essere montata e operativa in modo rapido e semplice senza
impostazioni di rete complicate.



Installazione della scheda MicroSD

Le telecamere DIGITUS® Plug&View per interni possono essere
dotate di scheda MicroSD per la registrazione.
Controllare la modalita di installazione nelle immagini sottostanti.

DN-16047

Installare la scheda SD come
illustrato, con i contatti dorati
rivolti verso I'obiettivo della
telecamera.

DN-16046

Installare la scheda SD come -

illustrato, con i contatti dorati s

rivolti verso l'obiettivo della 4
Fg2°

telecamera.

DN-16029
Installare la scheda SD come
illustrato, con i contatti dorati

rivolti verso l'alto. |=!\



Connessioni della telecamera

LAN:

Collegare la telecamera alla
porta LAN del router.

Reset:

Dopo avere avviato la
telecamera, tenere premuto il
pulsante Reset per 10 secondi
per ripristinare le impostazioni
predefinite della telecamera.
Alimentazione:

Collegare il cavo di
alimentazione fornito in
dotazione per alimentare la
telecamera.

MicroSD:

Inserire una scheda MicroSD
per l'archiviazione locale.

Mic: Microfono (ingresso audio).

Uscita audio:

Collegare un altoparlante
esterno con il cavo audio da
3,5 mm.

WPS:

Tenere premuto il pulsante
WPS per 8 secondi dopo
l'avvio della telecamera, per
attivare la modalita WPS.
(*I modelli DN-16029 e
DN-16046 hanno il pulsante
WPS)

Allarme:

Pin1: ingresso allarme

Pin2: Terra

Pin3: Non in uso

Pin4: NO

6

Ingessosimenazione
| sves

s roman

mmmm scheda  IngressalUscia allame
MicroSD.

Porta di rete

Uscita audio
l E LET) ' l

s
Ingresso alimentazione
WPS SVCC 1
AT
Alloggiamento
a6 . 'scheda MicroSD
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Reimpostazione

Alloggiamento scheda MicroSD
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Reimpostazione
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Connessioni della telecamera

Le telecamere DIGITUS® Plug&View per esterni sono dotate di un
cavo speciale.
Controllare la modalita di installazione nelle immagini sottostanti.

. Pulsante di ripristino:
Quando la telecamera &
stata collegata ed &
pronta per l'uso, tenere
premuto questo pulsante
per 10 secondi. Questo
ripristina i valori predefiniti
della telecamera.

. Cavo di rete:

Collegare il cavo di rete al
router per stabilire una
connessione Internet.

. Ingresso alimentazione
12V CC:

Collegare l'alimentatore
esterno per fornire
elettricita alla telecamera.

. Spia LED di stato:

La spia LED di stato blu
segnala che la telecamera
€ alimentata.

| modelli DN-16039, DN-16043 e DN-16048 possono essere alimentati
direttamente dalla telecamera, tramite cavo di rete collegato a un
iniettore PoE o switch PoE.



Configurazione dell'obiett

DN-16039
DN-16043

La messa a fuoco e
la nitidezza possono
essere regolate con
in controlli manuali.
Utilizzare le
immagini dal vivo
della telecamera per
regolare
opportunamente la
messa a fuoco e la
nitidezza.

Impostazione della
messa a fuoco (angolo)

2>

Impostazione della
nitidezza

Impostazione della messa a
fuoco (angolo) W
(ang )_ vy AR



1. Preparazione

Prima di usare la sua telecamera IP, & necessaria la seguente
preparazione.

Collegare I’'antenna

Inserisca I'antenna wireless nel connettore e stringa i bulloni di
fissaggio.

Inserimento scheda SD

La telecamera IP Plug&View supporta le schede MicroSD fino a
32GB di capacita, acquistabili presso il suo rivenditore. Le immagini
o i video fatti con questa telecamera IP sono memorizzati sulla
scheda.

Se la sua telecamera ha una porta esterna e non ha alcuna
memoria interna, inserisca la sua MicroSD nello slot corrispondente
fino a farla scattare in posizione.

Colleghi I’'alimentatore

Inserisca il cavo dell’alimentatore accluso nella connessione
“Alimentazione” della telecamera.

Collegare la telecamera al router (ad es. AVM Fritz!
Box, Telekom Speedport ecc.)*

Colleghi un’estremita del cavo di rete in dotazione alla porta LAN
della telecamera. Colleghi I'altra estremita del cavo di rete a uno dei
connettori chiamati 'LAN' sul retro del router. Alcuni router hanno
solo un connettore LAN, altri ne hanno svariati. Il suo router deve
avere una connessione a internet funzionante.

* Questo punto puo essere ignorato con la modalita "Punto di
accesso" della telecamera. Questo punto deve essere ignorato
per il modello DN-16047.



2. Impostare I’account Utente Plug&View

Per usare la telecamera Plug&View ed avere una visualizzazione dal
vivo sempre e ovunque, occorre registrare la telecamera tramite un
account utente Plug&View. L'impostazione e il controllo dei dispositivi
possono avvenire tramite Smartphone/tablet o PC/Notebook.

2.1 Creazione di un account con smartphone/tablet
Per dispositivi iOS Apple®, I'applicazione "DIGITUS® Plug&View" &
disponibile nell'Apple App Store®. Per gli Smartphone e i tablet
dotati di OS Google Android, pud trovare I'applicazione “DIGITUS®
Plug&View’su Google™ Play Store.

Digitare "Digitus" o "DIGITUS Plug&View" nel campo di ricerca dei
rispettivi App Store®.

Apple App Store® Google™ Play

| § oGS | |K, Coogle pay [ooe= | [EEE




Tra i risultati della ricerca I'app “DIGITUS®

r°\
U Plug&View’-é segnalata da questo simbolo.

Installi 'app sul suo dispositivo mobile.

Avviare I'app dal tablet o smartphone. Per creare I'account ha due
possibilita:

1.

Se dispone gia di un account Google puo usarlo per
I'applicazione Plug&View App, altrimenti

Crei direttamente un nuovo account Plug&View con nome
utente e password individuali.

00 vm> 1. Acceda con I’Account
Google

Fare clic su "g" per
accedere con "Google
account". Potra usare il
suo indirizzo di posta e la
password Google Mail
per accedere.

o

2. Crei un nuovo account
con Plug&View

Clicchi su “Create

e Account”.



= 1:02 CR |
Terms of Use Agreement

Fiir die Nutzung der Plug8View Plattform via Browser oder App ist es
erlorderl»m die Datmschutzerklarung die Sie unter hitp:/plug

€ m/privacy-policy platform-apps/ nachlesen konnen v
akzepnereﬂ
Eridérung:
Ich habe die Datenschutzeridérung der Assmann Electronic GmbH zur
Kenntnis genommen und willige in die Datenvereinbarung gemas der
Datenschutzerkidrung ein. Ich kann meine Einwiligung jederzeit unter
8 digitus.info wiederrufen,
Wir weisen jedoch darauf hin, dass die Plug&View App dann nicht mehr
genutzt werden kann
To use the Plug&View platform via the browser or app, it is necessary
that you agree to the privacy
policy, which you can find at http://plug-vie
platfo apps/ Privacy policy:
| have acknowledged the privacy policy of Assmann Electronic GmbH,
and hereby consent to the dala agreement according to the privacy
DO|le 1 may revoke my consent at any time by contacting
digitus.info,
However, we must point out that in the event consent is revoked, the

T

Accettare
l'informativa sulla
privacy per I'utilizzo
del sistema
DIGITUS®
Plug&View.

Nella pagina
successiva scelga un
nome utente, una
password e confermi
il suo indirizzo email.

Fare clic su "Apply" per creare I'account Plug&View. In seguito
ricevera un'e-mail con le istruzioni di attivazione dell'account.
Acceda poi alla app con “Login” usando il nome utente e la
password. Adesso puo aggiungere la telecamera all’account

(proceda al punto 3).

2.2 Creare un account utente con il PC

Oltre alle App, i sistemi DIGITUS Plug&View supportano anche
l'accesso via browser a PC/Notebook.

La invitiamo a recarsi su http://plug-view.com
Poi fare clic su "Login" per accedere al Portale Web Plug&View.



Create Account

Assmann Electronic GmbH

1. Acceda con I’Account
Google

Fare clic su "g" per accedere
a "Google Login". Sara
possibile accedere tramite il
proprio indirizzo e password
di Google Mail.

(o]

2. Crei un nuovo account con
Plug&View

Clicchi su “Create Account”. La
preghiamo di completare le
informazioni nella pagina
seguente e di confermarle con
“Apply”. In seguito ricevera
un’email con le istruzioni su
come sbloccare I'account. Sulla
pagina di accesso pud entrare
inserendo i dati utente e
registrare la telecamera.

A questo punto, I'account € stato creato tramite App o portale Web.

Per continuare le impostazioni WiFi per la telecamera IP in modalita
Punto di Accesso, applicare la sezione 3 del presente manuale.

Per il modello DN-16047, la connessione della telecamera a
Internet in modalita Punto di Accesso & obbligatoria.

Passare alla sezione 4 del manuale se la telecamera € collegata al

router tramite cavo LAN.

13



3. Connessione della telecamera IP Plug&View

tramite Wi-Fi

3.1 Con smartphone o tablet

Aprire le impostazioni Wi-Fi dello

smartphone/tablet.

Cerchi le reti wireless disponibili
nelle immediate vicinanze. La
telecamera apparira come una rete
wireless con il numero di modello e
gli ultimi 6 caratteri dell'indirizzo

MAC.

Flugandiiew
AEGT
AEGLOG
AEG-Gurst

AEG-PAIT

4 4 4 4 4 2

ON-16047-003F00

E

FAAM Assmann

E

cmProqectons_Bode

WLAN O

+  PlugandView a= (i)

NETZWERK WAHLEN

DN-16049-07a405 =0

Annreai a= (1

Collegare lo smartphone/tablet alla telecamera IP tramite la
connessione Wi-Fi.

#sec0 02-de+ 36 n23  eoxmmy

Dopo avere collegato il proprio
< Einstellungen ~ WLAN

smartphone/tablet alla
telecamera, proseguire con WLAN L
l'installazione dell'app
Plug&View. Avviare |'app
Plug&View.

~ DN-16049-072405 = (D
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L'app Plug&View rilevera la
connessione di una telecamera
Plug&View posta in modalita
"punto di accesso" e chiedera di
selezionare la rete Wi-Fi a cui
collegare la telecamera.

Back Le reti disponibili nelle vicinanze
saranno visualizzate. Selezioni qui la
rete alla quale collegare la
telecamera. Se la Sua rete non &
visibile, potrebbe essere necessario
cambiare la posizione della
telecamera.

ATTENZIONE: Punti di accesso invisibili, ovvero reti WLAN
invisibili, non sono supportati dalla telecamera. Verificare che
la rete utilizzata sia visibile per poter installare la telecamera.

15



weeo o2-dar ¥ mas | e

{ Back Wi-Fi Setting

seessnnsns

Cancel

Please se-connect the WIF| of yous mobie phone 10 the wireless
Foutes o AP before logn 1o BIGITUS Plugtiew

o

Digitare la password della rete
Wi-Fi criptata nel campo
corrispondente e confermare
I'immissione con OK.

Nel sistema operativo Android,
dopo che la connessione & andata
a buon fine, sara richiesto di
collegare nuovamente il proprio
smartphone/tablet alla rete Wi-Fi.

Normalmente, questo avviene
automaticamente. In caso
contrario, accedere alle
impostazioni Wi-Fi del proprio
smartphone/tablet e collegarsi alla
rete Wi-Fi.



4. Aggiungere una telecamera IP Plug&view

4.1 Con smartphone o tablet

Premere "+" per aggiungere una
nuova telecamera durante
l'installazione della prima telecamera
Plug&View.

Navigare fino alle impostazioni
(icona della ruota dentata in alto a
destra) e toccare "Add camera" se
ci sono gia delle telecamere. Cio
puo essere fatto facilmente
effettuando la scansione del codice
QR con il proprio smartphone/tablet
o inserendo manualmente i dati di
attivazione.

| seguenti dispositivi sono abilitati per la scansione del codice QR:
iPhone Apple®, iPad Apple®, Smartphone Android, tablet Android
(con telecamera posteriore integrata).

L’indirizzo MAC, il codice di attivazione e il codice QR sono reperibili
all'ultima pagina di questa guida.

Nota: La versione Android del dispositivo dovrebbe essere la
2.3.5 0 una successiva.

17



Aggiungere la telecamera scannerizzando il
codice QR

I Nella pagina successiva,

: selezionare l'opzione "Scan QR
code".
La funzione codice QR del suo
dispositivo & attivata.

Effettuare la scansione del codice QR riportato all'ultima pagina del
presente manuale per aggiungere la telecamera al proprio account.

Durante la scansione del codice QR, spostare avanti e indietro il
proprio dispositivo mobile fino al riconoscimento del codice.

Aggiungere la telecamera attraverso inserimento
manuale dell’indirizzo MAC e del codice di
attivazione

L’indirizzo MAC e il codice di attivazione si trovano all'ultima pagina
di questa guida. Nell'app Plug&View, selezionare "Add camera" e
navigare fino a "Manual input".

Digitare la combinazione alfanumerica trovata alla voce "MAC".
Inserisca in seguito il suo codice di attivazione e clicchi su “Apply”.

18



4.2 Aggiungere la telecamera al PC tramite il
Browser

Per utenti PC/Notebook, la telecamera puo essere aggiunta all'account
con una procedura simile a quella descritta in sezione 4.1 per dispositivi
mobili.

Dopo il primo login alla pagina di amministrazione della telecamera
http://www.plug-view.com tramite "Login" con i propri account e
password, sara richiesto alla pagina di "Download" di installare il
plug-in. Premere il tasto download e seguire le istruzioni di
installazione.

Please download the new version of "Plug&View
plugin” for camera liveview:

If you have already downloaded before, check the
following:

« Enable P2P Viewer in Chrome extension
Open Menu > Settings > Extensions > P2P Viewer

+ If you have ever deleted the plugin before, please download
the Plug&View plugin

« If P2P Viewer does not exist in the Chrome extension list,
please download P2P Viewer

« Chrome installation tutorial

19



Dopo l'installazione del
plug-in, accedere di nuovo
alla pagina di login
http://www.plug-view.com
con il proprio account.

AL

Premere l'icona "+" per
aggiungere la telecamera.
Please complete registration in 60 minutes
after boot up your camera, or you need to Poi premere l'icona ">" per
re-pox».re.rthe camera and corﬂplete accedere alla pagina
registration process again. . .
successiva e applicare le
istruzioni.

Quindi inserire l'indirizzo MAC e il codice di attivazione riportato
all'ultima pagina del manuale e premere "Apply" per aggiungere la
telecamera.

Add Camera

MAC Address

Activate Code

20



Dopo I'aggiunta della telecamera all'account, controllare la
visualizzazione dal vivo della telecamera.

et

Se pensa di continuare a usare la telecamera Plug&View con
un cavo di rete, il setup termina qui.

Se intende usare la connessione wireless Wi-Fi per maggiore
flessibilita, continuare la lettura.

21



5. Impostazione Wi-Fi su PC/Notebook

L’impostazione della connessione wireless (Wi-Fi) tra la telecamera
IP e il router/Punto di accesso Wi-Fi pud anche avvenire lato PC/
notebook via browser

Dopo linstallazione della telecamera, acceda al sito
“http://www.plug-view.com”. Clicchi su “Login | My camera
administration”.

Accedere con account Plug&View o scegliere Google-Login. Se non
ha effettuato gia I'accesso al suo account Google, verra reindirizzato
automaticamente alla pagina di login di Google.

Dopo l'inserimento dei dati di login, potra vedere la telecamera dal
vivo.

Alla destra dell'immagine della 0
telecamera, ci sono varie icone. =
Fare clic sul tasto "Camera
Configuration" per accedere
all'interfaccia utente.

figuration
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Si apre una nuova finestra, quella dell'interfaccia utente su web della
telecamera. Accedere con l'account predefinito di "telecamera” con
nome utente "admin" e password "admin". Selezionando I'opzione
“Autologin”, la prossima volta accedera automaticamente al menu di
configurazione. Clicchi su “Login”.

D[G]TUSO DIGITUS® PLUG&VIEW

safe&secure - anywhere. anytime.

| —
Language:
Stream

Nell'interfaccia utente della telecamera, fare clic su Wi-Fi per
effettuare le impostazioni Wi-Fi.

safe&secure - anywhere. anytime.

Home Replay Parameters System Wireless

Una finestra di ricerca compare, qui sono elencate le reti wireless
disponibili per lei. La preghiamo di selezionare I'ID (SSID) della sua
rete e di confermare con “OK”.

ssID Signal  Authentifzierungsmodus
O Testeym 88% [WPA-PSK-TKIP)[WPA2-PSK-CCMP)[WPS]ESS]
O PhugandView 8% [WPA-PSK-TKIPJ[ESS]

~ —ams masme s AL s S
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Nella schermata successiva, immettere la chiave Wi-Fi e confermare

con "OK".

Passwort:

ok

Si assicuri che il router
funzioni come server
DHCP. Si tratta di
un’impostazione
predefinita per quasi tutti
i router.

In seguito viene stabilita
la connessione alla sua
LAN wireless. Se la
connessione € avvenuta
correttamente, comparira
in una finestra a parte.

E ora possibile rimuovere il cavo di rete alla telecamera &

chiudere la finestra di browser.

Congratulazioni. Ha appena completato il primo set up della
telecamera IP Plug&view. Ora puo accedere alla telecamera IP in
qualsiasi momento dal suo smartphone, tablet PC o da un browser.
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6. Impostazione del rilevamento di

movimento e della registrazione

II sistema DIGITUS® Plug&View offre le opzioni di rilevamento di
movimento e registrazione. Per utilizzare questa funzione, &
necessario che la scheda SD sia stata formattata e inserita nella
telecamera; inoltre, il rilevamento di movimento deve essere attivato.
Per formattare la scheda SD, accedere alla telecamera dal portale
web.

Alla destra dell'immagine della

0
telecamera, ci sono varie icone. b
Fare clic sul tasto "Camera
Configuration" per accedere &
all'interfaccia utente. L
)

figuration

Si apre una nuova finestra, quella dell'interfaccia utente su web
della telecamera. Accedere con I'account predefinito di
"telecamera" con nome utente "admin" e password "admin".
Selezionando I'opzione “Autologin”, la prossima volta accedera
automaticamente al menu di configurazione. Clicchi su “Login”.

Le informazioni della scheda SD sono accessibili tramite menu

System -> Local storage. Formattare la scheda SD dalla voce di
menu "Format".
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Dopo avere eseguito la formattazione, & possibile attivare la funzione
di rilevamento di movimento.

Selezionare la voce "Parameters" -> "Motion Detect" dell'interfaccia
Web.

DIGITUS'

Home Replay Parameters. System Wireless
Arsa:
Activate B Enasis

Sensibilty L Select All Clean All

Action:

E-Mail Send E-mail

Output Alarm With Snapshet [/ Send ToEmall ) Upload to FTP

Alarm With Record 4 Upload to FTP
Trigger Alarm Output

Schedule: Week Mode Work Mode @ Alvays

Attivare il rilevamento di movimento facendo clic su "ON". L’area
colorata dell'immagine video & I'area di rilevazione di movimento,
es.: 'area in cui il movimento fa scattare una foto o attiva la
registrazione video. Alla consegna, quasi la totalita dello schermo &
coperta da riquadri rossi. Fare clic sulle marcature colorate per
escludere determinate aree dal rilevamento di movimento. Con
questo passaggio, cancellera la selezione per quell’area. La
sensibilita del rilevamento di movimento puo essere impostata alla
voce “Sensibility". Selezionare uno dei seguenti quattro livelli: “Very
high (Altissimo)”, “High (Alto)”, “Normal (Normale)” e “Low (Basso)".
Attivare "Alarm with recording" per salvare sulla scheda SD in caso
di rilevamento di movimento.

HRAA

26



L'impostazione temporale & modificabile nella programmazione del
rilevamento di movimento. E possibile registrare nelle modalita
settimanale, giorni feriali o tempo pieno.

La programmazione pu0 essere regolata individualmente.

Salvare la configurazione con "Apply".

La funzione di rilevamento di movimento con registrazione & cosi
completata.

Per informazioni sull'interfaccia web della telecamera,
consultare il manuale della telecamera contenuto nel CD.

Per ulteriori domande, accedere alla sezione FAQ della nostra
pagina Plug&View (http://www.plug-view.com/) o contattare il
nostro servizio di assistenza
(http://www.plug-view.com/support-de/support/).

Marchi registrati

DIGITUS & un marchio registrato di ASSMANN Electronic GmbH.
Apple, Apple App Store sono marchi registrati di Apple Inc.

Android, Google, Google play sono marchi registrati di Google Inc.
AVM Fritz!Box € un marchio registrato di AVM Computersysteme
Vertriebs GMBH.

Telekom Speedport € un marchio registrato di Deutsche Telekom AG.

Nota:

Tultti gli altri marchi registrati qui, sono proprieta dei rispettivi
proprietari.

I marchi registrati 0 nomi commerciali menzionati in questo manuale
sono usati per descrivere le fasi operative e non implicano che
siano disponibili liberamente. In ogni caso sono di proprieta del
detentore rispettivo dei diritti.
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DIGITUS"

Camaras IP Plug&View
de DIGITUS®

Guia rapida de instalacion



Precauciones de seguridad

Utilice la camara IP Plug&View Unicamente dentro del rango de
temperaturas especificado para esta camara

Cuando no la utilice, guarde el producto en un lugar limpio y seco
a una temperatura de entre 0°C y 40°C

No cubra la camara

No permita que la camara entre en contacto con liquidos (excepto
las camaras para exteriores con cubierta protectora IP66)

Las camaras IP Plug&View no sustituyen la supervision de un
adulto. Proteja la salud de sus hijos, familiares o mascotas
vigilandolos con regularidad

Asegurese de que las camaras IP de interior se utilicen Unicamente
en interiores. Estas camaras no estan destinadas al uso en
exteriores y podrian resultar dafiadas. Utilice los modelos
especificos para exteriores en esos casos

Instale las camaras IP Plug&View en las proximidades de una
toma de corriente de facil acceso. Compruebe que el cable
eléctrico no esté sometido a tensién ni estiramiento

Coloque las camaras IP Plug&View dentro del alcance de su
router Wi-Fi y asegurese de que no haya obstaculos entre la
camara y el router que podrian interferir con la sefial Wi-Fi



Proteja las camaras IP Plug&View de los dispositivos eléctricos y
otros dispositivos de alta frecuencia que generen interferencias
(microondas, teléfonos moviles, etc.)

Mantenga la camara, el cable de red y el cable eléctrico fuera del
alcance de los nifios, ya que se trata de componentes peligrosos

Utilice unicamente el adaptador de corriente incluido.

No trate nunca de reparar usted mismo las camaras IP Plug&View.
Las tareas de reparacion y mantenimiento deben ser efectuadas
por especialistas.

En caso de problemas, pédngase en contacto con nuestro servicio
de atencion al cliente.

Respete todas las leyes aplicables relativas a la monitorizacion
con camara. Las camaras IP Plug&View estan destinadas
Unicamente al uso doméstico privado. Informe a sus familiares,
parientes y al personal doméstico sobre la monitorizaciéon de
video. Asegurese de que las zonas publicas y las propiedades de
sus vecinos no puedan ser vistas.



Informacién personal D)

* Leay acepte la politica de privacidad para utilizar los sistemas
DIGITUS® Plug&View, en
http://plug-view.com/privacy-policy-for-platform-apps/.

* Escoja una contrasefa con alto grado de seguridad para su
cuenta Plug&View, para protegerla frente a accesos no
autorizados.

* La contrasefa debe contener al menos 8 caracteres; le
recomendamos utilizar mayusculas y mindsculas, y caracteres
alfanumeéricos.

* Ademas, la contrasefa estandar de la camara debera ser
cambiada para evitar accesos no autorizados.

La transmision en directo, las notificaciones push y otros
servicios estan disponibles a través de un servidor en la nube.
Pese a las soluciones de respaldo, la estabilidad del sistema y
la gestion del ancho de banda, no puede garantizarse la
disponibilidad ininterrumpida del sistema.

Contenido de la caja

1 Camara IP Plug&View Opcional:

1x Fuente de alimentacion con 1 cable Ethernet

cable 1x Montaje para techo/pared
1 x guia de instalacion rapida 1 Antena extraible

1x CD con utilidades

* Las siguientes camaras estan equipadas con una antena extraible:
DN-16029, DN-16039, DN-16043, DN-16048, DN-16049

Gracias por elegir una camara IP Plug&View, la cual tendra lista
para utilizar répida y facilmente sin necesidad de complicados

ajustes de red.
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Instalar la tarjeta MicroSD

Las camaras Plug&View para interiores DIGITUS® pueden equiparse
con una tarjeta microSD para almacenar grabaciones.

Compruebe en las imagenes de instalacion su opcion para la
instalacion.

DN-16047

Instale la tarjeta SD como se
muestra en la imagen, con los
contactos dorados orientados
hacia la lente de la camara.

DN-16046

Instale la tarjeta SD como se
muestra en la imagen, con los
contactos dorados orientados
hacia la lente de la camara.

DN-16029

Instale la tarjeta SD como se
muestra en la imagen, con los
contactos dorados orientados
hacia arriba.




Conexiones de la camara

LAN:

Conecte la cdmara al puerto
LAN de su router.

Reiniciar:

Tras iniciar la camara, mantenga
pulsado durante 10 segundos el
boton de reinicio para restaurar
los ajustes por defecto de la
camara.

Alimentacion:

Conecte el cable de
alimentacién incluido para
suministrar energia a la
camara.

MicroSD:

Introduzca una tarjeta microSD
para el almacenamiento local.
Mic: Micréfono (Entrada de
audio).

Salida de audio:

Conecte un altavoz externo
mediante un cable de audio de
3,5 mm.

WPS:

Tras iniciar la cAmara, mantenga
pulsado durante 8 segundos el
botén WPS para activar el modo
WPS.

(*DN-16029 y DN-16046
disponen del boton WPS)
Alarma:

Pin1: Entrada de alarma

Pin2: Masa

Pin3: Sin uso

Pin4: NO
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Conexiones de la camara

Las camaras Plug&View para exteriores DIGITUS® estan equipadas
con un cable especial.

Compruebe en las imagenes de instalacion su opcion para la
instalacion.

. Botén de Reseteo:
Cuando la camara esté
conectada y lista para
usar, mantenga pulsado
este botdn durante
10 segundos. Esto
restaurara los ajustes por
defecto de la camara.

. Cable de red:

Conecte el cable de red al
router de su red para
establecer la conexion a
Internet.

. Conexion de
alimentacion de CC 12 V:
Conecte el adaptador de
alimentacién externo para
alimentar su camara.

. LED indicador de estado:
ElI LED azul indicador de
estado indica si la camara
esta recibiendo energia.

Para los modelos DN-16039, DN-16043 y DN-16048, la alimentacion
puede suministrarse directamente a la camara mediante la conexién
de entrada del cable de red con un inyector PoE o conmutador PoE.



Ajustes de la lente

DN-16039

DN'1 6043 Ajustar el enfoque
(angulo)

Puede ajustar el e

enfoque y la nitidez Ajustar (a nitidez
mediante controles
manuales. Utilice
las imagenes en
directo de la cdmara
para ajustar el
enfoque y la nitidez
segun se requiera.



1. Preparacion

Antes de poder utilizar su camara IP, debe realizar algunos
preparativos.

Conectar la antena

Conecte la antena inaldambrica en el conector y apriete los tornillos
de montaje.

Insertar la tarjeta SD

Las camaras IP Plug&View soportan tarjetas MicroSD de hasta 32 GB
de capacidad, las cuales puede comprar en cualquier tienda de
electrénica/informatica. Las fotos y videos grabados con su camara IP
se almacenaran en esta tarjeta.

Si su camara tiene un puerto externo y no tiene memoria interna,
introduzca su tarjeta MicroSD en la ranura correspondiente hasta
que quede correctamente enganchada en su sitio.

Conectar el adaptador eléctrico

Conecte el cable del adaptador eléctrico suministrado en el conector
“Power” de la camara.

Conectar la camara al router (ej. AVM Fritz! Box,
Telekom Speedport etc.)*

Conecte uno de los extremos del cable de red suministrado en el
puerto LAN de la camara. Conecte el otro extremo del cable de red
en uno de los conectores de salida “LAN” en la parte posterior de
su router. Algunos routers tienen una sola conexion LAN, y otros
tienen varias conexiones. Su router debe tener una conexién a
Internet activa.

* Puede saltarse este paso con el modo de punto de acceso de las
camaras. Para el modelo DN-16047, puede saltarse este paso.



2. Configurar la cuenta de usuario Plug&View

Para utilizar su camara Plug&View y poder ver el video en directo
en cualquier momento y desde cualquier lugar, debe registrar su
camara en una cuenta de usuario Plug&View. Podra configurar y
controlar su dispositivo desde su smartphone/tableta y desde su
PC/portatil.

2.1 Crear una cuenta de usuario desde su
smartphone/tableta

Si tiene un dispositivo Apple® iOS, encontrara nuestra aplicacién
"DIGITUS® Plug&View" en la Apple App Store®. Para Smartphones
y tabletas con sistema operativo Google Android puede encontrar
nuestra aplicacion “DIGITUS® Plug&View’- en la Google™ Play
Store.

En el campo de busqueda de la tienda de aplicaciones
correspondiente, introduzca "Digitus” o "DIGITUS Plug&View".

Apple App Store® Google™ Play




En los resultados de la busqueda la App “DIGITUS®

r°\
U Plug&View” vendra marcada con este simbolo.

A continuacion instale la aplicacion en su dispositivo movil.

Inicie la App en su tableta o Smartphone. Tiene 2 opciones para
crear una cuenta:

1. Siya tiene una cuenta Google, puede usar su cuenta Google
para usar la App Plug&View, o

2. Puede crear directamente una nueva cuenta Plug&View con un
nombre de usuario individual y una contrasefa.

B: 0o sm> 1. Registrese con una
cuenta Google

Haga clic en "g" para
iniciar sesion en "Google
account". Luego podra
usar su direccion de
correo electrénico de
Google y su contrasefia
para iniciar sesion.

(o}

2. Cree una nueva cuenta
con Plug&View

Haga ‘clic’ sobre “Create
e Account”.



= 1:02 CR |
Terms of Use Agreement

Fiir die Nutzung der Plug8View Plattform via Browser oder App ist es
erlorderlm die Datmsch u:zerklarung die Sie unter hitp:/plug

€ m/privacy-policy Jatform-apps/ nachlesen kbnnen, zu
akzepneren
Eridérung:
Ich habe die Datenschutzeridérung der Assmann Electronic GmbH zur
Kenntnis genommen und willige in die Datenvereinbarung gemas der
Daienschu!zekarung ein. Ich kann meine Einwiligung jederzeit unter
digitus.info wiederrufen,
W|r weisen jedoch darauf hin, dass die Plug&View App dann nicht mehr
genutzt werden kann

To use the Plug&View platiorm via the browser or app, it is necessary
that you agree to the privacy
policy, which you can find at http://plug T cy-for
platform-apps/ Privacy policy:
| have acknowledged the privacy policy of Assmann Electronic GmbH,
and hereby consent to the dala agreement according to the privacy
polncy I may revoke my consent at any time by contacting

digitus.info,
However, we must point out that in the event consent is revoked, the

Acepte la politica de
privacidad para
utilizar el sistema
DIGITUS® Plug&View.

En la pagina
siguiente, por favor
elija un nombre de
usuario, una
contrasefia y confirme
su direccién de correo
electronico.

Luego toque sobre “Apply” para crear su cuenta Plug&View. A
continuacion, recibira un correo electrénico con instrucciones
acerca de como activar su cuenta. Luego inicie sesién en la App
con “Login” usando su nombre de usuario y contrasefia. Ahora
podra afadir su cdmara a la cuenta (continte con el elemento 3).

2.2 Crear una cuenta con su PC

Ademas del uso mediante la App, el sistema Plug&View de DIGITUS
también permite el uso mediante PC/portatil a través del acceso por
navegador.

Por favor, entre en el sitio Web http://plug-view.com
Después, haga clic en "Login" para entrar al portal web Plug&View.



1. Registrese con una cuenta
Google

Haga clic en "g" para

"Google Login". Podra utilizar
8 su direccion de correo
electrénico y contrasefia de
Google Mail para iniciar

sesion.
(6]
Create Account 2. Cree una nueva cuenta con
Plug&View
Haga ‘clic’ sobre “Create
Account”. Por favor, complete
or e la informacién en la pagina

siguiente y confirme sus
entradas con “Apply”. Después
1 recibira un correo electrénico
SRS S con instrucciones sobre como
desbloquear su cuenta. En la
pagina de inicio de sesién
podra iniciar sesién con sus
datos de usuario y agregar su
camara.

Llegados a este punto, ya habra creado con éxito una cuenta
mediante la App o mediante el portal web.

Para proseguir con los ajustes de Wi-Fi de la camara IP mediante
el modo de punto de acceso, por favor consulte la seccién 3 de
este manual.

Por favor, tenga en cuenta que para el modelo DN-16047, es
necesario conectar la camara a Internet mediante el modo de punto
de acceso.

Salte a la seccion 4 de este manual si su camara esta conectada al

router a través de un cable LAN.
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3. Conectar la camara IP Plug&View a través

de Wi-Fi

3.1 Con un smartphone/tableta

Abra los ajustes de Wi-Fi en su

smartphone/tableta.

Busque las redes inaldambricas
disponibles en las cercanias. La
camara aparecera como una red
inaldmbrica con su nimero de
modelo y los 6 ultimos caracteres
de su direcciéon MAC.

Flugandiiew
AEGT
AEGLOG
AEG-Gurst

AEG-PAIT

4 4 4 4 4 2

ON-16047-003F00

E

FAAM Assmann

E

cmProqectons_Bode

WLAN O

+  PlugandView a= (i)

NETZWERK WAHLEN

DN-16049-07a405 =0

Annreai a= (1

Conecte su smartphone/tableta a la camara IP mediante la conexién
WLAN.

#sec0 02-de+ 36 n23  eoxmmy

Tras conectar su smartphone/
< Einstellungen ~ WLAN

tableta a la camara, puede
continuar con la instalacién de WLAN O
la gpllcg’mon PIug&VleW. Abra la 7 DhEB0dsi07aa08 S
aplicacion Plug&View.



La aplicacion Plug&View
detectara la conexién a una
camara Plug&View utilizada en
modo de punto de acceso y le
pedira que seleccione la red
Wi-Fi a la que se conectara la
camara.

Back Apareceran las redes disponibles en
¢ las cercanias. Por favor, seleccione
aqui la red a la que se conectara la
camara. Si su red no aparece en la
lista, es posible que deba cambiar la
camara de posicion.

ATENCION: Las SSID ocultas, correspondientes a redes Wi-Fi
ocultas, no son compatibles con la camara. Si desea conectar
su camara a una de ellas, por favor, haga visible esa red.
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weeo o2-dar ¥ mas | e

{ Back Wi-Fi Setting

seessnnsns

Cancel

Please se-connect the WiFl of your mobie phone 10 The wireless

your
Foutes o AP before logn 1o BIGITUS Plugtiew

o

Introduzca la contrasefia con la
que esta encriptada su red WLAN
en el campo de la contrasefia y
confirmelo pulsando OK.

En sistemas operativos Android,
tras conectarse con éxito, se le
pedira que vuelva a conectar su
smartphone/tableta de nuevo a su
red Wi-Fi.

Normalmente, esto ocurrira
automaticamente. En caso de no
ser asi, por favor abra los ajustes de
Wi-Fi de su smartphone/tableta y
conéctelo a su red Wi-Fi desde ahi.



4. Agregar una camara Plug&View

4.1 Con un smartphone/tableta

Pulse “+” para agregar una nueva
camara durante la instalacion inicial
de la camara Plug&View.

Vaya a los ajustes (icono de la
rueda dentada en la parte superior
derecha) y toque en "Add camera"
si ya hay alguna camara. Esto se
puede hacer faciimente
escaneando el cédigo QR con su
Smartphone/tableta o introduciendo
manualmente los datos de
activacion.

Los dispositivos siguientes son aptos para escanear el cédigo QR:
Apple iPhone®, Apple iPad®, Smartphone Android, Tableta Android
(con camara trasera integrada).

Puede encontrar la direccion MAC, el cédigo de activacion y el
cadigo QR en la Ultima pagina de esta guia.

Nota: La version del sistema operativo Android del dispositivo
movil ha der ser 2.3.5 o posterior.
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Afadir la camara escaneando el codigo QR

] En la pagina siguiente, seleccione
la opcion “Scan QR code”.
Se activara la funcion de escanear
cédigos QR de su dispositivo.

Por favor, escanee el cédigo QR de la dltima pagina de este
manual para afadir la cdmara a su cuenta.

Cuando escanee el cédigo QR, es posible que tenga que mover el
dispositivo movil hacia delante y hacia atras hasta que se reconozca
el codigo.

Agregar una camara introduciendo manualmente
la direccion MAC y el cédigo de activacion

La direccién MAC y el cédigo de activacion se encuentran en la
ultima pagina de esta guia. Vaya a "Manual input" tras seleccionar
"Add camera" en la aplicacion Plug&View.

Introduzca la combinacién alfanumérica que encontrara en “MAC”.
Luego introduzca su cddigo de activacion y haga ‘clic’ en “Apply”.
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4.2 Agregar la camara al PC usando el navegador

Los usuarios de PC/portatil también pueden afadir camaras a su
cuenta de forma similar al procedimiento descrito en 4.1 para
dispositivos moviles.

Tras el primer inicio de sesién en la pagina de administracion de su
camara mediante http://www.plug-view.com para iniciar sesiéon con
su cuenta y contrasefia, se le pedira que instale el complemento
con la pagina "Download". Por favor, pulse descargar y siga las
instrucciones para la instalacion.

Please download the new version of "Plug&View
plugin” for camera liveview:

If you have already downloaded before, check the
following:

Enable P2P Viewer in Chrome extension

Open Menu > Settings > Extensions > P2P Viewer

If you have ever deleted the plugin before, please download
the Plug&View plugin

If P2P Viewer does not exist in the Chrome extension list,
please download P2P Viewer

Chrome installation tutorial
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Tras instalar el complemento,
vuelva a la pagina de inicio
de sesién en
http://www.plug-view.com
con su cuenta.

Pulse el simbolo "+" para
anadir la camara.
Please complete registration in 60 minutes
after boot up your camera, or you need to DeSpUéS pu|Se el simbolo
re-pg-v.fe.rthe camera and corﬂplete nsn para pasar a la siguiente
registration process again. L, .
pagina y siga los pasos.

Después introduzca la direccion MAC y el cédigo de activacion que
aparece en la ultima pagina de su manual de usuario y pulse
"Apply" para afadir la camara.

Add Camera

MAC Address

Activate Code

20



Tras afiadir la cdAmara con éxito a su cuenta, por favor compruebe
que su camara se visualiza con live-view.

.oe

Si planea continuar usando su camara Plug&View conectada
con el cable de red, la configuracion termina aqui.

Si piensa utilizar la conexion inalambrica mediante Wi-Fi para
mayor flexibilidad de ubicacién, por favor, continte leyendo.
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5. Configurar la Wi-Fi en el PC/portatil

La configuracion de la conexion inalambrica (Wi-Fi) entre la camara
IP y el router Wi-Fi/punto de acceso también puede realizarse en el
PC/portatil mediante el navegador

Después de instalar correctamente su camara, inicie sesion en el
sitio Web “http://www.plug-view.com”. Por favor, haga clic con el
botén derecho sobre “Login | My camera administration”.

Utilice su cuenta Plug&View o seleccione el inicio de sesion de
Google. Si no se ha registrado en su cuenta Google se le
redireccionara automaticamente a la pagina de inicio de sesion de
Google.

Tras introducir sus datos de inicio de sesién, podra ver la camara
en directo.

A la derecha de la imagen de su 0
camara, podra ver varios iconos. =
Haga clic en el botén "Camera

Configuration" para acceder a la
interfaz de usuario de la camara.

figuration
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Esto abrira otra ventana, que es la interfaz de usuario web de la
camara. Por favor, inicie sesion con la cuenta por defecto "camera"
con el usuario "admin" y la contrasefia "admin". Si selecciona la
opciodn “Autologin”, iniciara sesion automaticamente la préxima vez
que acceda al menu de configuracién. Haga ‘clic’ sobre “Login”.

D[G]TUSO DIGITUS® PLUG&VIEW

safe&secure - anywhere. anytime.

| —
Language:
Stream

En la interfaz de usuario de la cdmara, haga clic en Wi-Fi para
efectuar la configuraciéon Wi-Fi.

safe&secure - anywhere. anytime.

Home Replay Parameters System Wireless

Le aparecera la ventana de busqueda, donde vera todas las redes
inaldambricas disponibles en su entorno. Por favor seleccione el
identificador de su red (SSID) y confirmelo con “OK”.

ssID Signal  Authentifzierungsmodus
O Testeym 88% [WPA-PSK-TKIP)[WPA2-PSK-CCMP)[WPS]ESS]
O PhugandView 8% [WPA-PSK-TKIPJ[ESS]

~ —ams masme s AL s S

23



En la siguiente ventana, introduzca la clave Wi-Fi y confirme con

“OK”.

Passwort:

ok

Por favor, cerciérese de
que su router esta
funcionando como
servidor DHCP. Esta es
la configuracion de
fabrica de casi todos los
routers.

A continuacion, se
establecera la conexion
con su LAN inalambrica.
Si se establecio la
conexion correctamente,
le aparecera un mensaje
a tal efecto en una
ventana separada.

Ahora puede desconectar el cable de red de la camara y cerrar

el navegador.

Enhorabuena. Acaba de completar la configuracién de su camara
IP Plug&View. Ahora puede acceder a su camara IP en cualquier
momento desde su Smartphone, tableta o desde el navegador de

su PC.
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6. Establecer la deteccion de movimiento y

grabacion

El sistema Plug&View DIGITUS® ofrece las opciones de deteccion
de movimiento y grabacion. Para utilizar esta funcion, la tarjeta SD
debe estar formateada en la cdmara y la deteccién de movimiento
debe estar activada.

Para formatear la tarjeta SD, acceda a la camara a través del portal
web.

A la derecha de la imagen de su

d
camara, podra ver varios iconos. x
Haga clic en el botén "Camera
Configuration" para acceder a la &
interfaz de usuario de la camara. e

)

figuration

Esto abrira otra ventana, que es la interfaz de usuario web de la
camara. Por favor, inicie sesion con la cuenta por defecto "camera"
con el usuario "admin" y la contrasefia "admin". Si selecciona la
opcién “Autologin”, iniciara sesién automaticamente la proxima vez
que acceda al menu de configuracion. Haga ‘clic’ sobre “Login”.

Puede acceder a la informacion de la tarjeta SD a través de los

elementos del menu System -> Local storage. Formatee la tarjeta
SD a través del elemento del menu “Format”.
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Tras el formateo, podra activarse la detecciéon de movimiento.

Por favor, acceda a "Parameters" -> "Motion Detect" en la IU web.

safe&secure - anywhere. anytime.

Home Replay Parameters System Wireless
Area:
Activate B4 Enable

Sensibilty [Norma w Select All Clean All

Action:

E-Mail Send E-mail

Alam With Snapshot ¥ Send To Email &) Upload to FTP
Alarm With Recard ) Upload to FTP
Trigger Alarm Output

Schedule Week Mode Work Mode @ Alvays

Active la deteccion de movimiento haciendo clic en “ON”. El area
coloreada dentro de la imagen de video es el area de deteccion de
movimiento, p.ej. el area en la cual un movimiento activara la
grabacion de movimiento o hara una foto. En la condicién original
de entrega, casi toda la pantalla esta cubierta con rectangulos
rojos. Haga clic en las marcas de color para excluir ciertas areas
de la deteccion de movimiento. Haciendo esto eliminara el
marcador para esa area. Puede ajustar la sensibilidad de la
deteccion de movimiento en “Sensibility”. Seleccione uno de estos
cuatro niveles: «Very high", "High", "Normal" y "Low".

Active la opcién “Alarm with recording” para guardar las imagenes
en la tarjeta SD en caso de detectar algin movimiento.

Output

RRERAA
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El ajuste de tiempo se modifica a través del horario de la deteccion
de movimiento. Puede grabar en modo semanal, dias laborables o
a tiempo completo.

Puede ajustar el horario de manera individual.

Guarde la configuracién con “Apply”.

Ha establecido con éxito la deteccién de movimiento con grabacién.
Para mas explicaciones sobre la interfaz web de la camara,
consulte el manual de la camara incluido en el CD.

Si le surgen preguntas, acceda al area de preguntas frecuentes
en nuestra pagina Plug&View (http://www.plug-view.com/) o
poéngase en contacto con nuestro servicio de atencién al
cliente (http://www.plug-view.com/support-de/support/).

Marcas comerciales

DIGITUS es una marca registrada de ASSMANN Electronic GmbH.
Apple, Apple App Store son marcas comerciales registradas de
Apple Inc.

Android, Google, Google Play son marcas comerciales registradas
de Google Inc.

AVM Fritz!Box es una marca comercial registrada de AVM Computer
systeme Vertriebs GMBH.

Telekom Speedport es una marca comercial registrada de Deutsche
Telekom AG.

Nota:

El resto de las marcas comerciales no enumeradas aqui, son
propiedad de sus respectivos propietarios.

Las marcas comerciales o nombres comerciales mencionados en
este manual se usan para describir los pasos operativos y no
implica que estén disponibles gratuitamente. En cualquier caso son
propiedad de los respectivos titulares de los derechos.
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DIGITUS"

IP kamepbi DIGITUS®
Plug&View

UHCTpYyKUMSA No 6bICTPOM YyCTaHOBKe



MepbI NpeaocTOPOXKHOCTU

Wcnonesynte IP kamepy Plug&View B ananasoHe Temneparyp,
yKasaHHbIX ANs AaHHOW Kamepbl

Korpa kamepa He Ucrnonb3yeTcs, XpaHUTe eé€ B CyXOM U YACTOM
mecTe npu TemnepaTtype ot 0°C go 40°C

He HakpbiBaviTe Kamepy

M3beraiTe koHTaKTa kKamephbl C XWUOKOCTAMM (He OTHOCUTCS K
Hapy>XHbIM KamepaM C 3aLUTHbIM koprnycom |IP66)

IP kamepbl Plug&View He sBnstoTCA 3aMeHOW poAUTENbCKOMY
KOHTponto. beperute 3gopoBbe CBOMX OETEN, YNEHOB CEMbM U
[OMaLLHUX XXUBOTHBIX U PEryrsipHO NpucmaTpvBanTe 3a HUMK

Y6eputech, 4To AoMaluHue IP kaMepbl MCMONb3YTCS TOSNBKO
BHYTPMW NoMeLLeHunid. [laHHble kKaMepbl He NpegHa3HaveHbl 4ns
MCMOSb30BaHUS Ha yNnLE U MOTYT BbIATY 13 cTpos. Mcnonbayiite
COOTBETCTBYHOLLME MOAENN, NPeAHa3HauYeHHble AN YITUYHOTO
MCMomnb3oBaHUs

YctaHosuTe IP kamepbl Plug&View B HenocpencTBeHHOM
61130CTH K anekTpu4eckon poseTke. YbeamTech, YTO OTCYTCTBYeT
HaTsxeHne kabensa anekTponuTanus, n kabenb ocnabnex

Paawmectute IP kamepbl Plug&View B paguyce pgevictaus Wi-Fi
poyTepa 1 ybeautech, YTo MeXay Kamepamu 1 poyTepoM HeT
npenaTCTBUA, KOTOpble MOrnM 6bl co3gaBaTtb nomexu curHany Wi-Fi



Ob6ecneybTe 3awuTy IP kamep Plug&View ot Bo3gencTaus
3MEeKTPUYECKUX UMW BbICOKOYACTOTHBIX YCTPOWCTB, CO3AatoLLmMX
nomexu (MMKpOBOJTHOBbIE MeYn, MOOUIbHbIE TeNnedOoHbl U T.4.)

XpaHute Kamepy, ceTeBoW kabenb 1 kabenb QNIEKTpoOnNnTaHnA B
HeOOoCTynHOM AnA neTen Mecte, Tak Kak 9TU KOMMOHEHTbI MoryT
npeacTtaenATb onNacHOCTb

|/|CI'IOJ'Ib3yVITe TONbKO NOCTaBMsiEMbIA B KOMMNIEKTE agantep
nnTaHuA.

He nbitanteck nounHuTh IP kamepbl Plug&View camoctosiTenbsHo.
PaboTbl N0 peMOHTY 1 TEXHUYECKOMY 0BCNYXNBAHWIO AOMKHbI
BbINOMHATLCSA creuuanMcTamm.

B Crny4yae BO3HMKHOBEHUA npo6neM CBSXKMUTECH C Hallen CJ'Iy)K6Ol7I
noaaepXxkn KNnnMeHToB.

Cobntopaiite NPUMEHNMOE 3aKOHOAATENbCTBO B OTHOLLIEHWM
BuaeoHabnopeHus. IP kamepbl Plug&View npegHasHaveHbl ans
TNINYHOTO AOMALLHEro ncnonb3oBaHus. MponHdopmupynTe
4YrieHOB CeMbW, POACTBEHHMKOB U MOMOLLHWMKOB MO XO3SAWCTBY O
Hanuuun BugeoHabnogeHVs B gome. Y6eamTecs, 4To Ha 3anmcsx
BUAEOHabNI0AEHUS] HE BUOHO OOLLECTBEHHbIE MecTa unm
COBCTBEHHOCTb BalLMX coceaen.



JNInyHasa nHdopmaumnsa

¢ [pouuTainTte 1 NPUMUTE YCIOBUS NMOMUTYKM KOHDUAEHLMANBHOCTU
LS MCnonb3oBaHus cuctem DIGITUS® Plug&View, nepeigs no
cebinke http://plug-view.com/privacy-policy-for-platform-apps/.

e YcTaHoBUTE Naposib C BLICOKOW CTENEHbIO 3aLUmThl AMs
yyeTHon 3anucu Plug&View, 4tobbl 3aWwmTUTL €€ 0T
HeCaHKLIMOHUPOBAHHOIO AOCTYNa.

e [Maponb JoMmKeH coaepXkaTb MUHUMYM 8 3HAKOB; Mbl
peKoMeHayeM UCToNb30oBaTh GYKBLI Pa3HOro perncrtpa u
ByKBEHHO-LUMMDPOBLIE CYMBOIIbI.

* MomMumo aTtoro, Takke cnegyet USMEHUTb CTaH,D,apTHbIVI naponb
Kamepbl Ana npegorsepawieHna HeCaHKUMOHUPOBaHHOIoO
AocTtyna.

Mpamas TpaHcnauma, push-ysegomnenuns u gpyrme cepBuchl
AOCTYMHbI C NOMOLLbIO0 obnavyHoro cepsepa. Hecmotps Ha
pe3epBHOE KONMUPOBaHUE AaHHbIX, CTAOUITIBHOCTb CUCTEMbI U
ynpaBrieHue nornocow nponyckaHus, 6ecnepe6onHas
AOCTYMHOCTb CUCTEMbI He MOXET ObITb rapaHTUpPOBaHa.

Komnnekm nocmaseku

1 x IP kamepa Plug&View Mopg 3akas:

1x Bnok nutaHus c kabenem 1 x Ethernet kabenb
WHCTpyKums no GeicTpon 1 x KpoHwTenH gns
ycTaHoBke - 1 wr. KpenneHusi Ha cTeHe/noTonke
1x Komnakt guck ¢ ytunuramu 1 X cCbeMHas aHTeHHa

* CbeMHas aHTeHHa NocTaBfseTCs Co CreayowmMMmn Kamepamu:
DN-16029, DN-16039, DN-16043, DN-16048, DN-16049

Bbnazodapum 3a ebibop IP kamepsbl Plug&view. Ee Hacmpolka
3aliMmem coscem HeMHO20 8PEMEHU U He nompebyem CrIOXHbIX
Hacmpoek cemu.

4



YcTaHoBka kapTbl MicroSD

B kamepbl DIGITUS® Plug&View gns gomalluHero ncnonb3oBaHust
MOryT yCTaHaBnNmMBaTbCH kapTbl microSD ansa 3anvcu Buaeo.
O3HakoMbTech co cnocobamm yCTaHOBKM KapT NaMsaTh Ha
NPUBEAEHHBIX HIKE N300paXKeHUsX.

DN-16047

YcraHoBuTe KapTy SD, kak
NoKasaHo Ha PUCYHKe.
KoHTaKTbl KapTbl AOMKHBI
pacnonaraTtbcsi B
HanpasneHun obbekTUBa
Kamepbl.

DN-16046

YcraHosuTe kapTy SD, kak o

NoKa3aHo Ha PUCYHKe. Pinl }

KoHTaKTbl KapTbl AOMKHBI ?,3 ;7
32"

pacnonaraTtbcs B
HarnpaBneHun oobekTBa
Kamepsbl.

DN-16029
YcraHoBuTe KapTy SD
KOHTaKTaMu BBEPX, Kak

MoKa3aHO Ha PUCYHKe. I: !



MopTbl U pa3beMbl Kamepbl

LAN: =
MoakntounTte kamepy K nopTy D exm ST
LAN Balwero poyTepa. %]“W | ”Wl““ .
Cb6poc: ; H Gl
HaxmuTe n yoepxusante S ==
KHOTKY cbpoca B TeueHue o —
10 cekyHA nocne BKIOYEHUsI

Kamepbl, 4TOObI BEPHYTH Kamepy R g —

K HAacTpoVikam No yMOn4aHuto. .1”;.! .|’ °

Mutanwue: iil o

Mopknioumnte kabenb = §*=
3MEKTPONUTaHWS ANs nogayn ——
3MEKTPO3HEPTUM. T T

MicroSD: CE0  —
BcrasbTe kapTy microSD ans e @ MicroSD
NoKasbHOrO XPaHEeHUs AaHHbIX. . I""“ ®
XapakTepucTuku: MykpodoH

C6poc

(3BykOBOW BXOA).
AypvoBbixoa:
I'IO/:lKJ‘I}O‘-I ute BHeUJHMVl Cnor ans kapt MicroSD
AMHaMUK C NOMOLLIbIO
3ByKOBOro kabens 3,5 mm. s .
WPS: ) ® "t @
Haxmute n yaepxusaite W MAC:

MAC:
kHonky WPS B TeueHue 8 cekyHa
riocne 3arpysku kamepbl Ans B ”’)
akTmBaumn pexuma WPS. [ ]

T T
PR

(*kHonka WPS npucyTcteyeT ® __._.__I ®

Ha mogensix DN-16029 n Scocol
DN-16046)

Pa3bem gaTyvMKkoB TpeBoru: UcTounmk nmmga, NOCTORHHBII TOK

KoHTakT 1: TpeBOXHbI BXOS,
KoHTakT 2: 3emns

KoHTakT 3: OTKto4eH
KoHTakT 4: HET
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I10p1'|=| n pa3beMbl KaMmepbl

Kamepbi DIGITUS® Plug&View Anst yNM4HOTO UCMONb30BaHMS!
OCHaLLalTCA cneuuanbHbIM kabenem.

O3HakoMbTeCh CO CNocobamu yCTaHOBKM KapT NamsiTh Ha
NPVBEAEHHBIX HUXE N306paKeHUsIX.

. KHonka c6poca:
MopxkntounTe kamepy K
ceTu U NoAoXAMTE, Noka
OHa He byaeT rotoBa kK
ncnonb3oBaHuio. 3atem
HaXXMUTe 1 yaepxuBanTe
KHOMKY B TeveHve 10
CeKyHA. OTO BEpHeT
Kamepy K HacTpolkam no
YMOJTYaHUIO.

. CeTeBoW Kabenb:
MopxkntounTe ceTeBomn
kabenb K Balemy
poyTepy, 4TOObI
yCTaHOBUTb COEAMHEHMNE
c ceTbto VIHTepHer.

. MopaknioyeHne NUTaHUA
12 B NOCTOAHHOIO TOKa:
MogknounTe BHELLHWIA
apanTep NUTaHUsS K
Kamepe Ans nogayu
3NEKTPOSHEPTUN.

. CBeTOAUOAHbIN
WHAUKATOP COCTOSIHUA:
CWHWIA cBETOANOAHBIN
VHAMKATOp NokasbiBaeT,
4YTO KamMepa nogKnryeHa
K CeTU 3NEKTPONUTAHUS.

Y mogenen DN-16039, DN-16043 n DN-16048 nutaHue kamepbl
MOXET OCYLLECTBMSATLCA HAaNpsMYH Yepes ceTeBon kabenb npu
noaxntoveHun k PoE-unxektopy nnu PoE-kommyTaTtopy.



Hactpoika o6bekTnBa

DN-16039
DN-16043

Hacrpoitka hokyca
(yron)

Bbl moxeTe 4
HacTpanBaTh (OOKYC ~ Hactpoiiia peskocrn
1 pe3koCTb Kamepbl
BPY4HYtO. DL
Wcnonbayiite
npsAMYo TpaHCNALMIO
C Kamepbl, YTOObI
HacTpouTb POKYC 1
Pes3koCTb No CBOEMY
YCMOTPEHMIO.

HacTpoiika dhokyca (yron) S
- TN

HacTpo#ka peskoctn



Mpexae yeM, NnpucTynaThb K akcnnyartauum IP kamepbl, HeobxoaMmo
NPOBECTN HEKOTOPbIE NOArOTOBUTENbHbIE PaboThI.

TModknroyume aHmMeHHy
BcraBbTe aHTEeHHY B pa3beM U 3aTAHUTE YCTaHOBOYHbIE GonThbl.

Bcmasbme SD-kapmy

IP kamepbl Plug&View nopgaepxusatoT kaptbl MicroSD o6bemom go
32 I'6. O6bI4HO OHYM ecTb B cBOGOAHOM Npopaxe. N3obpaxkeHus
Unv BMAeo, 3anucanHble |IP kamepolt ByayT coxpaHsTbCs Ha 3Ty
KapTy.

Ecnu kamepa nmeeT BHELUHWUI NOP, HO He OCHALLleHa BHYTPEHHeN
namsiTblo, BcTaBbTe kapTy MicroSD B cooTBeTcTBYlOWMIA CnoT. Kak
TOMbKO OHa BCTAHET Ha CBOE MEeCTO, AOSMKEH pasgacTes
XapaKTepHbIi LLEMYoK.

Modknoyume numaHue
BcTtaBbTe kabenb nuTaHusa B pasbemMm «MutaHue» Kamepbl.

TModknro4ume Kamepy K poymepy (Hanpumep,
AVM Fritz! Box, Telekom Speedport u m.d.)*

BcTaBbTe 0MH KOHeL, ceTeBOro kabensi n3 KOMMnekTa nocTaBky B
nopt LAN kamepbl. BctaBbTe apyroi KoHew, ceTeBoro kabens B
OOMH 13 pa3beMOB, OTMeYeHHbIX kak «LAN» 1 pacnonoxeHHbIX Ha
3agHel yactu poytepa. OfHu poyTepbl UMEIOT TONBbKO OAWH NOpT
LAN, gpyrue - Heckonbko. PoyTep fomkeH umeTb pabodee Internet
coeavHeHve.

* Bbl MOXeTe NponycTMTb 3Tan C NOAKMIOYEHNEM B PEXUME TOUKM
pocTyna. OToT 3Tan Heobxoaumo nponycTuTe Ans mogenu DN-
16047.



2. Co3gaHue y4yeTHOW 3anucu nonb3oBaTtens

Plug&View

Y7066l cnonb3oBaTh kamepy Plug&View n npocmatpuBath BUAEO
B peanbHOM BpeMeHU B ntoboe Bpemsi 1 B ntobom MecTe,
HeobX0AMMO 3aperncTpupoBaTh Kamepy B MOMb30BaTEIbCKOM
akkayHTe Plug&View. Hactpoiikn 1 ynpaBneHne kamepoin MOXHO
npon3BoAMTb Kak co cmapTdoHa/nnaHwerta, Tak u ¢ MNK/HoyTbyka.

2.1 Co3pgaHue yvyeTHOM 3anucu nonb3oBaTens
npu nomMmoLum cmaptcoHa Unu nnaHweTa

Ecnu y Bac ycTpoiicTeo komnaHum Apple®, paGoTaiolee Ha iOS, To
Bbl MOXETE HaliTu Halwe npunoxenune «DIGITUS® Plug&View» B
MarasuHe npunoxenun Apple App Store®. ins cmapTOHOB 1
nnaHweToB Ha 6a3e onepaunoHHo cuctembl Google Android, Bbl
MOXeTe HalTU Halle npunoxermne «DIGITUS® Plug&View»-B
Google™ Play Store.

BeeauTte «Digitus» unu «DIGITUS Plug&View» B none noucka

BaLlero marasvHa npunoXxeHun.

Apple App Store® Google™ Play

[ oo MDD




B peaynbTaTax noucka npunoxenue «DIGITUS®

w Plug&View»- 6yaeT oTMe4eHO crneayoLwmm

CUMBOJIOM.

YcTtaHoBuTe NpUNoXXeHne Ha MobunsHoe yCTpOIZCTBO.

3anycTute NpunoxeHWe Ha nnaHweTe unm cmapTgoHe. Beol
MOeTe BbliGpaTh OAVH U3 ABYX CMOCOBOB CO3AaHNS yYETHOM
3anuecu:

1. Ecnny Bac yxe ecTb yyeTHas 3anucb Google, To MOXHO
nonb3oBaTbCs e Ans npunoxexus Plug&View, nnm

2. CosgaTb HOBbIN akkayHT Plug&View ¢ nHamBuayanbHbIM
MMeHeM Monb3oBaTens U Naponem.

> 11:00 ey 1, Bolidume, ucnonb3ysi
OaHHbIe aKkKayHma
Google

Haxmute "g" ans Bxona
yepes akkayHT Google.
Tenepb anst Bxoga
MO>HO UCMOMb30BaTh
agpec 1 naposb NoYThbl
Google.

Unn

2. Coz0amb Hoeblll
aKKkayHm npu nomouu
Plugé&View

e HaxmuTte Ha «Create
Accounty.



= 1:02 o-

Terms of Use Agreement MpUMKTE NONOXKEHUS
NOJTIUTUKU
Fiir die Nutzung der Plug&View Plattform via Browser oder App ist es KOH(bVI,quLWIaJ'IbHOCTM
erla-derlwm die Datenschutzerkldrung, die Sie unter http://plug
sw.com/privacy-policy-for-platform-apps/ nachlesen kénnen, zu Ang ncnonb3oBaHUA
Zﬁ?ﬂf;n cuctembl DIGITUS®
Ich habe die Datenschutzeridérung der Assmann Electronic GmbH zur PlUg&VIeW

Kenntnis genommen und willige in die Datenvereinbarung geméan der
Daienschu!zekbrung ein. Ich kann meine Einwiligung jederzeit unter
digitus.info wiedernufen,

Wnr weisen jedoch darauf hin, dass die Plug&View App dann nicht mehr
genutzt werden kann Ha cnepytowuen
To use the Plug&View platform via the browser or app, it is necessary CTpaHuue Bb|68pMTe

that you agree to the privacy

policy, which you can find at hitp:/plug
platform-apps/ Privacy policy:

| have acknowledged the privacy policy of Assmann Electronic GmbH, naponbe 1

and hereby consent to the dala agreement according to the privacy

pohcy I may revuke myonnsenl at any time by contacting I'IO,D,TI?ep,ElVITe ap‘pec
Jigitus.info, e-mail.

However, we must ﬂolnt out that in the event consent is revoked, the

olicy-for nM4a nonb3oBaTtens,

3atem HaxmuTe Ha «Apply», 4Tobbl co3gaTb akkayHT plug&View.
Mocne 3Toro Bbl NOMYyYNTE INIEKTPOHHOE NMUCbMO C MHCTPYKLMSIMU
o aKkTuBaLmMK akkayHTa. [ina BxoAa B NPUNoXeHne BBEAUTE CBOU
MMsi MoNb30BaTenNs U naponb, 3ateM HaxxmuTe «Login». Tenepb Bbl
MoxeTe 400aBUTb KaMepy K y4eTHou 3anucu (cm. pasgen 3).

2.2 Co3aaHue Nonb30BaTeNbCKOro akkayHTa npu
NOMOLLU NepCoHarbHOro KomMnbioTepa

Momnmo mobunbHoro npunoxenust B cuctemy DIGITUS Plug&View
MOXHO Takke BoWTU Yepes bpay3sep c MK/HoyTOyka.

3angute Ha cant http://plug-view.com
3aTtem HaxmuTe "Login" ans Bxoaa Ha Beb-noptan Plug&View.



1. Bolidume, ucnonb3ys
daHHble akkayHma Google

Haxmute "g" ansa sxoga
Yyepes akkayHT Google.
& 3aTtem BBeaWTe CBOV agpec
AneKTPoHHOW noyTbl Google
1 napornb Ans Bxoaa.

Nnn

2. Co30amb HO8bIl aKkKayHm
Create Account npu nomowju Plug&View

HaxmuTte Ha «Create Account».
YkaxwuTe BClo Heobxoanmyto
MHdOPMaLMIo Ha creaytoLen
CTpHULIE 1 NoATBEPAUTE ee,
HaxaB Ha «Apply». [lanee Bbl
nony4nTe aNeKTPOHHOE NMCbMO
C UHCTPYKLMSMM MO
pa3brioknpoBKe akkayHTa.
Tenepb MOXHO UCNONb30BaTh
[JaHHble nonb3oBaTens Ans
BXO/a Ha CTpaHuLie Bxoda B
cuctemy 1 fobaBrneHust Kamepbl.

Mo3apaBnsiemM, Bbl YCMELIHO CO34anmn akkayHT Yepes NpuUoxeHne
unu Beb-nopran.

Y1066l HacTpouTb noaknoveHve WiFi Bawe IP-kamepbl B pexvme
TOYKM JOCTyna, nepenanTe K pasgeny 3 AaHHOro pykoBOACTBA.
O6patute BHMMaHuWe, 4To Ansa mogenu DN-16047 Heob6xooumo
NOAKMIOYUTL Kamepy K ceTn VIHTEpHET B pexxmme TOYKM AOCTyna.

Meperigute Kk pasgeny 4, ecnv Balla kKaMepa NoAKIioYeHa K
poyTtepy yepe3 kabenb LAN.
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3. NoaknioueHue IP kamepbl Plug&View

yepe3 Wi-Fi
3.1 C nomouwbio cmapT¢oHa/nnaHweTa

OTkponTe HacTporkn Wi-Fi Ha
BalleM cMapTdoHe/nnaHLweTe.
HaynuTe nonck AoCTynHbIX
6ecnpoBoAHbIX ceTew B
HenocpeacTBeHHON 6nn3ocTy.
Kamepa 6yaet oTobpaxatbcsi B
Buae becnpoBoaHoO ceT BMecTe C
HOMEpPOM MOAEeNM 1 nocnegHummn 6
cumonamu agpeca MAC.

Flugandiiew
AEGT
AEGLOG
AEG-Gurst

AEG-PAIT

4 4 4 4 4 2

ON-16047-003F00

E

FAAM Assmann

E

Ao Prejectort_Bote
- ©
+  PlugandView = (D)

NETZWERK WAHLEN :

MoakntounTe cmapTdhOH Unu nnaHwert K IP-kamepe vepes
6ecnposoaHoe coeanHeHne WLAN.

o000 02-de+ 36 n23 § eoxmmy

Mocne Toro, kak
£ Einstellungen WLAN

cMmapTdoH/nnaHweT
NOAKIIOUUIICA K Kamepe, WLAN (/
yCTaHOBUTE NPUMNOXeHne 7 DNCiB045 07adns -0

Plug&View. OTkpoiite
npunoxenne Plug&View.

14



Mpunoxexue Plug&View
0BHapyXuUT NOAKMIOYEHNe K
kamepe Plug&View,
paboTatoLLel B pexume ToUKn
[ocTyna, n NpeanoxuT BelbpaTb
ceTb Wi-Fi, k koTopon
HeobX0ANMO NOAKMNIYUTL
Kamepy.

Back OT06pa3nTCs CrMCcoK AOCTYMHbIX
ceTew, HaxoasLWwmxcs B
HenocpeacTBEHHON 6rn3ocTy.
BbiGepuTe ceTb, kK KOTOPOW

R Heobxo0aNMO MOAKIIYNTL KaMepy.

Ecnu ceTb He oTobpaxaeTcs,
HeobXoaNMO MOMEHSITb MecTo
pacnornoXeHust Kamepsbl.

BHUMAHME: Kamepa He nopnepxuBaet cetn WLAN co
CKpbITbIM naeHTudmukatopom SSID. Ecnu BbI xenaeTte
NOAKNIOYUTE KaMepy K OAHOW U3 TaknX ceTen, caenanTe ee
BUAUMOMN.
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weeo o2-dar ¥ mas | e

{ Back Wi-Fi Setting

seessnnsns

Cancel

Please se-connect the WiFl of your mobie phone 10 The wireless

your
Foutes o AP before logn 1o BIGITUS Plugtiew

o

BBeguTte ceTteBom naponb,
KOTOPbIM 3aKoAMpoBaHa
6ecnpoBogHas cetb WLAN, B
COOTBETCTBYHOLLEE None 1

noaTeBepaute BBof, Haxas Ha OK.

B onepaunoHHbIx cuctemax
Android, nocne ycnewHoro
NOAKMIOYEHUS], MPUINOXEHNE
NPeLNOXNUT NOAKIMIOYNTL BaLl
cMapTdoH/nnaHweT obpaTHo Kk
Bawewu cetn Wi-Fi.

Kak npaBwno ato npoucxogut
aBTomaTunyeckn. Ecnm atoro He
npousoLuso, nepenaute B
HacTponku Wi-Fi Bawero
cmapTdoHa/nnaHweTa un

nogkntoumTech k Bawen cetn Wi-Fi.



4. No6aBuThb IP kamepy Plug&view

4.1 C nomouwbto cmapTtdoHa/nnaHweTa

Haxmute «+», 4yTo6bl J06aBUTL
Kamepy BO BpeMs nepBou
ycTaHoBKM kamepbl Plug&View.
MepengnTe B HACTPOWKK (MKOHKa
LUecTepeHKy B MPaBOM BEPXHEM
yrny) n Haxmute «Add camera
(JobaBuTb kamepy)», ecnu yxe
ecTb paboTatoLme kamepbl. ATO
nerko BbIMOMHWTL Npu nomoLum QR-
KoAa cMapTOHOM, NaHLIEeTOM
UKW pyYHbIM BBOAOM Aa@HHbIX 4ns
aKTUBaLmW.

Ons ckaHmpoBaHusa QR-koga nogxogdaT criegytolme yCTponcTea:
Apple iPhone®, Apple iPad®, cMapTdoHbI U NNaHweThl Ha 6ase
Android (co BCTPOEHHOW Ha 3afHel MOBEPXHOCTUN KaMepow).

Appec MAC, kog aktuauum n QR-kof ykasaHbl Ha nocnegHen
CTpaHuLe HaCTOSILLEeN HCTPYKLMN.

lpumeyvaHue: MobunbHoe ycTponcTeo Ha 6a3e Android gomkHO
mmeTb Bepcuto MO He Huke 2.3.5.
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HobaeneHue kamepbi cyumbieaHueM Kkoda QR

[ Scan QR Code ] Ha cnepytowlei ctpaHnue

) - BblbepuTe «Scan QR code».
Ha mobunbHoOM ycTponcTee
aKTMBMpYeTCs PYHKUMA
ckaHupoBaHusa QR kopa.

OtckaHunpyite QR-koa Ha mocrneaHen cTpaHuue AaHHOro
pykoBoAcTBa, YTobbl J06aBUTL kKamepy B Ball akKayHT.

Mpwu ckaHmpoBaHun QR-koAa Bam, BO3MOXHO, NOTpebyeTca HanTu
HY)>XHOE MONOXeHWe yCTPOWCTBa AN KOPPEKTHOrO pacno3HaBaHUs
Koaa.

Hob6aeneHue kamepb! py4HbIM 8eodom MAC-
adpeca u koGa akmueauyuu

MAC-agpec v Koa aKkTMBauMu ykasaHbl Ha nocneaHen cTpaHuLe
HacTosiLen MHCTpykumn. B npunoxenumn Plug&View HaxmuTe «Add
cameray» u 3aTem nepengute B «Manual input».

BBegute 6ykBeHHO-UMEPOBYIO KOMOMHALMIO, KOTOpPasi HAXOAUTCS
noa Hagnucoto «MAC». 3aTeM BBeaNUTE KO akTUBALMM U HAXMUTE
Ha «Apply».
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4.2 [ob6aBneHue Kamepbl K NepCOHaNIbHOMY
KOMNbIOTEPY Yepe3 Gpaysep

Monk3osaTtenu MK/HoyTOyKoB Takke MoryT 4obaBnsaTb Kamephbl B
aKKayHT, 4eCTBYS MO aHaNorM4yHou cXeme, YTo U ANt MOBUMbHbIX
YCTPOWCTB, Ha4MHas ¢ nyHkTa 4.1.

Mocne nepBoro Bxoaa Ha CTpaHuLy ynpaBreHus kKamepou
http://www.plug-view.com ¢ NOMOLLbI0 NOTMHA ¥ Napons Bbl
nepevigeTe Ha CTpaHULy AN YCTAHOBKW NnarnHa. HaxmmTe KHonKy
«Download» n cnepyvite MHCTPYKLMAM MO YCTAHOBKE.

Please download the new version of "Plug&View
plugin” for camera liveview:

If you have already downloaded before, check the
following:

« Enable P2P Viewer in Chrome extension
Open Menu > Settings > Extensions > P2P Viewer

« If you have ever deleted the plugin before, please download
the Plug&View plugin

« If P2P Viewer does not exist in the Chrome extension list,
please download P2P Viewer

« Chrome installation tutorial
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L&

Please complete registration in 60 minutes
after boot up your camera, or you need to

re-power the camera and complete
registration process again.

[Mocne ycTaHoBKM NnarvHa
BHOBb 3alianTe B CBOW
aKKayHT Ha cTpaHuue
http://www.plug-view.com.

HaxmuTe KHOMKy co 3HaKom
«+», ytobbl fOBABUTL
Kamepy.

3aTeM HaXXMuTe KHOMKY CO
3HAKOM «>», YTOObI
nepenTn Ha crneayLLyio
CTpaHuuy 1 cregynte
OanbHENLWNM yKkasaHusM.

Mocne atoro BBeaute MAC-afpec v ko akTuBaLuu, ykasaHHble Ha
nocnegHen cTpaHuLe pykoBoACTBa NOMb30BaTens, v HaxMuTe

«Apply», 4Tobbl 06aBUTL Kamepy.

Add Camera

MAC Address

Activate Code
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Mocne ycnewHoro nobasneHus Kamepbl B Ball aKKayHT NpoBepbTe,
nocrynaet nn M306pa>KeHme C KaMepbl B peXXnume pearnbHoro
BpeMeHMN.

.oe

Ecnu B AanbHeWwweM nnaHUpyeTcsl MCNONb30BaTh Kamepy
Plug&View c ceTeBbIM kabenem, ycTaHOBKa cunTaeTcs
3aBepLUeHHOW Ha 3TOM 3JTane.

Ecnu Bbl NnaHupyeTe ucnosnb3oBaTth GECNPOBOLHOE COEANHEHNE

Wi-Fi ans cBo6oaHoro nepemelLeHust kKamepbl, Noxanyicra,
03HaKOMbTECH C AarnbHENLUNMMN UHCTPYKLUSIMU.
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5. Hactpownka Wi-Fi Ha

Hactpoiiky 6ecnposogHoro (Wi-Fi) coeamHeHus mexay IP-kamepon
n Wi-Fi-poyTepom/Toykor AOCTyna MOXHO TakkKe BbIMOMHUTL C
nomoubto MK/HoyTOyka Yepes Bpaysep.

Mocne ycneLHon ycTaHOBKM kamepsbl, BOWANUTE Ha BebcanT
«http://www.plug-view.comy». HaxxmunTe Ha «Login | My camera
administration».

Wcnonb3ayiite Baw akkayHT Plug&View unu Beibepute Bxof 4epes
akkayHT Google. Ecnu Bbl He Bownn B akkayHT Google, To Bbl
6yneTe nepeHanpasrneHbl Ha cTpaHuuy Bxoda Google.

Mocne Bxoaa B cMCTEMY Bbl yBUAUTE TPAHCIALMIO C Kamepbl B
pearnbHOM BpeMeHM.

CnipaBa OT n306paxeHus kamepbl 0
HaXOASATCst HECKOIBbKO UKOHOK. =
Haxmute «Camera Configuration»,
4yTObbI NEpeviTn B
nonb3oBaTenbCKNN NHTepdenc ©
Kamepbl.
7
G

‘ =] , Camera Configuration
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OTKpOeTCS OKHO Nonb3oBaTenbCKoro Beb-nHTepdenca kamepsl.
[Ins BXxoga ncnonb3yiTe akkayHT «kamepay, YCTaHOBIIEHHbIN MO
ymonuaHuio, n BBeaute "admin” B none norvHa n "admin" B none
naponsi. Mpu Beibope onuumn «Autologiny, B cneayowmnii pas BXxoq B
MEeHI0 KOHdUrypauum byaeT ocyLecTBNATLCA aBTOMaTUHECKN.
HaxmuTte Ha «Login».

D[G]TUSO DIGITUS® PLUG&VIEW

safe&secure - anywhere. anytime.

R —
Lenguage:
Stream

B nonb3oBaTensckoM UHTEpPENCE KaMepbl HAXXMUTE Ha 3HAYOK
Wi-Fi, yTo6bl nepevitn B HacTporikn Wi-Fi.

safe&secure - anywhere. anytime.

Home Replay Parameters System Wireless

MosiBUTCSt OKHO Nowcka, B kKOTOpoM ByayT nokasaHbl Bce AOCTYMHbIe
ceTu. Beibepute nageHtndmkartop (SSID) Baluein ceTn n noaTBEPAUTE
HaxaTmeM Ha «OK».

ssiD Signal  Authentifcierungsmodus.
PMM % -PSK-TKIP][ -PSK-CCMP][ JESS]
) TestPun 88% PSK-TKIF)[WPAZ-PSK-CCMF][WFS][ESS]
O Piugandview 88% [WPA-PSK-TKIPJ[ESS]

~ Sam masma A mALs e e A
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B cnepaytowem okHe BBegmTe naponb Wi-Fi n noarsepanTe, Haxas
«OK».

Passwort: Y6eanTech, YTo poyTep
hYHKUMOHUPYET Kak
ok DHCP-cepsep. 310

HacTpowka no
yMOn4YaHuio ANsi noYvTn
BCEX POYyTEpPOB.
Tenepb coeanHeHue ¢
Balleln 6ecnpoBogHON
CeTblo YCTaHOBMEHO.
Ecnu coegnHenue
yCTaHOBIEHO YCMELLHO,
TO 37O coobLieHne
nosiBUTCS B OTAENbHOM
OKHe.

Tenepb MOXHO U3BMeYbL CeTeBOW kabenb U3 kKamepbl U
3aKpbITb OKHO Gpay3epa.

Mo3gpaBnsiem. Bbl TONbKO YTO 3aBepLUMnM yCTaHOBKY IP kamepsbl
Plug&view. Tenepb y Bac ectb goctyn k IP kamepe B nio6on
MOMEHT BpEMEHM CO CMapTdoHa, NNaHLWETHOro KOMMNblTepa unm
yepes 6payasep.
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6. Hactpouka oGHapyXeHus ABUXKEHUA U

BKJ1HOHeHUA 3anucum

Cucrema DIGITUS® Plug&View umeeT tyHKLMM OGHapYXeHWs!
OBWKEHVS 1 BKITKoYeHUst 3anmcu. [nsi ncnonb3oBaHusi 3Ton yHKLUMN
B Kamepe [omkHa BbiTb yCTaHOBINEHa 0T(hopMaTUpoBaHHas kapTa
SD 1 BKItoYEHO 0OHapYXeHNe ABUXKEHUS.

YTobbl 0OTchopMaTMpoBaTh kapTy SD, noaknioumTeck kK kKamepe
Yyepes Beb-nopTan.

CnipaBa OT n3006paxeHUsi kamepbl 0

HaXoAsATCs1 HECKOINbKO MKOHOK. 4

Haxmunte «Camera Configuration»,

4yTOObI MEPENTN B NONMb30BaTENLCKUIA

NHTepdenc kamepbl. ©
v
G

, Camera Configuration

OTKpOETCS OKHO NOb30BaTENbCKOro Be6-uHTEepdeica kamepsi.
[ns Bxoda Ucnonb3ynTe akkayHT «kamepay, YCTaHOBIEHHbIN MO
ymon4yaHuio, u BBeguTe "admin" B none norvHa v "admin™ B none
naponsi. Mpwu BeiGope onuumn «Autologiny, B cneayowmnii pa3 BXxof B
MEHI0 KOHuMrypaumm byaeT ocyLlecTBNATLCA aBTOMATUYECKU.
HaxmuTe Ha «Login».

MonyunTe AocTyn K uHdopmaumm Ha SD-kapTe MOXHO B MEHIO
System -> Local storage. OtdopmaTtupyvite kapTy SD B pasgene
MeHo «Format».
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Mocne hopMaTMpOBaHUS KapTbl MOXHO BKIMIOYNTL OBHapyXxeHue
[BWXEHNS.

[ns aTtoro B nonb3oBaTenbckoM Be6-UHTEpdeENce nepengnTe B
«Parameters» -> «Motion Detect».

DIGITUS'

Home Replay Parameters. System Wireless
Arsa:
Activate B Enasis

Sensibilty L Select All Clean All

Action:
E-Mail
Output

Send E-mail
Alarm With Snapshet ) Send ToEmall ™ Upioad to FTP
Alarm With Record 4 Upload to FTP

Trigger Alarm Output

— esktlta O Wtk ® A

BkntounTte obHapyxeHne aBuxkeHust, Haxxas «ONy». LiIBeTHoM y4acTok
Ha BMAEOU306paXKeHUM - y4acToK, Ha KOTOPOM Kamepa pacro3HaeT
ABWXEHVe, T.e. y4acToK, rAe Npu oBHapyXeHN ABUKEHNS
HayvHaeTcs 3anucb BUAEO Mnn n3obpakeHni. o ymonyaHuio
NPaKTUYECKN BECb 3KPAH NOKPbIT KPACHBIMU MPSMOYTOSbHUKaMM.
HaxxmuTte Ha LBeTHble MapKepebl, YTOObI UCKNIOYNUTL 0OHapyXeHve
OBWKEHWS B onpeaeneHHbIX 06nacTsx. BeinonHmMe atn gencteus, Bbl
yAanviTe Mapkep ¢ yvactka BugeonsobpaxeHus. Bel MoxeTe
yNpaBnsTb YyBCTBUTENLHOCTHIO OBHAPYXEHNS ABVKEHUSA B MEHIO
«Sensibility». [JoCTynHbI YeTbIpe YPOBHA YyBCTBUTENbHOCTU: «Very
high», «High», «Normal» n «Low».

AxkTuBupymnTe «Alarm with recording» Ans coxpaHeHusi 3anncu Ha
kapTy SD B cnyyae obHapy>XeHUsi OBVKEHMS.

HRAA
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B HacTpolikax rpadmka Bugeosanmcy obHapy>KeHUs ABUXKXEHUSI
MOXXHO U3MEHUTb HACTPOMKN BpeMeHU. [JoCTynHbI cneayoLme
pexvmbl Bugeosanucu: «Kaxayto Hegentoy, «B paboune gHu» munm
«MoCTOAHHOY.

Bbl Takke MOXeTe HacTPOUTL rpadmk MO CBOEMY YCMOTPEHUIO.
CoxpaHunTe HacTpoWkn, Haxxas «Apply».

Bbl ycnelHo HacTpounu obHapyxeHve ABUKEHNUS C BKIHOYEHNEM
3anucy.

Onsa nonyyeHus 6onee nogpo6HoN MHcopmauum o Be6-
nHTepdence kKaMepbl 03HaKOMbTECh C PyKOoBoACTBOM Ha CD-
ANCKe, NpunaraemMom B KOMMNeKTe.

Ecnu y Bac BO3HMKNM Bonpockl, noceTute pasgen FAQ Ha
caunTe Plug&View (http://www.plug-view.com/) unu cBsaxurecb
C Hallen cnyx6omn nogaepKKu No ropssven NMMHUN
(http://www.plug-view.com/support-de/support/).

ToproBble Mapku

DIGITUS aBnsieTcst 3aperMcTpMpoBaHHON TOProBO MapKom
ASSMANN Electronic GmbH.

Apple, Apple App Store - 3aperucTpmpoBaHHble TOProBble Mapku
Apple Inc.

Android, Google, Google play siBnstTCS 3aperncTpMpoBaHHbIMM
ToprosbiMu Mapkamu Google Inc.

AVM Fritz!Box - 3apeructpupoBaHHag Toprosas mapka AVM
Computersysteme Vertriebs GMBH.

Telekom Speedport - 3apernctpupoBaHHas ToproBas Mmapka
Deutsche Telekom AG.

MpumeyaHwue:

Bce npoune, He nepevncneHHbIe Bhille TOProBble Mapku SIBMSIOTCS
COBCTBEHHOCTBIO COOTBETCTBYIOLLMX NpaBoobnagaTenein.
YkasaHHbIe B HACTOSILLIEM PYKOBOACTBE TOProBble Mapku Unn
TOProBble Ha3BaHWSA UCMOIb3YHTCS TOMbLKO B LIENSX OnncaHus
paboumx npoueayp, YTo He NoapasymMmeBaeT BO3MOXHOCTb MX
cB0OOAHOrO NPUCBOEHMS UMW Ucnonb3oBaHus. B niobom crnyyae oHn
SIBNSILOTCSH COBCTBEHHOCTBLIO COOTBETCTBYIOLLIETO NpaBoobragartensi.
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DIGITUS"

Kamery IP DIGITUS®
Plug&View

Instrukcja szybkiej instalacji



Zasady bezpieczenstwa

* Z kamery IP Plug&View nalezy korzysta¢ wytgcznie w otoczeniu o
temperaturze z przedziatu zalecanego dla tejze kamery

* Gdy kamera nie jest uzywana, nalezy jg przechowywaé w
czystym i suchym miejscu o temperaturze od 0°C do 40°C

Nie przykrywa¢ kamery

Nie naraza¢ kamery na dziatanie cieczy (nie dotyczy kamer do
montazu na zewnagtrz wyposazonych w ochronng ostone IP66)

Kamery IP Plug&View nie stuzg do wyreczania oséb dorostych w
sprawowaniu nadzoru. Nalezy regularnie zajmowac sie dzie¢mi,
cztonkami rodziny lub zwierzetami domowymi, dbajac o ich zdrowie

Upewnij sie, iz kamery IP do montazu wewnetrznego sg stosowane
jedynie wewnatrz budynkéw. Kamery te nie sg przeznaczone do
montazu na zewnatrz, poniewaz moze to prowadzi¢ do
uszkodzenia kamery. Aby zainstalowaé kamere na zewnatrz
budynku, wybierz model przystosowany do montazu na zewnatrz

Zainstaluj kamery IP Plug&View w niewielkiej odlegtosci od fatwo
dostepnego gniazdka Sciennego. Upewnij sig, ze przewdd
zasilania nie jest naprezony lub naciggniety

Umies$¢ kamery IP Plug&View w obrebie zasiegu sieci Wi-Fi
routera oraz upewnij sie, iz pomiedzy kamerg a routerem nie
znajduja sie zadne przeszkody, ktére mogtyby zaktécaé sygnat
sieci Wi-Fi



Nalezy chroni¢ kamery IP Plug&View przed urzadzeniami
elektrycznymi oraz innymi urzgdzeniami, ktére generuja fale
elektromagnetyczne o wysokiej czestotliwosci i mogg powodowac
zaktécenia (np. kuchenki mikrofalowe, telefony komérkowe itp.)

Kamere, przewdd sieciowy i przewdd zasilania nalezy umiesci¢ w
miejscu niedostepnym dla dzieci, poniewaz przedmioty te moga
stwarza¢ zagrozenie

Nalezy uzywac jedynie dostarczonego zasilacza.

Nigdy nie nalezy probowa¢ wtasnorecznie naprawia¢ kamer IP
Plug&View. Naprawa i czynnosci konserwacyjne muszg zosta¢
przeprowadzone przez specjalistow.

W razie problemoéw nalezy skontaktowac sie z obstuga klienta
firmy DIGITUS.

Nalezy przestrzega¢ wszystkich przepiséw dotyczacych
monitorowania za pomocg kamery. Kamery IP Plug&View sg
przeznaczone do zastosowan domowych. Poinformuj o
zainstalowanej kamerze cztonkéw rodziny, krewnych i osoby
zatrudnione do pracy w domu. Upewnij sig, iz kamera nie jest
skierowana na przestrzen publiczng lub posesje sgsiadow.



Informacje dotyczace prywatnosci

* Przeczytaj i zaakceptuj polityke prywatnosci dotyczaca stosowania
systeméw DIGITUS® Plug&View dostepng na stronie internetowej
http://plug-view.com/privacy-policy-for-platform-apps/.

e Ustaw takie hasto do konta Plug&View, ktére zapewnia wysoki
poziom bezpieczenstwa, aby chroni¢ konto przed nieuprawnionym
dostepem.

e Hasto powinno sktadac¢ sie z co najmniej 8 znakéw; zaleca sie
stosowanie wielkich i matych liter oraz znakéw alfanumerycznych.

* Ponadto nalezy zmieni¢ standardowe hasto dostepu do kamery,
aby chroni¢ takze jg przed nieuprawnionym dostepem.

Transmisja na zywo, powiadomienia push oraz inne ustugi sg
dostepne za posrednictwem serwera w chmurze. Pomimo
stabilnosci systemu i zastosowania rozwigzan umozliwiajacych
tworzenie kopii zapasowych oraz zarzadzanie przepustowoscia,
nie mozna zagwarantowac nieprzerwanej dostepnosci systemu.

Co znajduje sie w pudetku

1 kamera IP Plug&View Opcjonalnie:

1 zasilacz z przewodem 1 przewdd Ethernet

1 instrukcja szybkiej instalaciji 1 element do montazu

1 ptyta CD z programami podsufitowego/$ciennego
narzedziowymi 1 wyjmowana antena*

* Nastepujgce modele kamer sg wyposazone w wyjmowang antene:
DN-16029, DN-16039, DN-16043, DN-16048, DN-16049

Dziekujemy za wybranie kamery IP Plug&View, ktérg mozna szybko
i tatwo przygotowac do pracy bez skomplikowanych ustawien
sieciowych.



Instalacja karty microSD

Kamery DIGITUS® Plug&View do montazu wewnatrz moga zostaé
wyposazone w karty microSD do nagrywania.

Aby sprawdzi¢ sposéb instalacji karty, zapoznaj sie z rysunkiem
przedstawiajgcym instalacje.

DN-16047

Zainstaluj karte SD jak
pokazano na rysunku. Ziote
styki na karcie SD powinny
by¢ skierowane w strone
obiektywu kamery.

DN-16046

Zainstaluj karte SD jak
pokazano na rysunku. Ziote
styki na karcie SD powinny
by¢ skierowane w strone
obiektywu kamery.

DN-16029

Zainstaluj karte SD jak
pokazano na rysunku. Ztote
styki na karcie SD powinny
by¢ skierowane ku goérze.




Ztacza kamery

LAN:

Stuzy do potaczenia kamery z
portem LAN routera.
Przycisk resetowania:

Po uruchomieniu kamery
nacisnij i przytrzymaj przez
10 sekund przycisk
resetowania, aby przywrécic¢
domysine ustawienia kamery.
Zasilanie:

Podtgcz dostarczony przewdd
zasilania, aby zapewni¢
zasilanie kamerze.

Gniazdo microSD:

W16z karte microSD w celu
lokalnego magazynowania
danych.

Gniazdo MIC: Mikrofon
(wejscie audio).

Wyjscie audio:

Podtgcz zewnetrzny gtosnik za

pomocg przewodu audio 3,5 mm.

WPS:

Po uruchomieniu kamery
nacisnij i przytrzymaj przez

8 sekund przycisk WPS, aby
aktywowac tryb WPS.
(*Modele kamer DN-16029 i
DN-16046 sa wyposazone w
przycisk WPS)

Alarm:

Styk 1: Wejscie alarmu

Styk 2: Uziemienie

Styk 3: Nieuzywany

Styk 4: Normalnie otwarty
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Ztacza kamery

Kamery DIGITUS® Plug&View do montazu na zewnatrz s
wyposazone w specjalny przewod.

Aby sprawdzi¢ sposob instalacji karty, zapoznaj sie z rysunkiem
przedstawiajgcym instalacje.

. Przycisk resetowania:
Gdy kamera zostata
podtgczona i znajduje sie
w trybie gotowosci do
pracy, nacisnij i
przytrzymaj przez
10 sekund przycisk
resetowania. Spowoduje to
przywrécenie domysinych
ustawien kamery.

. Przewéd sieciowy:
Podtgcz przewdd sieciowy
do routera, aby uzyskac¢
dostep do Internetu.

e  Zlacze zasilacza DC 12 V:
Podtacz zewnetrzny
zasilacz, aby dostarczy¢
zasilanie do kamery.

. Lampka LED wskaznika
stanu:

Niebieska lampka LED
wskaznika stanu pokazuje,
czy kamera jest zasilana.

Modele kamer DN-16039, DN-16043 oraz DN-16048 mogg by¢
zasilane bezposrednio przez przewdd sieciowy w potgczeniu z
przetacznikiem i iniektorem PoE.



Ustawienia obiektywu

DN-16039
DN-16043

Ustawienie ogniskowej
(kata widzenia)

Mozliwo$¢ recznego L

ustawienia Ustawienie ostrosci

ogniskowe;j i

ostrosci za pomocg D%

pokretet. Ustaw

ogniskowg i ostros¢

w oparciu o obraz

podgladu na zywo.

Ustawienie ogniskowej -

(kata widzenia) ;&
fra8




1. Przygotowanie

Przed zastosowaniem kamery IP nalezy wykona¢ czynnosci
przygotowawcze.

Podfaczanie anteny

Podtgcz antene bezprzewodowg do ztgcza i dokrec¢ Sruby
montazowe.

Wkiadanie karty SD

Kamery IP Plug&View obstugujg karty microSD o pojemnosci do

32 GB, ktére mozna kupi¢ u lokalnych dystrybutoréw. Zdjecia lub
filmy wykonane kamerg IP sg zapisywane na zainstalowanej karcie.

Jesli kamera ma port zewnetrzny i nie jest wyposazona w pamieé
wewnetrzng, nalezy wsung¢ karte microSD do odpowiedniego
gniazda az do zatrzasniecia.

Podfaczanie zasilania

Podtgcz kabel dotgczonego zasilacza do ztgcza kamery
oznaczonego jako ,Power” (Zasilanie).

Podigcz kamere do routera (np. routera AVM Fritz!
Box, Telekom Speedport itp.)*

Podtacz jeden koniec dostarczonego przewodu sieciowego do portu
LAN kamery. Podtgcz drugi koniec przewodu sieciowego do
jednego ze ztgczy oznaczonych jako ,LAN” z tytu routera. Niektore
routery posiadajg tylko jedno ztgcze LAN, inne maja ich kilka.
Router musi by¢ potgczony z Internetem.

* Ten punkt mozna poming¢, jesli uzytkownik korzysta z trybu
punktu dostepu kamery. W przypadku kamer DN-16047 nalezy
poming¢ ten punkt.



2. Ustawianie konta uzytkownika Plug&View

Aby moéc korzystaé i wyswietla¢ obraz podgladu na zywo z kamery
Plug&View w dowolnym miejscu i czasie, nalezy zarejestrowac
kamere na koncie uzytkownika Plug&View. Do konfiguracji i
sterowania kamerg mozna uzy¢ zaréwno smartfona/tabletu, jak i
komputera/laptopa.

2.1 Tworzenie konta uzytkownika za pomoca
smartfonaltabletu

Uzytkownicy urzadzen z systemem operacyjnym Apple® iOS moga
pobraé aplikacje ,DIGITUS® Plug&View” w sklepie Apple App
Store®. W przypadku smartfonéw i tabletow z systemem
operacyjnym Google Android OS aplikacje ,DIGITUS® Plug&View”
mozna pobraé w sklepie Google™ Play.

W polu wyszukiwania w sklepie App Store® lub Google™ Play

wprowadz nazwe ,Digitus” lub ,DIGITUS Plug&View”.

Apple App Store® Google™ Play




W wynikach wyszukiwania aplikacja ,DIGITUS®

r°\
u Plug&View” zostanie oznaczona tym symbolem.

Aplikacje nalezy zainstalowa¢ na swoim urzadzeniu mobilnym.

Uruchom aplikacje na tablecie lub smartfonie. Istniejg 2 opcje
utworzenia konta:

1. Jesli uzytkownik posiada konto Google, mozna go uzy¢ do
korzystania z aplikacji Plug&View lub

2. Mozna bezposrednio utworzy¢ konto Plug&View z indywidualng
nazwag uzytkownika i hastem.

B: 00 vm; 1, Rejestracja za pomoca
konta Google
Kliknij przycisk ,g"
oznaczajacy ,konto
Google”, aby sie
zalogowac¢. Do
zalogowania sie nalezy
uzy¢ adresu i hasta
poczty Google.

Lub

2. Tworzenie nowego
konta w aplikacji
Plug&View

e Kliknij opcje ,Create
Account” (Utwérz konto).
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Terms of Use Agreement Zaakceptuj polityke
prywatnosci
Fiir die Nutzung der Plug&View Plattform via Browser ader App ist es dotyczqca korzystania
erlarderlwm die Datenschutzerkdénung, die Sie unter http://plug ®
ew.com/privacy-policy-for-platform-apps/ nachlesen kénnen, zu z systemu DIGITUS
aKzep[ eren .
Erkliarulng Plug&View.

Ich habe die Datenschutzeridérung der Assmann Electronic GmbH zur
Kenntnis genommen und willige in die Datenvereinbarung geman der
Daienschu!zekbrung ein. Ich kann meine Einwiligung jederzeit unter
digitus.info wiedernufen,

Wnr weeisen jedoch darauf hin, dass die Plug&View App dann nicht mehr Na nastepnej stronie
O e wybierz nazwe

To use the Plug&View platform via the browser or app, it is necessary uzytkownika’ hasto i
that you agree to the privacy X .

policy, which you can find at http:/plug T y-for pOtWIerdZ adres

platform-apps/ Privacy policy:
| have acknowledged the privacy policy of Assmann Electronic GmbH,
and hereby consent to the dala agreement according to the privacy
pohcy I may revoke my consent at any time by contacting

digitus.info,
However, we must point out that in the event consent is revoked, the

e-mail.

Nastepnie stuknij opcje ,Apply” (Zastosuj), aby utworzy¢ konto
Plug&View. Na konto uzytkownika zostanie wystana wiadomos$¢é
e-mail z instrukcjami dotyczgcymi aktywacji konta. Nastepnie zaloguj
sie do aplikacji za pomocg opciji ,Login” (Zaloguj), nazwy uzytkownika
i hasta. Teraz mozna doda¢ kamere do konta (przejdz do pkt. 3).

2.2 Tworzenie konta uzytkownika za pomoca
komputera

Dostep do systemu DIGITUS Plug&View mozna uzyskac nie tylko
za pomoca aplikacji, ale takze za pomoca komputera/laptopa i
przegladarki internetowe;.

Otwérz strone internetowg http://plug-view.com
Kliknij przycisk ,Login” (Zaloguj), aby przej$¢ do strony internetowej
Plug&View.

12



Create Account

‘;'\55 ;j tronic GmbH

1. Rejestracja za pomocg
konta Google

Kliknij przycisk ,g”
oznaczajacy ,konto Google”.
Do zalogowania sie nalezy
uzy¢ adresu i hasta poczty
Google.

Lub

2. Tworzenie nowego konta w
aplikacji Plug&View
Kliknij opcje ,Create Account”
(Utwoérz konto). Uzupetnij
informacje na nastepnej stronie
i potwierdz dane przyciskiem
LApply” (Zastosuj). Na konto
uzytkownika zostanie wystana
wiadomos¢ e-mail z
instrukcjami dotyczacymi
odblokowania konta. Na stronie
logowania mozna sie
zalogowaé, korzystajac z
danych uzytkownika, a
nastepnie doda¢ kamere.

Na tym etapie pomysinie utworzono konto korzystajac z aplikacji lub

strony internetowe;.

Aby kontynuowa¢ konfiguracje sieci Wi-Fi kamery IP w trybie punktu
dostepu, przejdz do rozdziatu 3 niniejszej instrukgcji obstugi.
Nalezy pamietaé, iz kamera DN-16047 musi by¢ potgczona z

Internetem w trybie punktu dostepu.

Jesli Twoja kamera jest potaczona z routerem za pomocg przewodu
LAN, przejdz do rozdziatu 4 niniejszej instrukcji.

13



3. Potaczenie z kamera IP Plug&View za

posrednictwem sieci Wi-Fi

3.1 Potaczenie za pomocg smartfona/tabletu

Otworz interfejs ustawien sieci Wi-

Fi w smartfonie/tablecie.

Wyszukaj sieci bezprzewodowe
dostepne w bezposrednim
otoczeniu. Kamera zostanie
wys$wietlona jako sie¢
bezprzewodowa, ktérej nazwa
sktada sie z numeru modelu i 6
ostatnich znakéw w adresie MAC
urzgdzenia.

ON-16047-003F00

FAM A3smann

44 449449 9
B
i

cmProqectons_Bode

WLAN ' @

+  PlugandView &= ()

DN-16049-07a405 = (0

Anarfieal a = 1Y

Potacz swoj smartfon/tablet z kamera IP za posrednictwem sieci
Wi-Fi.

Gdy smartfon/tablet zostanie e 2 .20
potagczony z kamerg, mozna { Einstellungen  WLAN
kontynuowac instalacje aplikacji WLAN O
Plug&View. Otwoérz aplikacje J DNCIG0AB-aTak08 =
Plug&View. -
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Aplikacja Plug&View wykryje
podigczong kamere Plug&View
pracujgca w trybie punktu
dostepu. Wyswietlony zostanie
komunikat z prosbg o wybor
sieci Wi-Fi, z ktérg ma zosta¢
potaczona kamera.

Back Wyswietlone zostang sieci dostepne
cr w poblizu . Wybierz sie¢, do ktdrej
bssid signal ssid chcesz podigczy¢ kamere. Jesli
Twoja sie¢ nie zostata wyswietlona,
nalezy zmieni¢ potozenie kamery.

UWAGA: Ukryte identyfikatory SSID, czyli ukryte sieci Wi-Fi,
nie sa obstugiwane przez kamere. Aby potaczy¢ kamere z
ukryta siecig Wi-Fi, zmien ustawienia sieci tak, aby byta ona
widoczna.

15



weeo o2-dar ¥ mas

| e

{ Back Wi-Fi Setting

Cancel

Please re-connect the WiFl of

mobie phone 10 the wireless

your
Foutes o AP before logn 1o BIGITUS Plugtiew

o

Wprowadz hasto, ktérym chroniona
jest sie¢ Wi-Fi, w polu hasta i
potwierdz, klikajac przycisk ,OK”.

Po pomysinym nawigzaniu
potgczenia z siecig uzytkownicy
systemow operacyjnych Android
otrzymajg komunikat z prosbg o
ponowne podtgczenie smartfona/
tabletu do sieci Wi-Fi.

Zazwyczaj odbywa sie to
automatycznie. Jesli tak sie nie
stanie, przejdz do interfejsu
ustawien sieci Wi-Fi w smartfonie/
tablecie i potgcz sie z siecig Wi-Fi.



4. Dodawanie kamery IP Plug&View

4.1 Polaczenie za pomoca smartfonal/tabletu

Aby podczas instalacji pierwszej
kamery Plug&View doda¢ nowg
kamere, naci$nij przycisk ,+”.
Jesli zainstalowano juz inne
kamery, przejdz do ustawien
(stuknij symbol kota zebatego
znajdujacy sie w prawym gérnym
rogu) i stuknij opcje ,Add camera”
(Dodaj kamere), Aby w prosty
sposéb doda¢ kamere, zeskanuj
kod QR za pomoca
smartfona/tabletu lub recznie
wprowadz dane aktywacji.

Kod QR mozna zeskanowac¢ za pomocg nastepujgcych urzadzen:
iPhone® firmy Apple, iPad® firmy Apple, smartfon z systemem
operacyjnym Android, tablet z systemem operacyjnym Android

(z wbudowang kamera tylng).

Adres MAC, kod aktywacyjny i kod QR mozna znalez¢ na ostatniej
stronie niniejszej instrukciji.

Uwaga: System operacyjny Android zainstalowany w urzgdzeniu
mobilnym powinien by¢ w wersji 2.3.5 lub nowsze;j.
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Dodawanie kamery poprzez zeskanowanie kodu QR

[ Scan OR Code ] Na nastepnej stronie wybierz opcje

,Scan QR code” (Skanuj kod QR).
Funkcja skanowania kodu QR w
urzgdzeniu mobilnym zostanie
aktywowana.

Aby doda¢ kamere do konta, zeskanuj kod QR znajdujgcy sie na
ostatniej stronie niniejszej instrukcji.

Podczas skanowania kodu QR nalezy przesuwac¢ urzadzenie
mobilne do przodu lub do tytu, dopdki nie wykryje ono kodu.

Dodawanie kamery poprzez reczne wprowadzenie
adresu MAC i kodu aktywacyjnego

Adres MAC i kod aktywacyjny znajdujg sie na ostatniej stronie
niniejszej instrukcji. Po wybraniu opcji ,Add camera” (Dodaj
kamere) w aplikacji Plug&View przejdz do interfejsu ,Manual input”
(Wprowadzenie reczne).

Wprowadz kombinacje znakéw alfanumerycznych zamieszczong
pod nazwa ,MAC”. Nastepnie wpisz kod aktywacyjny i kliknij opcje
LApply” (Zastosuj).
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4.2 Dodawanie kamery do komputera za pomocg
przegladarki

Uzytkownicy komputeréw/laptopéw mogg takze dodac¢ kamery do
swoich kont w podobny sposadb, jak opisuje to procedura
dodawania kamery za pomocg urzgdzenia mobilnego
przedstawiona w rozdziale 4.1

Po naci$nieciu przycisku ,Login” (Zaloguj) na stronie internetowe;j
http://www.plug-view.com i wprowadzeniu nazwy uzytkownika i
hasta, uzytkownik zostanie zalogowany do interfejsu zarzadzania
kamerg. Na ekranie wyswietli si¢ ekran pobierania wtyczki. Nacisnij
przycisk ,Download” (Pobierz) i postepuj zgodnie z wyswietlanymi
instrukcjami, aby zainstalowa¢ wtyczke.

Please download the new version of "Plug&View
plugin” for camera liveview:

If you have already downloaded before, check the
following:

« Enable P2P Viewer in Chrome extension
Open Menu > Settings > Extensions > P2P Viewer

« If you have ever deleted the plugin before, please download
the Plug&View plugin

« If P2P Viewer does not exist in the Chrome extension list,
please download P2P Viewer

« Chrome installation tutorial

19



Po zainstalowaniu wtyczki
otworz strone
http://www.plug-view.com i
ponownie zalogu;j sie,
podajac dane dostepu do
I (=] konta.

Nacisnij symbol ,+”, aby
Please complete registration in 60 minutes dodac kamere.
after boot up your camera, or you need to
re-power the camera and complete
registration process again.

Nastepnie nacisnij symbol
,>", aby przejs¢ do
nastepnej strony i postepuj
zgodnie z instrukcjami.

Woprowadz adres MAC i kod aktywacyjny znajdujgce sie na ostatniej
stronie instrukgcji obstugi i kliknij przycisk ,Apply” (Zastosuj), aby
dodac kamere.

Add Camera

MAC Address

Activate Code
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Po pomysinym dodaniu kamery do konta nalezy sprawdzic, czy
wys$wietla sie obraz podgladu na zywo z kamery.

Plugiiew s - - e

Jesli chcesz nadal korzystaé¢ z kamery Plug&View potaczonej z
Internetem za pomoca przewodu sieciowego, konfiguracja
zostaje zakonczona w tym momencie.

Jesli jednak chcesz ustanowi¢ bezprzewodowe potgczenie z siecig
Wi-Fi w celu dowolnego umiejscowienia kamery, kontynuuj czytanie.
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5. Konfiguracja sieci Wi-Fi za pomoca

komputera/laptopa

Konfiguracja bezprzewodowego potaczenia (sieci Wi-Fi) pomiedzy
kamerg IP a routerem Wi-Fi/punktem dostepu moze zosta¢ wykonana
za pomocg komputera/laptopa i przegladarki internetowe;.

Po pomysinym zainstalowaniu kamery, nalezy zalogowac sie na
stronie ,http://www.plug-view.com”. Kliknij przycisk ,Login | My
camera administration” (Zaloguj | Zarzadzanie kamera).

Wprowadz dane swojego konta Plug&View lub zaloguj sie za
pomoca konta Google. Jesli nie jestes zalogowany na swoim koncie
Google, zostaniesz automatycznie przekierowany na strone
logowania Google.

Po wprowadzeniu danych do logowania wyswietli si¢ obraz
podgladu na zywo z kamery.

Po prawej stronie obrazu z kamery 0

wyswietli sie kilka ikon. Kliknij x

przycisk ,Camera Configuration”

(Konfiguracja kamery), aby przejs¢

do interfejsu uzytkownika kamery. ©
)

figuration
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Otworzy sie nowe okno bedace sieciowym interfejsem uzytkownika
kamery. Zaloguj sie do domysInego konta kamery wprowadzajac
nazwe uzytkownika ,,admin” oraz hasto ,,admin”. Jesli wybrano
opcje ,Autologin” (Zaloguj automatycznie), przy kolejnym otwarciu
menu konfiguracji nastgpi automatyczne zalogowanie uzytkownika.
Kliknij przycisk ,Login” (Zaloguj).

D[G]TUSO DIGITUS® PLUG&VIEW

safe&secure - anywhere. anytime.

R —
Lenguage:
Stream

W interfejsie uzytkownika kamery kliknij zakladke ,Wi-Fi”, aby
skonfigurowac sie¢ Wi-Fi.

safe&secure - anywhere. anytime.

Home Replay Parameters System Wireless

Pojawi sie okienko wyszukiwania, w ktérym wyswietlone zostang
dostepne sieci bezprzewodowe znajdujace sige w poblizu. Wybierz
identyfikator (SSID) sieci i potwierdz za pomocg przycisku ,OK”.

ssiD Signal  Authentifzierungsmodus
) TestPMM 8% -PSK-TKIF)[WPAZ-PSK-CCMP)[WPS)[ESS]
- TestPM)

O Piugandview 88% [WPA-PSK-TKIPJ[ESS]

Sam masma A mALs e e A
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W nastepnym oknie wprowadz klucz sieci Wi-Fi i potwierdz za

pomoca przycisku ,OK”.

Passwort:

ok

Nalezy sie upewni¢, ze
router dziata jako serwer
DHCP. Jest to ustawienie
fabryczne prawie
wszystkich routeréw.
Nastepnie nawigzane
zostanie potgczenie z
bezprzewodowsg siecig
LAN. Jesli potaczenie
zostato nawigzane
pomysinie, w oddzielnym
okienku wyswietli sie
odpowiedni komunikat.

Mozesz teraz odiaczy¢ przewod sieciowy od kamery i zamkna¢

okno przegladarki.

Gratulacje. Konfiguracja kamery IP Plug&view zostata wiasnie
zakonczona. Teraz mozna uzyskac¢ dostep do kamery IP w dowolnym
momencie za pomocg smartfona, tabletu lub przegladarki.
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6. Ustawienia detekcji ruchu i nagrywania

System DIGITUS® Plug&View oferuje opcje detekgji ruchu i
nagrywania. Aby skorzystac z tych funkcji, kamera SD w kamerze
musi zosta¢ sformatowana, a funkcja detekcji ruchu musi zosta¢
aktywowana.

Aby sformatowac¢ karte SD, nalezy uzyska¢ dostep do kamery za
pomocg interfejsu sieciowego.

Po prawej stronie obrazu z kamery 0
wyswietli sie kilka ikon. Kliknij -
przycisk ,Camera Configuration”
(Konfiguracja kamery), aby przej$¢
do interfejsu uzytkownika kamery.

Camera Configuration

L»

Otworzy sie nowe okno bedgce sieciowym interfejsem uzytkownika
kamery. Zaloguj sie do domysinego konta kamery wprowadzajac
nazwe uzytkownika ,,admin” oraz hasto ,,admin”. Jesli wybrano
opcje ,Autologin” (Zaloguj automatycznie), przy kolejnym otwarciu
menu konfiguracji nastapi automatyczne zalogowanie uzytkownika.
Kliknij przycisk ,Login” (Zaloguj).

Aby uzyska¢ dostep do informacji o karcie SD za pomocg menu,
kliknij opcje System -> Local storage (Pamigé lokalna). Aby
sformatowac karte SD, wybierz opcje menu ,Format” (Formatuj).

Po sformatowaniu karty mozna aktywowac¢ funkcje detekgcji ruchu.
25



W interfejsie sieciowym wybierz opcje ,Parameters” -> ,Motion
Detect” (Parametry -> Detekcja ruchu).

Home Replay Parameters. System Wireless
Arsa:
Activate B Enasis

Sensibilty | Normal L Select All Clean All

Action:
E-Mail

K Sena E-mail

Output B AamwithSnapshot ¥ SendToEmall ™ Upiced to FTP
%
5

Alarm With Record 4 Upload to FTP
Trigger Alarm Output

Schedule: Week Mode Work Mode @ Alvays

Aby aktywowac¢ funkcje detekcji ruchu, kliknij opcje ,ON”. Kolorowy
obszar na obrazie wideo to obszar wykrywania ruchu, tzn. obszar, w
ktorym ruch aktywuje funkcje wykonywania zdjecia lub nagrywania
wideo. Zgodnie z domysinym, fabrycznym ustawieniem prawie caty
ekran jest pokryty czerwonymi polami. Kliknij kolorowe oznaczenia,
aby wylaczy¢ pewne obszary z detekgcji ruchu. W ten sposéb mozna
usung¢ znacznik z danego obszaru. Aby ustawi¢ czuto$¢ detekc;ji
ruchu, wybierz opcje ,Sensibility” (Czuto$¢). Wybierz jeden z
nastepujgcych czterech pozioméw: ,Very high” (Bardzo wysoka),
,High” (Wysoka), ,Normal” (Normalna) lub ,Low” (Niska).

Aktywuj opcje ,Alarm with recording” (Alarm z nagrywaniem), aby w
razie wykrycia ruchu zarejestrowac to zdarzenie na karcie SD.

Czas nagrywania jest ustawiany za pomocg harmonogramu
nagrywania detekcji ruchu. Mozliwe jest nagrywanie w trybie
tygodniowym, nagrywanie w dni robocze lub w trybie catodobowym.
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Harmonogram mozna dostosowac do indywidualnych potrzeb.
Aby zapisaé¢ konfiguracje, kliknij przycisk ,Apply” (Zastosuj).

Funkcja detekcji ruchu z nagrywaniem zostata pomysinie
skonfigurowana.

Aby uzyska¢ wigcej informacji na temat interfejsu sieciowego
kamery, nalezy zapoznac sie z instrukcjg obstugi kamery
zamieszczong na dotaczonej ptycie CD.

W razie pytan nalezy otworzy¢ zakladke FAQ na stronie
Plug&View (http://www.plug-view.com/) lub skorzysta¢ z
infolinii (http://www.plug-view.com/support-de/support/).

Znaki towarowe

DIGITUS to zarejestrowany znak towarowy firmy ASSMANN
Electronic GmbH.

Apple, Apple App Store to zarejestrowane znaki towarowe firmy
Apple Inc.

Android, Google, Google Play to zarejestrowane znaki towarowe
firmy Google Inc.

AVM Fritz!Box to zarejestrowany znak towarowy firmy AVM
Computersysteme Vertriebs GMBH.

Telekom Speedport to zarejestrowany znak towarowy firmy Deutsche
Telekom AG.

Uwaga:

Wszystkie inne, niewymienione znaki towarowe sg witasnoscig ich
poszczegodlnych wiascicieli.

Znaki lub nazwy towarowe wymienione w niniejszej instrukcji sg
stosowane do opisu wykonywanych dziatan i nie sugeruje sie, iz sg
one ogolnodostepne. Niezaleznie od okolicznosci znaki towarowe
sg wtasnoscig poszczegoélnych posiadaczy praw.
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DIGITUS"

DIGITUS® Plug&View
IP kameralari

Hizli Kurulum Kilavuzu



Giivenlik onlemleri

Plug&View IP kamerasini, sadece bu kamera igin belirtilen
sicaklik araliginda kullanin.

Kullanmadiginiz zamanlarda Griint temiz ve kuru bir yerde
0°C ile 40°C arasindaki sicakliklarda saklayin

Kameranin uzerini értmeyin.

Kameranin sivilarla temas etmesine izin vermeyin (IP66 koruma
kapagina sahip dig mekan kameralari harig).

Plug&View IP kameralari, bir yetiskinin gézetiminin yerini alamaz.
Cocugunuzun, aile bireylerinizin veya evcil hayvanlarinizin
saghgini onlari dizenli araliklarda kontrol ederek koruyun

ic mekan IP kameralarinin sadece i¢ mekanda kullanilmasini
saglayin. Bu kameralar, dis mekanda kullaniimak tzere
tasarlanmamistir, zarar goérebilirler. Bu durumda belirtilen dig
mekan modellerini kullanin.

Plug&View IP kameralarini, kolay ulasilabilir bir elektrik prizine
yakin sekilde monte edin. Elektrik kablosunun, gergin veya baski
altinda olmamasini saglayin

Plug&View IP kameralari, Wi-Fi yonlendiricinizin menzili icerisine
konumlandirin ve kamera ile ydnlendirici arasinda, Wi-Fi sinyalini
engelleyebilecek engellerin bulunmamasini saglayin.



Plug&View IP kameralari, parazit Greten elektrikli ve diger HF
cihazlardan (mikrodalga firinlar, cep telefonlari vb.) koruyun

Kamera, ag kablosu ve elektrik kablosu tehlikeli olabilecegi icin
bunlari gocuklardan uzak tutun.

Sadece Uriinle birlikte verilen gli¢ adaptoriinii kullanin.

Plug&View IP kameralari kesinlikle kendiniz onarmaya
galismayin. Onarim ve bakim isleri uzmanlar tarafindan
gerceklestiriimelidir.

Sorun yasamaniz durumunda musteri hizmetlerimizle iletisime
gegcin.

Kamera izlemeye iligkin ylrurlukteki tim kanunlara uyun.
Plug&View IP kameralari, sadece evde 6zel kullanima yonelik
olarak tasarlanmistir. Evinizde yasayan aile Gyelerini,
akrabalarinizi ve yardimcilarinizi video izleme hakkinda
bilgilendirin. Kamuya ait alanlarin ve komsularinizin mulklerinin
g6rinmediginden emin olun.



Kisisel Bilgiler

+ DIGITUS® Plug&View sistemlerine iliskin gizlilik politikasini
http://plug-view.com/privacy-policy-for-platform-apps/ adresinde
okuyarak kabul edin.

*  Yetkili olmayan erisimlerden korumak igin Plug&View hesabiniza
iliskin ylksek glivenlik derecesine sahip bir parola segin.

* Parola, en az 8 karakter uzunlugunda olmalidir; blyuk ve kuguk
harfler ile sayisal karakterler kullanmanizi 6neririz.

* Ayrica kameranin standart parolasi da yetkili olmayan erigimleri
Onlemek igin degistirilmelidir.

Canli akis, anlik bildirim ve daha fazla hizmet, bir bulut
sunucusu lizerinden kullanilabilir. Yedekleme ¢6ziimleri,
sistem kararhligi ve bant genisligi yonetimine ragmen sistemin
kesintisiz kullanilabilirlik garanti edilemez.

Kutunun igindekiler

1 x Plug&View IP kamera Segimli olarak:
1x Kablosuyla birlikte glic kaynagi 1 x Ethernet kablo
1x Hizlh Kurulum Kilavuzu 1x Tavana/Duvara Montaj

1x Yardimci programlari iceren CD  Tertibati
1 x Cikarilabilir anten

* Asagidaki kameralarda ¢ikarilabilir bir aten bulunmaktadir:
DN-16029, DN-16039, DN-16043, DN-16048, DN-16049

Karmasgik ag ayarlari olmadan kolay ve hizli bir sekilde ayarlanabilen
ve kullanilabilen Plug&view IP kamerasini segtiginiz icin tesekkdir
ederiz.



MicroSD Kartin Takilmasi

DIGITUS® i¢ mekan Plug&View kameralarda kayit igin bir microSD
kart bulunabilir.
Kart takma resminin yardimiyla kart takma secgenegini kontrol edin.

DN-16047

SD Kkarti, altin renkli temas
noktalari kameranin lensine
bakacak sekilde gosterildigi
gibi takin.

DN-16046

SD karti, altin renkli temas -0

noktalari kameranin lensine A
B 3

bakacak sekilde gosterildigi @

gibi takin.
\. y |

DN-16029
SD karti, altin renkli temas
noktalar yukarida olacak

sekilde gosterildigi gibi takin. |i !\



Kamera Baglantilar

LAN: =
Kamerayi, yonlendiricinizin . _
LAN baglanti noktasina takin.
Sifirla:

Kamerayi varsayilan ayarlara
sifirlamak igin kamerayi rosD¥er e pr e
baslattiktan sonra Sifirlama

diigmesini 10 saniye sireyle A
basili tutun. .l[li.vlJ .

Gﬁg: |-| ®
Kameraya gii¢ sadlamak igin |- g=
Urdnle birlikte verilen gli¢
kablosunu takin.

M icrOSD: MicroSD kart
Yerel depolama igin bir ee 8 Ty
microSD kart takin. ] m"“ ']

Mikrofon: Mikrofon (Ses Girisi).

Ses cikisi:

3,5 mm ses kablosuyla harici

wps  DC 5V gii¢ kaynag

CEQZ

Sifirla

T T
PR

bir hoparlér baglayin. MieroSD "f" yuvasi
WPS modunu etkinkinlegtirmek T

icin kamera acildiktan sonra e "ttt o
sureyle basili tutun.

(*DN-16029 ve DN-16046,

Alarm: [ ] ._,_,..I ®
Pin2: Topraklama

Pin3: Kullaniimiyor R

WPS:
WPS dugmesini 8 saniye WRMAC:
MAC:
9))
WPS digmesine sahiptir) g
Pin1: Alarm girisi Sifria
Pin4: HAYIR



Kamera Baglantilar

DIGITUS® dis mekan Plug&View kameralarda ézel bir kablo
bulunmaktadir.
Kart takma resminin yardimiyla kart takma segenegini kontrol edin.

. Sifirlama tusu:

Kamera baglandiktan ve
kullanima hazir olduktan
sonra bu digmeyi

10 saniye stireyle basili
tutun. Bu iglem, kamerayi
varsayilan ayarlara sifirlar.

* Ag kablosu:
internet baglantisi kurmak
icin ag kablosunu agdaki
yonlendiricinize takin.

. DC 12V gii¢ kaynagi:
Kameraya gli¢ saglamak
icin harici glic adaptoriinu
takin.

. LED durum gostergesi:
Mavi LED durum
gostergesi, kameraya glic
saglanip saglanmadigini
gosterir.

DN-16039, DN-16043 ve DN-16048 modelleri igin gui¢, dogrudan
kameraya ag kablosu UGzerinden PoE enjektorii veya PoE anahtari
ile baglantili olarak saglanabilir.



Lens Ayarlari

DN-16039
DN-16043

Odaklanma ayarlama (ag1)
Manuel kontroller ile L
odaklanma ve Keskinlik ayarlama
keskinligi

ayarlayabilirsiniz.
Odaklanma ve
keskinligi istediginiz
sekilde ayarlamak
icin kameranin canli
gOruntusinu
kullanin.



IP kameranizi kullanabilmeniz igin dnce bazi hazirliklarin yapilmasi
gerekir.

Anteni takin
Kablosuz anteni konektore takin ve montaj civatalarini sikin.

SD karti takin

Plug&View IP kameralari 32 GB depolama kapasitesine kadar
mikro SD kartlari destekler, bu kartlari saticinizdan satin
alabilirsiniz. IP kameranizla gekilen fotograflar veya videolar daha
sonra bu karta kaydedilecektir.

Kameranizin bir dis baglanti noktasi varsa ve mevcut dahili bellegi
yoksa, MicroSD kartinizi yerine tam oturuncaya kadar ilgili dilime
takin.

Gli¢c kaynagini takin

Gig kaynaginin kablosunu kameranin “Gii¢" baglantisina takin.

Kamerayi yénlendiriciye (6r. AVM Fritz! Box,
Telekom Speedport vb.)* baglayin

Uriinle birlikte verilen ag kablosunun bir ucunu kameranin LAN
baglanti noktasina takin. Ag kablosunun diger ucunu
yonlendiricinizin arkasinda "LAN" seklinde isaretlenmis
konektérlerin birine takin. Bazi ydnlendiricilerde sadece bir LAN
baglantisi bulunurken bazilarinda birkag baglanti bulunur.
Yonlendiricinizde ¢alisir durumda bir internet baglantisi olmalidir.

* Bu noktayil kameralarin erisim noktalariyla atlayabilirsiniz.
DN-16047 igin bu nokta atlanmalidir.



2. Plug&View Kullanici Hesabini Ayarlama

Plug&View kameranizi kullanmak ve istediginiz zaman istediginiz
yerden canl bir video goérintusiine sahip olmak icin kameranizi bir
Plug&View kullanici hesabina kaydetmeniz gereklidir. Kurulum ve
kontrol, akilli telefonunuzdan/tabletinizden ve ayni zamanda bir
kisisel bilgisayardan/dizustu bilgisayardan yapilabilir.

2.1 Akilh Telefonunuzla veya tabletinizle bir
kullanici hesabi olusturun

Bir Apple® iOS cihaziniz varsa bu durumda "DIGITUS® Plug&View"
Uygulamamizi Apple App Store®da bulabilirsiniz. Google Android
iOS kullanan akilli telefonlarda ve tabletlerde Google™ Play
Magazasinda "DIGITUS® Plug&View" uygulamamizi bulabilirsiniz.

ilgili App Stores™un arama alanina "Digitus" veya "DIGITUS
Plug&View" yazin.

Apple App Store® Google™ Play

[« oo Wl




Arama sonuglarinda "DIGITUS® Plug&View"

r°\
u Uygulamasi bu simgeyle isaretlenecektir.

Daha sonra uygulamayi mobil cihaziniza kurun.

Uygulamay tabletinizde veya akilli telefonunuzda baslatin.
Hesabinizi olusturmak igin 2 segcenege sahipsiniz:

1. Daha 6nceden bir Google hesabiniz varsa, plug&View
uygulamanizi kullanmak igin Google hesabinizi kullanabilirsiniz
veya

2. Ayri bir kullanici adi ve parolayla dogrudan yeni bir Plug&View
hesabini olusturun.

»e 11:00 sms 1, Google hesabinizla
oturum agma

"Google hesab1"
oturumunu agmak igin
"g"ye tiklayin. Daha sonra
oturum agmak igin
Google posta adresinizi
ve parolanizi
kullanabilirsiniz.

Veya

2. Plug&View ile yeni
hesap olusturma

“Create Account" 6gesine
e tiklatin.



F 11:02 o .

® .
Terms of Use Agreement DIGITUS® Plug&View
sistemine iligkin
Fiir die Nutzung der Plug8View Plattform via Browser oder App ist es g|z||||k politikas| ni
erlorderlwdw die Datmsch utzerklarung. die Sie unter http:/plug .
ew.com/privacy-polic Slatform-apps/ nachlesen kénnen, zu kabul edin.
aKzepnereﬂ
Eridérung:
Ich habe die Datenschutzeridérung der Assmann Electronic GmbH zur
Kenntnis genommen und willige in die Datenvereinbarung gemas der . .
Daienschu!zekauung &in. Ich kann meine Einwiligung jederzeit unter BII’ Sonrakl Sayfada
digitus.info wiedernufen,
er weisen jedoch darauf hin, dass die Plug&View App dann nieht mehr kullanici adini, parola
e segin ve e-posta
To use the Plug&View platiorm via the browser or app, it is necessary adresinizi dog ru|ay| n.
that you agree to the privacy
policy, which you can find at http://plug T y-for
platform-apps/ Privacy policy:

I have acknowledged the privacy policy of Assmann Electronic GmbH,
and hereby consent to the dala agreement according to the privacy
pollcy I may ravoke my consent at any time by centacting

Jigitus.info,

However, we must point out that in the event consent is revoked, the

Daha sonra Plug&View hesabinizi olusturmak igin "Apply" 6gesine
dokunun. Ardindan hesabinizi nasil etkinlestireceginiz hakkinda
talimatlar igeren bir e-posta alacaksiniz. Daha sonra "Login"
béliminden kullanici adinizi ve parolanizi kullanarak uygulamada
oturum agin. Simdi kameranizi hesaba ekleyebilirsiniz (6ge 3 ile
devam edin).

2.2 Kisisel bilgisayarinizla kullanici hesabi
olusturma

Uygulama desteginin yani sira, DIGITUS Plug&View sistemi de
tarayici erisimi vasitasiyla kisisel bilgisayari/dizusti bilgisayari
destekler.

Lutfen web adresini ziyaret edin http://plug-view.com
Ardindan Plug&View Web Portalina girmek igin "Login"e tiklayin.



Create Account

1. Google hesabinizla oturum
acma
"Google Oturum Agma" igin
"g"ye tiklayin. Ardindan
oturum agmak igin mevcut
Google Mail adresinizi ve
parolanizi kullanabilirsiniz.

Veya

2. Plug&View ile yeni hesap
olusturma

“Create Account" 6gesine
tiklatin. Latfen bir sonraki
sayfada bulunan bilgileri
tamamlayin ve "Apply" tusuna
tiklayarak girdilerinizi onaylayin.
Bir sonraki adim olarak
hesabinizi nasil aktif hale
getireceginizi belirten talimatlari
iceren bir e-posta alacaksiniz.
Oturum agma sayfasinda
kullanici bilgilerinizle oturum
acabilir ve kameranizi
ekleyebilirsiniz.

Bu noktada Uygulama veya Web portaliyla bir hesabi basaril

sekilde olusturdunuz.

Erisim NoktasI modu vasitasiyla IP kamerasinin WiFi ayarina

devam etmek igin litfen bu kilavuzdaki Kisim 3 ile devam edin.

Lutfen DN-16047 igin kameranin Erisim Noktasi modu vasitasiyla

internete baglanmasinin zorunluluk oldugunu unutmayin.

Kameraniz yonlendiricinize LAN kablosuyla bagliysa bu kilavuzun

Kisim 4'Une atlayin.
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3. Plug&View IP Kameranin Wi-Fi Uzerinden

Baglanmasi

3.1 Akill telefon/tablet ile

Akill telefonunuzdaki/tabletinizdeki
Wi-Fi ayarlarini agin.

Yakin gevredeki kullanilabilir

- w P
kablosuz aglari arayin. Kamera,
model numarasi ve MAC adresinin v
. . o L ey
son 6 karakteri ile kablosuz bir ag
v e g . L .
olarak géruntulenir. - )
W ON16047-005F09
- FRAM Azsmann
WLAN O -
~  PlugandView am (@
NETZWERK WAHLEN
DN-16049-07a405 = @
Annrbeai a = M

Akilli telefonunuzu veya tabletinizi IP kameraya WLAN baglantisi
Uzerinden baglayin.

Akilli telefon/tablet kameraya ShiE e it
baglandiktan sonra Plug&View QEEzinrn Tl
uygulamasini yiklemeye devam WLAN (/
edebilirsiniz. Plug&View
uygulamasini agin.

~ DN-16049-07a405 = (1)



Plug&View uygulamasi, erisim
noktasi modunda kullanilan bir
Plug&View kameraya olan
baglantiyi algilar ve kameranin
bagdlanacagdi Wi-Fi agini
segmenizi ister.

Back Yakin cevredeki kullanilabilir aglar
cr gosterilir. Litfen burada kameranin
bssid signal ssid baglanacagi agi secin. Aginiz
goruntulenmezse kameranin
yeniden konumlandiriimasi
gerekebilir.

UYARI: Gizli WLAN aglar anlamina gelen gizli SSID'ler kamera
tarafindan desteklenmez. Kameranizi bunlardan birine
baglamak istiyorsaniz aginizin goriiniir olmasini saglayin.

15



weeo o2-dar ¥ mas | e

il PREE WLAN aginizin ag sifresini sifre

alanina girin ve OK ile onaylayin.

Cancel

Android igletim sistemlerinde
baglantinin basarili olmasinin
ardindan Akilli Telefonunuzu/
Tabletinizi Wi-Fi aginiza tekrar
baglamaniz istenir.

Genellikle bu otomatik sekilde

o e o s S Pt s gerceklesir. Gergeklesmezse lutfen
= Akilli Telefonunuzun/Tabletinizin

Wi-Fi ayarlarina girin ve Wi-Fi

aginiza orada baglanin.




4. Plug&view IP kamerasini ekleme

4.1 Akill telefon/tablet ile

ilk Plug&View kamera kurulumu
esnasinda yeni bir kamera
eklemek icin "+"ya basin.
Ayarlara gidin (sag Ustte bulunan
disli simgesi) ve kameralar
mevcutsa "Add camera" 6Jesine
dokunun. Bu iglem, akill
telefonunuz veya tabletinizi
kullanarak QR kodunun
taranmasiyla veya etkinlestirme
verilerinin manuel olarak
girilmesiyle kolayca yapilabilir.

Asagidaki cihazlar QR kodunu taramak igin uygundur: Apple iPhone®,
Apple iPad®, Android akilli telefonu, Android tablet (arkasinda entegre
kamera bulunan).

MAC adresini, etkinlestirme kodunu ve QR kodunu bu kilavuzun
son sayfasinda bulabilirsiniz.

Not:  Mobil cihazin Android strimi en az 2.3.5 veya Uzeri
olmalidir.
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QR kodunu tarayarak kamerayi ekleme

[' S OR GO0 ] Sonraki sayfada "Scan QR code"
segenegini segin.

Mobil cihazin QR kodu tarama

fonksiyonu etkinlesir.

Kameray! hesabiniza eklemek icin litfen bu kilavuzun son sayfasinda
bulunan QR kodunu taratin.

QR kodunun taranmasi esnasinda kod, tanimlanana kadar mobil
cihazinizi ileriye ve geriye dogru hareket ettirmelisiniz.

MAC adresini ve etkinlestirme kodunu maniiel
olarak girerek kamerayi ekleme

MAC adresi ve etkinlestirme kodu bu kilavuzun son sayfasinda
bulunmaktadir. Plug&View uygulamasinda "Add camera"yi
sectikten sonra "Manual input" segenegine gidin.

"MAC" altinda bulacaginiz harf ve say kombinasyonunu girin. Daha
sonra etkinlestirme kodunu girin ve "Apply" tusuna tiklayin.

18



4.2 Kamerayi internet tarayicisi lizerinden kisisel
bilgisayara ekleme

Kisisel bilgisayar/Diziisti bilgisayar kullanicilari igin 4.1'de gorildugu
gibi mobil cihazla ayni igslem olan hesabiniza kameralarda
ekleyebilirsiniz.

Hesabiniz ve parolanizla "Oturum Agmak" igin
http://www.plug-view.com lizerinden kamera yénetimi sayfaniza ilk
kez girdikten sonra eklentiyi yiklemek icin "Download" sayfasi sizi
bilgilendirecek.

Please download the new version of "Plug&View
plugin” for camera liveview:

If you have already downloaded before, check the
following:

« Enable P2P Viewer in Chrome extension
Open Menu > Seltings > Extensions > P2P Viewer

« If you have ever deleted the plugin before, please download
the Plug&View plugin

« If P2P Viewer does not exist in the Chrome extension list,
please download P2P Viewer

« Chrome installation tutorial

19



Eklentinin yUklenmesinin

ardindan lutfen hesabinizla
http://www.plug-view.com
adresinde oturum agma
sayfasina tekrar girin.

Kamera eklemek igin litfen
"+" isaretine basin.

Please complete registration in 60 minutes
after boot up your camera, or you need to Sonraki Sayfaya giderek
re-power the camera and complete adimlari takip etmek igin
registration process again. . .
ardindan ">" isaretine basin.

Ardindan kullanma kilavuzunun son sayfasinda goriindigu gibi
lutfen MAC adresini ve Etkinlestirme kodunu ve kamerayi eklemek
icin "Apply" digmesine basin.

Add Camera

MAC Address

Activate Code

20



Kamerayi hesabiniza basariyla ekledikten sonra liitfen kameranizin
canli gorintuyl gosterip gostermedigini kontrol edin.

Plugiiew s

Plug&View kameranizi bir ag kablosuyla kullanmaya devam
etmeyi planliyorsaniz, kurulum burada tamamlanir.

Ancak konum esnekligi icin Wi-Fi'ye sahip kablosuz baglantiyi
kullanmay! planhyorsaniz litfen okumaya devam edin.
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5. Kisisel Bilgisayarda/Diziistu Bilgisayarda

Wi-Fi'nin kurulmasi

IP kamerayla Wi-Fi yonlendirici/Erisim Noktasi arasinda kablosuz
(Wi-Fi) baglantinin kurulmasi da tarayici tzerinden kisisel
bilgisayarda/dizUsti bilgisayarda yapilabilir

Kameranizin basarili bir sekilde kurulmasindan sonra
http://www.plug-view.com web sitesinde oturum agin. “Login | My
camera administration" 6gesine tiklayin.

Plug&View hesabinizi kullanin veya Google Oturum Agmayi segin.
Google hesabinizda oturum agmamigsaniz otomatik olarak Google
oturum agma sayfasina yénlendirileceksiniz.

Oturum agma bilgilerinizi girdikten sonra kamera canli goriintiisiind
gorebilirsiniz.

Kamera goruntisinin sag tarafinda I

bazi simgeler géreceksiniz. 4

Kameranin kullanici araytiziine

yonlendirilmek igin "Camera

Configuration" dugmesine tiklayin. ©
v

figuration
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Ardindan kameranin Web Kullanici arayuizi olan baska bir pencere
acihr. Litfen varsayilan "kamera" oturum agma hesabiyla oturum
acin, "admin" ve parola "admin" . “Autologin” segenegini
segerseniz konfiglirasyon menusiine bir sonraki girisinize otomatik
olarak oturumunuz agilacaktir. “Login" 6gesini tiklatin.

DIGITUS® PLUG&VIEW

safe&secure - anywhere. anytime.

S —
Language:
Stream

Kameranin araylzinde Wi-Fi ayarlarini gergeklestirmek igin Wi-Fi'yi
tiklatin.

D lGlTUS safeasecure - anywhere. aﬂvﬂmé-

Home Replay Parameters System Wireless

Ortaminizdaki kullanilabilir kablosuz aglarin gériintiilenecegi bir
arama penceresi agllacaktir. Litfen aginizin tanimlayicisini (SSID)
secin ve "OK" ile dogrulayin.

ssID Signal  Authentifzierungsmodus
O Testrrm 85% [WPA-FSK-TKIF)WRAZ-FSK-COMP)IWPS]ESS)
O PhugandView 85% [WPA-PSK-TKIF)[ESS]

—ams masme s AL s S
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Sonraki pencerede Wi-Fi anahtarini girerek "OK" diigmesiyle
onaylayin.

Yonlendiricinizin bir
DHCP sunucusu gibi

ok calistigindan emin olun.
Bu, hemen tim
yonlendiricilerde fabrika
ayaridir.

Daha sonra kablosuz
LAN ile baglanti kurulur.
Baglanti basarili bir
sekilde kurulursa bu ayri
bir pencerede
gOruntilenecektir.

Passwort:

Simdi ag kablosunu kameradan cgikarabilir ve tarayici penceresini
kapatabilirsiniz.

Tebrikler. Az 6nce Plug&view IP kamerasi kurulumunu tamamladiniz.

Simdi IP kameraniza istediginiz zaman akilli telefonunuzdan,
tabletinizden veya bir web tarayicisindan erigebilirsiniz.
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6. Hareket Algilamayi ve Kaydi ayarlama

DIGITUS® Plug&View sistemi, hareket algilama ve kaydetme
segeneklerini sunar. Bu fonksiyonu kullanmak igin SD kartin
kamerada bicimlendiriimesi ve hareket algilamanin da etkinlestirimesi
gerekir.

SD karti bigimlendirmek i¢in web portali Gzerinden kameraya ulagin.

Kamera goruntisunin sag tarafinda 0
bazi simgeler géreceksiniz. =
Kameranin kullanici arayliziine
yonlendirilmek igin "Camera
Configuration" dugmesine tiklayin.

®

| Camera Configuration

Ardindan kameranin Web Kullanici araylizu olan baska bir pencere
acihr. Litfen varsayilan "kamera" oturum agma hesabiyla oturum
acin, "admin" ve parola "admin" . “Autologin" segenegini
segerseniz konfigiirasyon menusiine bir sonraki girisinize otomatik
olarak oturumunuz agilacaktir. “Login" 6gesini tiklatin.

System -> Local storage'e giderek menu lzerinden SD kart
bilgilerine erisebilirsiniz. SD karti, "Format" menu 6gesi vasitasiyla
bigimlendirin.

Bicimlendirme isleminin ardindan hareket algilama etkinlestirilebilir.
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Lutfen WEB Ul'da "Parameters" -> "Motion Detect" 6gesine gidin.

&Secure - anywhere. anytime.

-

Sensibiity [Nerma v Select All m

Action:
E-Mail

Send E-mail

Output Alarm With Snapshot 1 Send ToEmall ) Upload to FTP

=
I~
B AamwihRecord o upicadto FTP
B4 Trigger Alarm Output

Schedule: Week Mode Work Mode ®  Always

“ON"u tiklatarak hareket algilamay: etkinlestirin. Video goruntusinin
icindeki renkli alan hareket algilama alanidir, yani bu alanda yapilan
bir hareket fotograf cekmeyi ya da video kaydetmeyi tetikler. Orijinal
teslimat halinde tim ekran kirmizi kutularla kaplidir. Bazi alanlari
hareket algilama 6zelliginden hari¢ tutmak icin renkli isaretleri
tiklatin. Bunu yapmakla o alan icin isaretgiyi silersiniz. Hareket
algilama hassasiyetini "Sensibility"de ayarlayabilirsiniz. Asagidaki dort
seviyeden birini segebilirsiniz: “Very high", "High", "Normal" ve "Low".
Hareketin algilanmasi durumunda SD karta kayit igin "Alarm with
recording"i etkinlestirin.

Zaman ayarl, hareket algilama programi ile degistirilebilir. Haftalik,
is Giinii veya Tam Zamanl modlarda kayit yapabilirsiniz.
Programi ayri ayri ayarlayabilirsiniz.

Yapilandirmayi "Apply" digmesiyle kaydedin.

Hareket algilama ile kaydi basarili sekilde ayarladiniz.
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Kameranin web arayiiziine iligkin agiklamalar igin CD lizerinde
sunulan kamera kilavuzuna bakin.

Sorularinizin olmasi durumunda Plug&View sayfamizdaki
(http://www.plug-view.com/) SSS boliimiine gidin veya Yardim
Hattimiza ulasin
(http://www.plug-view.com/support-de/support/).

Ticari Markalar

DIGITUS, ASSMANN Electronic GmbH sirketinin bir tescilli markasidir.
Apple, Apple App Store Apple Inc. sirketinin tescilli markalaridir.
Android, Google, Google play Google Inc. sirketinin tescilli
markalaridir.

AVM Fritz!IBox AVM Computersysteme Vertriebs GMBH sirketinin
bir tescilli markasidir.

Telekom Speedport Deutsche Telekom AG sirketinin bir tescilli
markasidir.

Not:

Burada belirtiimeyen tim diger ticari markalar ilgili sahiplerinin
muilkiyeti altindadir.

Bu kilavuzda bahsi gegen ticari markalar veya ticari isimler galisma
adimlarini agiklamak igin kullaniimistir ve serbestce
kullanilabilecegi anlamina gelmez. Tim durumlarda ilgili hak
sahiplerinin milkiyeti altindadirlar.
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DIGITUS"

DIGITUS® Plug&View
IP-camera’s

Snelle installatiehandleiding



Veiligheidsvoorschriften

* Gebruik de Plug&View IP-camera uitsluitend binnen het
temperatuurbereik gespecificeerd voor deze camera

* Wanneer niet in gebruik, bewaar het product op een schone en
droge plek bij temperaturen tussen 0 °C en 40 °C

¢ Gelieve de camera niet af te dekken

Laat de camera niet in contact komen met vloeistoffen (met
uitzondering van buitencamera’s met beschermende
IP66-behuizing)

Plug&View IP-camera’s zijn geen vervanging voor toezicht door
volwassenen. Let op de gezondheid van uw kinderen,
familieleden of huisdieren door op hen te letten

Zorg ervoor dat IP-binnencamera’s uitsluitend binnenshuis worden
gebruikt. Deze camera’s zijn niet bestemd voor buitengebruik en
kunnen daardoor beschadiging oplopen. Gebruik in dit geval de
gespecificeerde buitenmodellen

Installeer de Plug&View IP-camera’s zo dicht mogelijk bij een
eenvoudig toegankelijk stopcontact. Zorg ervoor dat de
voedingskabel niet te strak zit of uitgerekt is

Plaats de Plug&View IP-camera’s binnen het bereik van uw
wifirouter en zorg ervoor dat er geen obstakels aanwezig zijn
tussen de camera en de router waardoor het wifisignaal kan
worden gehinderd



Bescherm de Plug&View IP-camera’s tegen elektrische apparaten
of andere HF-apparaten die interferentie genereren (magnetrons,
mobiele telefoons enz.)

Houd de camera, netwerkkabel en voedingskabel buiten het bereik
van kinderen, omdat deze onderdelen gevaarlijk kunnen zijn

Gebruik uitsluitend de meegeleverde voedingsadapter.

Probeer de Plug&View IP-camera’s nooit zelf te repareren.
Reparaties en onderhoudswerkzaamheden moeten worden
uitgevoerd door gespecialiseerd personeel.

Neem in geval van problemen contact op met onze klantendienst.

Neem alle toepasbare wetten in acht m.b.t. camerabewaking. De
Plug&View IP-camera’s zijn bestemd voor privégebruik thuis.
Informeer uw gezins-, familieleden en thuiswerkers in uw
huishouden over de videobewaking. Zorg ervoor dat openbare
plaatsen en bezittingen van uw buren niet te zien zijn.



Persoonlijke informatie @

* Lees en accepteer het privacybeleid voor het gebruik van de
DIGITUS® Plug&View-systemen onder
http://plug-view.com/privacy-policy-for-platform-apps/.

* Kies een wachtwoord met een hoog beveiligingsniveau voor uw
Plug&View-account om ongeoorloofde toegang te voorkomen.

* Het wachtwoord dient minstens 8 tekens te bevatten; wij raden
u aan hoofdlettergevoelige letters en alfanumerieke tekens te
gebruiken.

* Het standaardwachtwoord van de camera moet worden
gewijzigd om ook hier ongeaoorloofde toegang te voorkomen.

Livestream, pushberichten en andere diensten zijn beschikbaar
via een cloudserver. Ondanks back-upoplossingen, kunnen
systeemstabiliteit en bandbreedtebeheer de onafgebroken
beschikbaarheid van het systeem niet garanderen.

Leveringsomvang

1 x Plug & View IP-camera Optioneel:

1 x voedingskabel 1 x ethernetkabel

1 x snelle installatiehandleiding 1 x plafond-/muurmontage
1 x CD met hulpprogramma's 1 x afneembare antenne*

* De volgende camera’s zijn voorzien van een afneembare antenne:
DN-16029, DN-16039, DN-16043, DN-16048, DN-16049

Hartelijk bedankt voor het aanschaffen van deze Plug&View IP-
camera, een systeem dat snel en eenvoudig zonder ingewikkelde
netwerkinstellingen kan worden geinstalleerd.



MicroSD-kaart installeren

DIGITUS® Plug&View-binnencamera’s kunnen worden gebruikt met
een MicroSD-kaart voor opnames.

Controleer de installatiemogelijkheid aan de hand van de installatie-
afbeelding.

DN-16047

Installeer de SD-kaart volgens
de afbeelding, met de
vergulde contacten in de
richting van de cameralens.

DN-16046

Installeer de SD-kaart volgens o
de afbeelding, met de o
vergulde contacten in de o 2
richting van de cameralens. ot L
DN-16029

Installeer de SD-kaart volgens
de afbeelding, met de

vergulde contacten omhoog. |i !\



Camera-aansluitingen

LAN:

Sluit de camera aan op de
LAN-poort van uw router.
Terugstelling:

Houd de resettoets met
ingeschakelde camera

10 seconden ingedrukt om de
camera terug te stellen op de
standaardfabrieksinstellingen.
Stroomaansluiting:

Sluit de meegeleverde
voedingskabel aan om de
camera van stroom te voorzien.
MicroSD:

Steek hier een MicroSD-kaart

in voor lokale geheugenopslag.

Mic: Microfoon (Audio In).
Audio-uitgang:
Sluit een externe luidspreker

aan via een 3,5mm audiokabel.

WPS:

Houd de WPS-knop met
ingeschakelde camera
gedurende 8 seconden
ingedrukt om de WPS-modus
te activeren.

(*DN-16029 en DN-16046
hebben een WPS-knop)
Alarm:

Pin1: Alarmingang

Pin2: Aarding

Pin3: Niet in gebruik

Pin4: NEE

s .
==
i
T—T
Netwerkpoort
Audio-uitgang
3 wm
I .'lj ®
- s
| l =
DC5V
WPS  voedingsspanning
=
CEQ =
MicroSD-
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ees B kaartsleuf
* o ©
Terugstelling
MicroSD-kaartsleuf
enstoa, \
e - tea, °®
WiFi MAC:
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.
.
.
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.
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Siriile
*seans®

Terugstelling

DC 5V voedingsspanning



Camera-aansluitingen

DIGITUS® Plug&View-buitencamera’s zijn voorzien van een speciale
kabel.

Controleer de installatiemogelijkheid aan de hand van de installatie-
afbeelding.

. Terugsteltoets:
Houd deze toets met
ingeschakelde camera
gedurende 10 seconden
ingedrukt. Hierdoor wordt de
camera teruggesteld op de
standaardfabrieksinstellingen.

. Netwerkkabel:
Sluit de netwerkkabel aan
op uw router op het netwerk
om de internetverbinding tot
stand te brengen.

. DC12V
stroomaansluiting:
Sluit de externe
voedingsadapter aan om de
camera van stroom te
voorzien.

. Ledstatusindicator:
De blauwe
ledstatusindicator geeft aan
dat de camera van stroom
wordt voorzien.

Voor DN-16039, DN-16043 en DN-16048, kan de stroom direct aan
de camera worden geleverd via de netwerkkabel verbonden met
een PoE-injector of PoE-switch.



Lensinstellingen

DN-16039
DN-16043

Focus (hoek) instellen
U kunt hier de focus L
en scherpte Scherpte instellen
handmatig

aanpassen. Gebruik DL
het live camerabeeld
om de focus en
scherpte naar wens
aan te passen.



1. Voorbereiding

Er moeten enkele voorbereidingen worden getroffen voordat u uw
IP-camera kunt gebruiken.

Antenne aansluiten

Steek de draadloze antenne in de ingang en draai de
bevestigingsbouten vast.

De SD-kaart aansluiten

De Plug&View IP-camera’s ondersteunen MicroSD-kaarten met
maximaal 32 GB geheugencapaciteit die u kunt kopen bij uw
distributeurs. De foto’s en video’s opgenomen met uw IP-camera
worden vervolgens op deze kaart opgeslagen.

Als uw camera een externe poort heeft en niet is voorzien van een
bestaand intern geheugen, steek dan uw MicroSD-kaart in de
corresponderende sleuf totdat ze stevig vast klikt.

Voeding aansluiten

Steek de kabel van de meegeleverde voeding in de voedingsingang
van de camera.

Sluit de camera aan op de router (bv. AVM Fritz!
Box, Telekom Speedport etc.)*

Sluit het ene einde van de meegeleverde netwerkkabel aan op de
LAN-poort van de camera. Sluit het andere einde van de
netwerkkabel aan op een van de ingangen gemarkeerd als ‘LAN’ op
de achterzijde van uw router. Sommige routers hebben slechts één
LAN-ingang, andere hebben meerdere aansluitingen. Uw router
moet een werkende internetverbinding hebben.

* U kunt dit punt overslaan met de toegangspuntmodus van de
camera’s. Voor de DN-16047 moet dit punt worden overgeslagen.



2. Het Plug&View-gebruikersaccount

instellen

Om op elk moment en overal een video LiveView te kunnen
gebruiken met uw Plug&View-camera, moet u een Plug&View-
gebruikersaccount aanmaken voor uw camera. De installatie en
bediening zijn zowel vanaf uw smartphone/tablet als vanaf een
pc/notebook mogelijk.

2.1 Creéer een gebruikersaccount met uw
smarthpone/tablet

Als u een Apple® iOS-apparaat gebruikt, zult u onze "DIGITUS®
Plug&View" App in de Apple App Store® vinden. Voor smartphones
en tablets die op Google Android OS werken, kunt u onze
"DIGITUS® Plug&View"-App in de Google™ Play Store vinden.

Voer "Digitus" of "DIGITUS Plug&View" in het zoekveld in van de
betreffende App Stores®.

Apple App Store® Google™ Play




\

De "DIGITUS® Plug&View"-App zal in de
zoekresultaten met dit symbooltje gemarkeerd staan.

Installeer de app vervolgens op uw mobiele apparaat.

Start de app op uw tablet of smartphone. U hebt 2 opties om uw
account te creéren:

1. Als u al een Google-account bezit, kunt u uw Google-account
gebruiken om uw Plug&View App te gebruiken, of

2. u kunt een nieuw Plug&View-account creéren met een
individuele gebruikersnaam en een wachtwoord.

00 vm> 1. Aanmelden met een
Google-account

Klik op "g" om in te
loggen met uw "Google-
account". Gebruik
vervolgens uw Google e-
mailadres en wachtwoord
om in te loggen.

of

2. Creéer een nieuwe
account met Plug&View

Klik op "Create Account".



= 1:02 CR |
Terms of Use Agreement

Fiir die Nutzung der Plug8View Plattform via Browser oder App ist es

erlorderlwm die Datmsch utzerklarung. die Sie unter hitp:/plug
fprivacy-polic slatform-apps/ nachlesen kdnnen, zu

akzepneren

Eridérung:

Ich habe die Datenschutzeridérung der Assmann Electronic GmbH zur

Kenntnis genommen und willige in die Datenvereinbarung gemas der

Daienschu!zeka.ung in, Ich kann meine Einwiligung jederzeit unter

digitus.info wiedernufen,

er weisen jedoch darauf hin, dass die Plug&View App dann nicht mehr

genutzt werden kann

To use the Plug&View platform via the browser or app, it is necessary
that you agree to the privacy

policy, which you can find at http://plug T y-for
platform-apps/ Privacy policy:

| have acknowledged the privacy policy of Assmann Electronic GmbH,
and hereby consent to the dala agreement according to the privacy
pollcy 1 may revoke my consent at any time by contacting

digitus.info,

However, we must point out that in the event consent is revoked, the

Accepteer het
privacybeleid voor
gebruik van het
DIGITUS®
Plug&View-systeem.

Gelieve op de
volgende pagina een
gebruikersnaam en
wachtwoord, te kiezen
en uw e-mailadres te
bevestigen.

Druk vervolgens op "Apply" om uw Plug&View-account te creéren.
Vervolgens zult u een e-mail ontvangen met instructies voor de
activering van uw account. Meld vervolgens aan op de App via
"Login" met uw gebruikersnaam en wachtwoord. U kunt uw camera
nu toevoegen aan het account (ga verder naar onderwerp 3).

2.2 Een gebruikersaccount creéren met uw pc

Naast de App-ondersteuning biedt het DIGITUS Plug&View-
systeem ook ondersteuning voor pc/laptop via een browser.

Gelieve de website http://plug-view.com te bezoeken
Klik vervolgens op “Login" om naar de Plug&View-webportaal te

gaan.



1. Aanmelden met een
Google-account

Klik op “g” om in te loggen

met uw "Google-account”.
a8 Gebruik vervolgens uw

bestaande Google e-

s mailadres en wachtwoord om
ine loggen.

Of

Create Account 2. Creéer een nieuwe account
met Plug&View

Klik op "Create Account".
Gelieve de informatie op de
volgende pagina in te vullen en
te bevestigen door op "Apply"
te drukken. Vervolgens zult u
een e-mail ontvangen met
instructies voor het
ontgrendelen van uw account.
U kunt u vervolgens op de
aanmeldpagina inloggen met
uw gebruikersgegevens en uw
camera toevoegen.

Nu hebt u succesvol een account aangemaakt, hetzij via de App of
het webportaal.

Gelieve om de wifi-instelling voor de IP-camera via
toegangspuntmodus in te stellen deel 3 van deze handleiding te
volgen.

Houdt u er rekening mee dat u voor de DN-16047 de camera moet
aansluiten op het internet via toegangstpuntmodus.

Ga verder naar deel 4 van deze handleiding als uw camera op de

router is aangesloten via een LAN-kabel.
13



3. De Plug&View IP-camera verbinden via wifi

3.1 Met smartphone/tablet

Open de wifi-instellingen op uw

smartphone/tablet.

Zoek naar beschikbare draadloze .

netwerken in de onmiddellijke
omgeving. De camera zal worden
weergegeven als een draadloos
netwerk met zijn modelnummer en
de laatste 6 tekens van zijn MAC-
adres.

4 4 4.4 4 4 4 2
i

WLAN ;‘1__,

+ PlugandView a= (i
NET WAHLEN ... &
ArarDrai a = i

Verbind uw smartphone/tablet met de IP-camera via de wifiverbinding.

eeec0 02-de+ 36 n23 § eoxmmy

Nadat de smartphone/tablet is
verbonden met de camera, kunt
u beginnen met de installatie WLAN O
van de Plug&View-app. Open
de Plug&View-app.

Einstellungen  WLAN

+ DN-16049-07a405 =



De Plug&View-app zal de
verbinding met een Plug&View-
camera gebruikt in
toegangspuntmodus herkennen
en u vragen het wifinetwerk te
selecteren waarmee de camera
moet worden verbonden.

Back De beschikbare netwerken in de
directe omgeving zullen worden
weergegeven. Gelieve hier het
netwerk te selecteren waarmee u de
camera wilt verbinden. Als uw
netwerk niet wordt weergegeven,
dient u de camera mogelijk te
verplaatsen.

OPGELET: Verborgen SSID’s, d.w.z. verborgen wifinetwerken,
worden door deze camera niet ondersteund. Gelieve uw
netwerk zichtbaar te maken als u een camera in dit soort
netwerk wilt installeren.

15



weeo o2-dar ¥ mas

{ Back Wi-Fi Setting

| e

seessnnsns

Cancel

Please se-connect the WiFl of your mobie phone 10 The wireless

your
Foutes o AP before logn 1o BIGITUS Plugtiew

o

Voer het netwerkwachtwoord in

het wachtwoordveld in waarmee
uw wifinetwerk is versleuteld en

bevestig uw invoer met OK.

Android besturingssystemen zullen
u na een geslaagde verbinding
vragen opnieuw verbinding te
maken tussen uw smartphone/
tablet en wifinetwerk.

Dit zal standaard automatisch
gebeuren. Als dit niet het geval is,
kunt u naar de wifi-instellingen van
uw smartphone/tablet gaan en
daar verbinding maken met uw
wifinetwerk.



4. Uw Plug&view IP-camera toevoegen

4.1 Met smartphone/tablet

Druk op "+" om een nieuwe camera
toe te voegen tijdens de eerste
installatie van de Plug&View-camera.
Ga naar instellingen
(tandwielpictogram rechtsboven) en
druk op "Add camera" als er al
camera’s aanwezig zijn. Dit kan
eenvoudig worden gedaan door de
QR-code met uw smartphonef/tablet
te scannen of door de
activeringsgegevens handmatig in
te voeren.

De volgende apparaten zijn geschikt voor het scannen van de QR-
code: Apple iPhone®, Apple iPad®, Android-smartphone, Android-
tablet (met geintegreerde achtercamera).

Het MAC-adres, de activeringscode en de QR-code zijn te vinden
op de laatste pagina van deze handleiding.

Opmerking: De Android-versie van het mobiele apparaat dient
minstens 2.3.5 of hoger te zijn.

17



De camera toevoegen door de QR-code te scannen

[ A TR CE0E ] Selecteer de optie "Scan QR
code" op de volgende pagina.

De scanfunctie voor QR-codes van

uw mobiele apparaat wordt

geactiveerd.

Gelieve de QR-code op de laatste pagina van deze handleiding in
te scannen om de camera toe te voegen aan uw account.

Tijdens het scannen van de QR-code moet u uw mobiele apparaat
heen en weer bewegen totdat de code wordt herkend.

De camera toevoegen door het MAC-adres en de
activeringscode handmatig in te voeren

Het MAC-adres en de activeringscode zijn te vinden op de laatste
pagina van deze handleiding. Ga naar "Manual input" na "Add
camera" te hebben geselecteerd in de Plug&View-app.

Voer de alfanumerieke combinatie in die u onder "MAC" vindt. Voer
vervolgens uw activeringscode in en klik op "Apply".

18



4.2 De camera toevoegen aan de pc via de
browser

Als pc/notebook-gebruiker kunt u ook camera's toevoegen aan uw
account via een procedure die vergelijkbaar is vanaf 4.1 voor
mobiele apparaten.

Wanneer u zich voor het eerst aanmeldt op de beheerspagina van uw
camera via http://www.plug-view.com en "Login" met uw account en
wachtwoord, zult u naar de "Download"-pagina verwezen worden om
de plug-in te installeren. Gelieve op download te drukken en de
installatie-instructies te volgen.

Please download the new version of "Plug&View
plugin” for camera liveview:

If you have already downloaded before, check the
following:

Enable P2P Viewer in Chrome extension

Open Menu > Settings > Extensions > P2P Viewer

If you have ever deleted the plugin before, please download
the Plug&View plugin

If P2P Viewer does not exist in the Chrome extension list,
please download P2P Viewer

Chrome installation tutorial

19



L.

Please complete registration in 60 minutes
after boot up your camera, or you need to

re-power the camera and complete
registration process again.

Gelieve u na de installatie
van de plug-in op nieuw aan
te melden op de inlogpagina
via http://www.plug-view.com
met uw account.

Gelieve op het "+" teken te
drukken om de camera toe
te voegen.

Druk vervolgens op het ">"
teken om naar de volgende
pagina te gaan en volg de
stappen.

Gelieve vervolgens het MAC-adres en de activeringscode in te
geven die u op de laatste pagina van uw gebruikershandleiding
vindt en op "Apply" te drukken om de camera toe te voegen.

Add Camera

MAC Address

Activate Code

20




Nadat de camera succesvol aan uw account werd toegevoegd, kunt
u controleren of uw camera op de liveweergavepagina wordt
weergegeven.

P sim

Als u van plan bent uw Plug&View-camera te blijven gebruiken
met een netwerkkabel, is de instelling nu voltooid.

Maar als u van plan bent om een draadloze verbinding via wifi te

gebruiken om flexibel van locatie te veranderen, gelieve dan verder
te lezen.

21



5. Wifi instellen via uw pc/notebook

U kunt een draadloze (wifi) verbinding tussen de IP-camera en de
wifirouter/toegangspunt ook via uw pc/notebook via een browser
instellen

Meldt u na een geslaagde installatie van uw camera aan op de
website "http://www.plug-view.com". Gelieve op "Login | My camera
administration" te klikken.

Gebruik uw Plug&View-account of selecteer Google-login. Als u niet
bent aangemeld op uw Google-account, zult u automatisch naar de
inlogpagina van Google worden verwezen.

Na het invoeren van uw inloggegevens kunt u de liveweergavepagina
van de camera zien.

Aan de rechterkant van het

camerabeeld vindt u een aantal =
pictogrammen. Klik op de toets
"Camera Configuration" om naar de
gebruikersinterface van de camera
te gaan.

figuration
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Een ander venster wordt geopend, dat is de webinterface van de
camera. Gelieve in te loggen met de standaard "camera"
inlogaccount met "admin" en wachtwoord "admin". Als u de optie
"Autologin” selecteert, zult u automatisch worden aangemeld de
volgende keer dat u het configuratiemenu opent. Klik op "Login".

D[G]TUSO DIGITUS® PLUG&VIEW

safe&secure - anywhere. anytime.

| —
Language:
Stream

Klik in de gebruikersinterface van de camera op wifi om de wifi-
instellingen uit te voeren.

D[G[TUS séfe.&secﬁ}r.t;. - aﬁy@heré..'énytirhel.

Home Replay Parameters System Wireless

Er zal een zoekvenster verschijnen waarin alle beschikbare draadloze
netwerken in uw omgeving staan weergegeven. Gelieve de
identificatie (SSID) van uw netwerk te selecteren en bevestig met
"OK".

ssiD Signal  Authentifzierungsmodus
) TestPMM 28% -PSK-TKIF)WPAZ-PSK-CCMP)[WPS)[ESS]
-/ TestPM)

O Piugandview 88% [WPA-PSK-TKIPJ[ESS]

Sam masma A mALs e e A
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Voer in het volgende venster het wifiwachtwoord in en druk ter
bevestiging op "OK".

Gelieve ervoor te zorgen
dat uw router werkt als een
ok DHCP-server. Dit is de
standaardfabrieksinstelling
in vrijwel alle routers.

De verbinding met uw
draadloze LAN wordt
vervolgens tot stand
gebracht. Als de
verbinding is geslaagd,
zult u hierover worden
geinformeerd in een
afzonderlijk venster.

Passwort:

U kunt de netwerkkabel van de camera nu verwijderen en het
browservenster sluiten.

Gefeliciteerd. U hebt zojuist uw Plug&view IP-camera instelling

voltooid. U hebt nu op elk gewenst moment toegang tot uw IP-
camera via uw smartphone, tablet-pc of een browser.
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6. Bewegingsdetectie en opname instellen

Het DIGITUS® Plug&View-systeem biedt de opties bewegingsdetectie
en opname. Voor deze functie moet de SD-kaart worden
geformatteerd in de camera en moet de bewegingsdetectie worden
geactiveerd.

Open de camera via het webportaal om de SD-kaart te formatteren.

Aan de rechterkant van het 0
camerabeeld vindt u een aantal :
pictogrammen. Klik op de toets

“Camera Configuration” om naar de

gebruikersinterface van de camera ©
te gaan.
v
G

| Camera Configuration

Een ander venster wordt geopend, dat is de webinterface van de
camera. Gelieve in te loggen met de standaard "camera"
inlogaccount met "admin" en wachtwoord "admin". Als u de optie
"Autologin” selecteert, zult u automatisch worden aangemeld de
volgende keer dat u het configuratiemenu opent. Klik op "Login".

U kunt naar de SD-kaartinformatie gaan via het menu door naar
System -> Local storage te gaan. Formatteer de SD-kaart via de
optie "Format" in het menu.

De bewegingsdetectie kan na het formatteren worden geactiveerd.

25



Ga naar "Parameters" -> "Motion Detect" via de webinterface.

safe&secure - anywhere. anytime.

Activate B4 Enable

.

Sensibiity [Nerma v Select All m

Action:
E-Mail

Send E-mail

Output Alarm With Snapshot 1 Send ToEmall ) Upload to FTP

=
I~
B AamwihRecord o upicadto FTP
B4 Trigger Alarm Output

Schedule: Week Mode Work Mode ®  Always

Klik op "ON" om de bewegingsdetectie te activeren. Het gekleurde
gedeelte binnen het videobeeld is het deel met bewegingdetectie,
d.w.z. het gedeelte waarin een beweging een foto- of video-opname
zal activeren. Bij de originele levering, is vrijwel het gehele scherm
bedekt met rode boxen. Klik op de kleurmarkeringen om bepaalde
zones van bewegingsdetectie uit te sluiten. U wist op deze wijze de
markering voor die zone. U kunt de gevoeligheid voor de
bewegingsdetectie instellen via de optie "Sensibility". U kunt kiezen
uit de volgende vier niveaus: "Very high", "High", "Normal" en "Low".
Activeer de optie "Alarm with recording" om een opname te maken
op de SD-kaart wanneer beweging wordt waargenomen.

De tijdinstelling hangt af van het schema voor bewegingsdetectie. U
kunt opnames maken in de modi Wekelijks, Werkdagen of Altijd.

U kunt het schema individueel aanpassen.

Sla de configuratie op met de optie "Apply".
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De bewegingsdetectie met opname is nu succesvol ingesteld.
Voor meer informatie over de webinterface van de camera,
raadpleeg de camerahandleiding beschikbaar op cd.

Als u nog vragen hebt, bezoek de zone Veelgestelde Vragen op
onze Plug&View-pagina (http://www.plug-view.com/) of neem
contact op met onze hulplijn
(http://www.plug-view.com/support-de/support/).

Handelsmerken

DIGITUS is een geregistreerd handselsmerk van ASSMANN
Electronic GmbH.

Apple, Apple App Store zijn geregistreerde handelsmerken van
Apple Inc.

Android, Google, Google play zijn geregistreerde handelsmerken
van Google Inc.

AVM Fritz!Box is een geregistreerd handselsmerk van AVM
Computersysteme Vertriebs GMBH.

Telekom Speedport is een geregistreerd handelsmerk van Deutsche
Telekom AG.

Opmerking:

Alle handelsmerken die hier niet zijn genoemd zijn eigendom van
hun respectieve eigenaren.

Handelsmerken of handelsnamen genoemd in deze handleiding
worden gebruikt om de gebruiksstappen te beschrijven, dit betekent
niet dat ze vrij beschikbaar zijn. Ze zijn in elk geval het eigendom
van de respectieve rechtenhouder.
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DIGITUS"

Camara IP Plug&View
DIGITUS®

Guia Rapido de Instalagao



Precaucgodes de seguranga

Utilizar apenas a camara IP Plug&View dentro dos limites de
temperatura especificados para esta camara

Quando néo estiver em utilizagéo, armazenar o produto num
local limpo e seco, a temperaturas entre 0 °C e 40 °C

N&o cobrir a camara

Nao deixar a cdamara entrar em contacto com liquidos (exceto
camaras exteriores com cobertura protetora IP66)

As camaras IP Plug&View ndo substituem a supervisdo de
adultos. Salvaguardar a saude das suas criangas, membros da
familia ou animais de estimagao, vigiando-os regularmente

Garantir que as camaras IP interiores apenas sao utilizadas no
interior. Estas camaras nao se destinam a ser utilizadas no
exterior e podem danificar-se. Neste caso, utilizar os modelos
exteriores especificados

Instalar as camaras IP Plug&View perto de uma tomada elétrica
de parede facilmente acessivel. Garantir que o cabo de
alimentag&o nado esta sob tensdo ou esticado

Posicionar as camaras IP Plug&View dentro do alcance do seu
router Wi-Fi e garantir que n&o existem obstaculos entre a
camara e o router, que poderao interferir com o sinal Wi-Fi



Proteger as camaras IP Plug&View de outros aparelhos elétricos
e de alta-frequéncia geradores de interferéncias (microondas,
telemoveis, etc.)

Manter a camara, o cabo de rede e o cabo de alimentacéo longe
do alcance de criangas, uma vez que estes componentes podem
ser perigosos

Utilizar apenas o adaptador de alimentagéo fornecido.

Nunca tentar reparar as camaras IP Plug&View por si proprio. Os
trabalhos de reparagdo e manutencdo devem ser levados a cabo
por especialistas.

Em caso de problemas, contactar o nosso servigo de apoio ao
cliente.

Observar todas as leis aplicaveis a videovigilancia. As camaras
IP Plug&View IP destinam-se a uso privado e doméstico. Informar
os membros da sua familia, familiares e empregados domésticos
em sua casa sobre o sistema de videovigilancia. Garantir que as
areas publicas e a propriedade dos seus vizinhos ndo séo
monitorizadas.



Informag&o pessoal

* Ler e aceitar a politica de privacidade para utilizar os sistemas
Plug&View DIGITUS® em
http://plug-view.com/privacy-policy-for-platform-apps/.

¢ Selecionar uma palavra-passe com um elevado grau de
seguranga para a sua conta Plug&View, para a proteger contra
0 acesso nao autorizado.

* A palavra-passe deve conter pelo menos 8 caracteres;
recomendamos letras maiusculas e mindsculas e caracteres
alfanumeéricos.

* Adicionalmente, a palavra-passe padrao da camara pode ser
alterada também aqui para evitar o acesso nao autorizado.

A transmissao ao vivo, as notificagées push e outros servigos
estao disponiveis através de um servidor na nuvem. Apesar
das solugdes de backup, da estabilidade do sistema e da
gestao de largura de banda, a disponibilidade ininterrupta do
sistema nao pode ser garantida.

Conteudo da embalagem

1 x Camara IP Plug&View Opcional:

1x Fonte de alimentagédo com 1 x cabo Ethernet

cabo 1 x Suporte para montagem
1 x Manual de Instalagao Rapida em tetos/paredes

1x CD com utilitarios 1 x antena removivel

* As seguintes camaras estdo equipadas com uma antena removivel:
DN-16029, DN-16039, DN-16043, DN-16048, DN-16049

Obrigado por escolher a cdmara IP Plug&View, que pode ser
instalada e utilizada rapida e facilmente, sem configuragées de

rede complicadas.
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Instalar o Cartao MicroSD

As camaras interiores Plug&View DIGITUS® podem ser equipadas
com um cartdo microSD para gravagéo.

Verificar a opgéo de instalagado de acordo com as ilustragdes de
instalacao.

DN-16047

Instalar o cartdo SD conforme
ilustrado, com os contactos
dourados virados para a lente
da camara.

DN-16046

Instalar o cartdo SD conforme o

ilustrado, com os contactos Y [

dourados virados para a lente 3@
952"

da camara.

DN-16029
Instalar o cartdo SD conforme
ilustrado, com os contactos

dourados para cima. |i !\



Ligagdes da Camara

LAN:

Ligar a cAmara a porta LAN do
seu router.

Repor Configuragoes:
Depois de iniciar a camara,
prima sem soltar o botao
Reinicializar durante

10 segundos, para repor as
predefinicbes da camara.
Alimentacgao:

Ligue o cabo de alimentagéo
fornecido para alimentar a
camara com energia elétrica.
MicroSD:

Insira um cartdo microSD para
armazenamento local.

Mic: Microfone (Entrada de
audio).

Saida de audio:

Ligar uma coluna externa
através do cabo de audio de
3,5 mm.

WPS:

Mantenha o botdo WPS
premido durante 8 segundos
apos a ativagdo da camara
para ligar o modo WPS.

(*os modelos DN-16029 e
DN-16046 incluem o botéao
WPS)

Alarme:

Pin1: Entrada de alarme
Pin2: Solo

Pin3: Nao esta em utilizagéo
Pin4: NAO

6
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Ligagdes da Camara

As camaras exteriores Plug&View DIGITUS® estdo equipadas com
um cabo especial.

Verificar a opgéo de instalagédo de acordo com as ilustragdes de
instalacao.

. Botao reinicializar:
Depois de a camara ser
ligada e estar pronta a
usar, premir sem soltar
este botado por
10 segundos. Esta agao
repde as predefinicdes de
fabrica da camara.

. Cabo de rede:

Ligar o cabo de rede ao
seu router para estabelecer
uma ligagéo a Internet.

. Ligacao elétrica de 12 V
CC:

Ligar o adaptador de
alimentagao externo para
fornecer energia elétrica a
camara.

. Indicador luminoso de
estado:

O indicador luminoso de
estado azul indica se a
camara tem alimentacéao
elétrica.

Nos modelos DN-16039, DN-16043 e DN-16048, a alimentagao
elétrica pode ser diretamente fornecida a camara ligando o cabo de
rede a um injetor POE ou a um interruptor PoE.



Definicoes da Lente

DN-16039
DN-16043
Definir o foco (angulo)
Pode ajustar o foco L
e a nitidez através Definir a nitidez

dos controlos
manuais. Utilizar a
imagem ao vivo da
camara para ajustar
o foco e a nitidez,
conforme
necessario.



1. Preparacgao

Antes de utilizar a sua camara IP, devem ser realizadas algumas
acgoes prévias.

Conexao da antena

Ligue a antena sem fios ao conector e aperte os parafusos de
montagem.

Insergéo do cartdo SD

As camaras IP Plug&View suportam cartdes MicroSD com até
32GB de capacidade que podem ser adquiridos em lojas. Os
videos e imagens gravados com a sua camara IP serdo
armazenados nesse cartdo.

Se a sua camara possuir uma porta externa e nao tiver memoria
interna disponivel, insira o seu cartdo MicroSD na abertura
correspondente até que esteja fixo nela.

Ligacdo da fonte de alimentagao

Ligue o cabo de alimentagéo ao conector denominado “Power” da
camara.

Ligagcado da camara ao router (por ex. AVM Fritz!
Box, Telekom Speedport etc.)*

Ligar um terminal do cabo de rede fornecido a porta LAN da
camara. Ligue a outra ponta do cabo de rede a um dos conectores
marcados com a abreviagédo ‘LAN’, localizados na parte traseira do
seu roteador. Alguns routers possuem apenas um conector LAN,
mas outros possuem varios conectores. O seu router deve estar
ligado a uma ligacao de Internet em funcionamento.

* Pode ignorar este ponto com o modo Ponto de Acesso das
camaras. Para o modelo DN-16047, este ponto deve ser
ignorado.



2. Configuracao da conta de utilizador

Plug&View

Para utilizar a camara Plug&View e para ter uma transmisséo de
video em direto em qualquer altura e em qualquer lugar, &
necessario registar a cAmara numa conta de utilizador Plug&View.
A configuragéo e o controlo podem ser feitos a partir do
smartphone/tablet ou a partir de um PC/computador portatil.

2.1 Criar uma conta de utilizador com o seu
Smarthpone/tablet

Se tiver um dispositivo iOS Apple® iOS, encontrara a nossa
aplicagdo "DIGITUS® Plug&View" na Apple App Store®. Para
telemoveis e tablets cujo sistema operacional é o Google Android
OS, o nosso aplicativo "DIGITUS® Plug&View" pode ser encontrado
na Google™ Play Store.

No campo de pesquisa das respetivas App Stores®, introduzir
"Digitus" ou "DIGITUS Plug&View".

Apple App Store® Google™ Play




\ Nos resultados da busca, o aplicativo "DIGITUS®

(
w Plug&View" aparecera com este simbolo.

Seguidamente deve instalar a aplicagdo no seu dispositivo portatil.

Abra a aplicagédo no seu tablet ou telemével. Ha duas opgdes para
a criagéo de contas:

1. Se ja possuir uma conta do Google, é possivel utilizar essa
conta com o seu aplicativo Plug&View, ou

2. E possivel criar diretamente uma nova conta Plug&View com
nome de utilizador e palavra-passe individuais.

B: 00 vm; 1, Entrar com uma conta
do Google
Clique em "g" para iniciar
sessdo numa "conta do
Google". Entdo, utilizar o
seu correio eletrénico do
Google com a respectiva
palavra-passe para
efetuar o login.

Ou

2. Criar uma nova conta
Plug&View

Clicar em "Create

e Account".



= 1:02 CR |
Terms of Use Agreement

Fiir die Nutzung der Plug8View Plattform via Browser oder App ist es

erlorderlwm die Datmsch utzerklarung. die Sie unter hitp:/plug
fprivacy-polic slatform-apps/ nachlesen kdnnen, zu

akzepneren

Eridérung:

Ich habe die Datenschutzeridérung der Assmann Electronic GmbH zur

Kenntnis genommen und willige in die Datenvereinbarung gemas der

Daienschu!zeka.ung in, Ich kann meine Einwiligung jederzeit unter

digitus.info wiedernufen,

er weisen jedoch darauf hin, dass die Plug&View App dann nicht mehr

genutzt werden kann

To use the Plug&View platform via the browser or app, it is necessary
that you agree to the privacy

policy, which you can find at http://plug T y-for
platform-apps/ Privacy policy:

| have acknowledged the privacy policy of Assmann Electronic GmbH,
and hereby consent to the dala agreement according to the privacy
pollcy 1 may revoke my consent at any time by contacting

digitus.info,

However, we must point out that in the event consent is revoked, the

Aceitar a politica de
privacidade para
utilizar o sistema
Plug&View DIGITUS®.

Na préxima pagina,
escolha um nome de
utilizador, uma
palavra-passe e
confirme o seu
enderego de correio
eletrénico.

Clique em "Apply" para criar a sua conta Plug&View. Recebera, em
seguida, um e-mail com instrugbes sobre a forma de ativar a sua
conta. Faga o login no aplicativo através da opgéo "Login", com o
seu nome de utilizador e a sua palavra-passe. Agora, é possivel
adicionar a sua camara a conta (continuar para o item 3).

2.2 Criar uma conta de utilizador com o seu PC

Além de suportar aplicagdes, o sistema DIGITUS Plug&View é
igualmente compativel com PC/computadores portateis através de

acesso no browser.

Visite o sitio http://plug-view.com

Em seguida, clique em "Login" para entrar no portal Web do

Plug&View.



1. Entrar com uma conta do
Google

Clique no "g" para "Iniciar

sessdo no Google". Podera,
a depois, utilizar o seu
endereco e a palavra-passe
do Google Mail para iniciar
sessé&o.

Ou

Create Account 2. Criar uma nova conta
Plug&View
Clicar em "Create Account".
Insira as informacgdes
o necessarias na proxima pagina

e confirme com a opgéo
DIGITUS"®

"Apply". Entdo, sera enviada

Assmann Electronic GmbH

sobre como desbloquear a sua
conta. Na pagina de login, sera
possivel efetuar o login com os
seus dados de utilizador e
adicionar a camara.

Tera, assim, criado com sucesso uma conta através da aplicagéo
ou do portal da Web.

uma mensagem com instrugées

Para prosseguir com a configuragao da ligagdo WiFi para a cdmara

IP através do modo Ponto de Acesso, consulte a secgéo 3 deste
manual.

No modelo DN-16047, lembre-se é obrigatério ligar a camara a
Internet através do modo Ponto de Acesso.

Ignore a Secgao 4 deste manual se a camara ja estiver ligada ao
router através de um cabo LAN.
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3. Ligar a camara IP Plug&View IP através de

Wi-Fi

3.1 Com um smartphone/tablet

Abrir as definigdes de Wi-Fi no seu

smartphone/tablet.

Procurar redes sem fios disponiveis
nas imediagdes. A camara sera
mostrada como uma rede sem fios
com o respetivo niumero de modelo
e os ultimos 6 caracteres do seu

endereco MAC.

Flugandiiew
AEGT
AEGLOG
AEG-Gurst

AEG-PAIT

4 4 4 4 4 2

ON-16047-003F00

E

FAAM Assmann

E

cmProqectons_Bode

WLAN O

+  PlugandView a= (i)

NETZWERK WAHLEN

DN-16049-07a405 =0

Annreai a= (1

Ligar o seu smartphone/tablet a camara IP através da ligagdo WLAN.

#sec0 02-de+ 36 n23  eoxmmy

Depois de ligar o smartphone/
< Einstellungen  WLAN

tablet a camara, pode
prosseguir com a instalagéo da WLAN @
aplicagéo Plug&View. Abrir a
aplicagéo Plug&View.

~ DN-16049-07a405 * (D)



A aplicagao Plug&View deteta a
ligagcdo de uma camara
Plug&View operada no modo
Ponto de Acesso e pedir-lhe-a
para selecionar a rede Wi-Fi a
qual a cAmara devera ser
ligada.

Back Ser&o indicadas as redes disponiveis
cr nas imediagoes. Deve selecionar
aqui a rede, com a qual a camara
devera ser ligada. Se a sua rede ndo
for exibida, deve ser necessario
reposicionar a camara.

ATENGAO: SSID’s ocultos, significa redes WLAN ocultas, nio
sao suportados pela camara. Deve tornar a sua rede visivel, se
quer instalar a camara numa das referidas redes.
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weeo o2-dar ¥ mas

{ Back Wi-Fi Setting

| e

seessnnsns

Cancel

Please se-connect the WiFl of your mobie phone 10 The wireless

your
Foutes o AP before logn 1o BIGITUS Plugtiew

o

Inserir a palavra-passe da rede no
campo da palavra-passe, com a
qual a sua rede WLAN é
encriptada e confirmar a entrada
com OK.

Nos sistemas operativos Android,
apos o estabelecimento da
ligagéo, ser-lhe-a pedido para
voltar a ligar o seu smartphone/
tablet a sua rede Wi-Fi.

Em regra, isto acontecera
automaticamente. Caso contrario,
ir para as definigbes Wi-Fi do seu
Smartphone/Tablet e ligar a rede
Wi-Fi dai.



4. Adicionar camara IP Plug&View

4.1 Com um smartphone/tablet

Premir "+" para adicionar uma nova
camara durante a primeira
instalacdo da camara Plug&View.
Ir para as defini¢des (icone da roda
dentada no topo a direita) e tocar
em "Add camera", se ja existirem
camaras. Isso pode ser feito
facilmente por meio da leitura do
codigo QR com o seu telemovel/
tablet ou através na insergao
manual dos dados de ativacéo.

Os seguintes aparelhos suportam a leitura do cédigo QR: Apple
iPhone®, Apple iPad®, telemével com Android, tablet com Android
(com camara traseira integrada).

O endereco MAC, o cadigo de ativagéo e o codigo QR podem ser
encontrados na Ultima pagina deste guia.

Nota: A versao do Android do aparelho portatil deve ser 2.3.5 ou
posterior.
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Adicionar a camara através da procura do cédigo
QR

[ Scan OR Code ] Na pagina seguinte, selecionar a
opgao "Scan QR code".

A fungéo de leitura do cédigo QR

do seu aparelho portatil sera

ativada.

Leia o codigo QR situado na ultima pagina deste manual para
adicionar a cdmara a sua conta.

Durante a leitura do cédigo QR, podera necessitar de deslocar o
dispositivo moével para a frente e para tras até o cédigo ser
reconhecido.

Adicionar a cdmara através da insergdao manual
do endereco MAC e do cédigo de ativacdo

O enderego MAC e o codigo de ativagéo estéo localizados na
ultima pagina deste guia. Navegar para "Manual input" ap6s
selecionar "Add camera" na aplicacéo Plug&View.

Introduzir a combinagao alfanumérica que pode ser encontrada em
"MAC". Entao, insira o seu codigo de ativagéo e clique em "Apply".
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4.2 Adicionar a camara ao computador através
do navegador

Para os utilizadores de um PC/computador portatil, € igualmente
possivel adicionar camaras a respetiva conta através de um processo
similar ao descrito no ponto 4.1 para um dispositivo mével.

Apds o primeiro inicio de sessédo na pagina de administragédo da
camara em http://www.plug-view.com para fazer "Login" com a
respetiva conta e palavra-passe, ser-lhe-a solicitado que aceda a
pagina "Download" para instalar o plug-in. Prima o botdo de
download e siga as instrugbes para proceder a instalacao.

Please download the new version of "Plug&View
plugin” for camera liveview:

If you have already downloaded before, check the
following:

« Enable P2P Viewer in Chrome extension
Open Menu > Settings > Extensions > P2P Viewer

+ If you have ever deleted the plugin before, please download
the Plug&View plugin

« If P2P Viewer does not exist in the Chrome extension list,
please download P2P Viewer

« Chrome installation tutorial
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Please complete registration in 60 minutes
after boot up your camera, or you need to

re-power the camera and complete
registration process again.

Depois de instalar o plug-in,
entre novamente na pagina
de inicio de sessdo em
http://www.plug-view.com
com a respetiva conta.

Prima o sinal "+" para
adicionar a camara.

Em seguida, prima o sinal
">" para avangar para a
pagina seguinte e siga as
instrucoes.

Introduza o enderego MAC e o cédigo de ativagao indicado na
ultima pagina do manual do utilizador e prima "Apply" para

adicionar a camara.

Add Camera

MAC Address

Activate Code
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Depois de adicionar a camara a sua conta com sucesso, verifique
se a camara apresenta uma transmissao em direto.

.oe

Se quiser continuar a utilizar a sua camara Plug&View com um
cabo de rede, a configuragao termina aqui.

Se, no entanto, quiser utilizar uma ligagdo sem fios para obter uma
maior flexibilidade em relagéo a localizagao, leia a secgédo seguinte.
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5. Configurar o Wi-Fi no PC/computador

portatil

A configuragdo da ligacédo sem fios (Wi-Fi) entre a cdmara IP e o
router/ponto de acesso Wi-Fi também pode ser feita no browser do
PC/computador portatil

Ap6s a instalagéo da sua camara, faga o log-in no sitio
"http://www.plug-view.com". Clique em "Login | My camera
administration".

Utilize a sua conta Plug&View ou selecione o inicio de sessao do
Google. Se a sua conta do Google néo estiver aberta, o navegador
sera redirecionado automaticamente a pagina de log-in do Google.

Depois de introduzir os detalhes de inicio de sesséo, podera ver a
transmisséo em direto da camara.

No lado direito da imagem da 8

camara, surgem alguns icones. =z

Clique no botéo "Camera

Configuration" para aceder a

interface do utilizador da camara. ®©
2
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Abre-se uma nova janela, a qual contém a interface do utilizador na
Web da camara. Inicie sessdo com a conta predefinida "camera",
cujo nome de utilizador é "admin" e a palavra-passe é "admin".
Se a opgéao de “Autologin” for selecionada, o log-in sera efetuado
automaticamente da préxima vez que o menu de configuragdes for
aberto. Clique em "Login".

D[G]TUSO DIGITUS® PLUG&VIEW

safe&secure - anywhere. anytime.

R —
Lenguage:
Stream

Na interface de utilizador da camara, clicar em Wi-Fi para configurar
as definigdes de Wi-Fi.

safe&secure - anywhere. anytime.

Home Replay Parameters System Wireless

Aparecera uma janela de busca, na qual todas as redes sem fios
disponiveis na sua area serdo mostradas. Selecione o identificador
(SSID) da sua rede e confirme com "OK".

ssiD Signal  Authentifzierungsmodus
) TestPMM 8% -PSK-TKIF)[WPAZ-PSK-CCMP)[WPS)[ESS]
- TestPM)

O Piugandview 88% [WPA-PSK-TKIPJ[ESS]

Sam masma A mALs e e A
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Na janela seguinte, introduzir a chave de acesso Wi-Fi e confirmar

com "OK".

Passwort:

ok

Certifique-se de que o
seu roteador esta a
funcionar como servidor
DHCP. Esse ¢ o padréao
original de quase todos
os roteadores.

Assim, a ligacdo da sua
rede LAN sem fios sera
estabelecida. Se a
conexao for estabelecida,
sera mostrada numa
janela separada.

O utilizador pode remover o cabo de rede da camara e fechar a

janela do navegador.

Parabéns. A configuragédo da sua camara IP Plug&View foi
completada. Agora, é possivel aceder a sua camara IP a qualquer
momento a partir do seu telemovel, tablet, PC ou navegador.
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6. Definir a Detegcdo de Movimento e a

Gravagao

O sistema Plug&View DIGITUS® disponibiliza as opgdes de
detecdo de movimento e gravagéo. Para utilizar esta fungéo, o
cartdo SD tem que ser formatado na camara e a detegdo de
movimento ativada.

Para formatar o cartédo SD, aceder a camara através do portal web.

No lado direito da imagem da

4
camara, surgem alguns icones. x
Clique no botédo "Camera
Configuration" para aceder a &
interface do utilizador da camara. *
Z

figuration

Abre-se uma nova janela, a qual contém a interface do utilizador na
Web da camara. Inicie sessdo com a conta predefinida "camera",
cujo nome de utilizador é "admin" e a palavra-passe é "admin".
Se a opgéao de “Autologin” for selecionada, o log-in sera efetuado
automaticamente da préxima vez que o menu de configuragdes for
aberto. Clique em "Login".

Podera aceder as informagdes do cartdo SD através do menu, em

System -> Local storage. Formatar o cartdo SD através do item de
menu "Format".
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Apos formatar, a detegdo de movimento pode ser ativada.

Aceder a "Parameters" -> "Motion Detect" na IU da Web.

Home Replay Parameters System Wireless
Area:
Activate B4 Enable

Sensibilty [Norma w Select All Clean All

Action:

E-Mail Send E-mail

Output: Alarm With Snapshot &1 Send ToEmail & Upload to FTP

Alarm With Record (A Upload to FTP
Trigger Alarm Output

Schedule Week Mode Work Mode @ Alvays

Ativar a detegdo de movimento clicando em "ON". A area colorida
dentro da imagem de video representa a area de detecgéao de
movimento, ou seja, a area na qual qualquer movimento ativa a
gravagao de videos ou imagens. Nas configuragdes originais da
camara, quase todo o ecra é coberto com caixas vermelhas. Clicar
nas marcagoes coloridas para excluir certas areas da detegéo de
movimento. Assim, a marcagao da area sera apagada. Pode definir
a sensibilidade da detegdo de movimento em "Sensibility".
Selecionar entre os seguintes quatro niveis: “Very high", "High",
"Normal" e "Low".

Ativar "Alarm with recording" para guardar no cartédo SD, no caso
de ser detetado movimento.

RRERAA

O ajuste horario é afetado pelo horario da detegdo de movimento.
Pode gravar nos modos Semanal, Dia Util ou Tempo Inteiro.
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Pode ajustar o horario individualmente.
Guardar a configuragdo com "Apply".

Definiu com sucesso a detecdo de movimento com gravagéao.
Para explicagoes relativas a interface web da camara,
consultar o manual da camara fornecido em CD.

Se tiver quaisquer questodes, aceder a area de Perguntas
Frequentes na nossa pagina de Plug&View
(http://www.plug-view.com/) ou contactar a nossa linha de
Apoio ao Cliente
(http://www.plug-view.com/support-de/support/).

Marcas registadas

DIGITUS é marca registada da ASSMANN Electronic GmbH.
Apple, Apple App Store sdo marcas registadas da Apple Inc.
Android, Google, Google play sdo marcas registadas da Google Inc.
AVM Fritz!Box é marca registada da AVM Computersysteme
Vertriebs GMBH.

Telekom Speedport € marca registada da Deutsche Telekom AG.

Nota:

Todas as outras marcas registadas néo indicadas aqui sao de
propriedade de seus respectivos donos.

As marcas registadas ou nomes comerciais mencionados neste
manual sdo utilizados para descrever 0s passos operacionais e nao
implicam que s&o de utilizagdo livre. De qualquer modo, séo de
propriedade dos seus respectivos donos.
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